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Legal information

Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are
graded according to the degree of danger.

A\DANGER
indicates that death or severe personal injury will result if proper precautions are not taken.

AAWARNING
indicates that death or severe personal injury may result if proper precautions are not taken.

A\ cAuTION
indicates that minor personal injury can result if proper precautions are not taken.

NOTICE
indicates that property damage can result if proper precautions are not taken.

If more than one degree of danger is present, the warning notice representing the highest degree of danger will
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to
property damage.

Qualified Personnel

The product/system described in this documentation may be operated only by personnel qualified for the specific
task in accordance with the relevant documentation, in particular its warning notices and safety instructions.
Qualified personnel are those who, based on their training and experience, are capable of identifying risks and
avoiding potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:

AAWARNING

Siemens products may only be used for the applications described in the catalog and in the relevant technical
documentation. If products and components from other manufacturers are used, these must be recommended
or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and
maintenance are required to ensure that the products operate safely and without any problems. The permissible
ambient conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.
Disclaimer of Liability

We have reviewed the contents of this publication to ensure consistency with the hardware and software
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the
information in this publication is reviewed regularly and any necessary corrections are included in subsequent
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STEP 7 CFC Readme

1.1 Security information

Configuring CFC charts

Siemens provides products and solutions with industrial security functions that support the
secure operation of plants, systems, machines and networks.

In order to protect plants, systems, machines and networks against cyber threats, it is
necessary to implement — and continuously maintain — a holistic, state-of-the-art industrial
security concept. Siemens’ products and solutions constitute one element of such a concept.

Customers are responsible for preventing unauthorized access to their plants, systems,
machines and networks. Such systems, machines and components should only be connected
to an enterprise network or the internet if and to the extent such a connection is necessary
and only when appropriate security measures (e.g. firewalls and/or network segmentation)
are in place.

For additional information on industrial security measures that may be implemented, please
visit
https:/lwww.siemens.com/industrialsecurity (https://www.siemens.com/industrialsecurity).

Siemens’ products and solutions undergo continuous development to make them more
secure. Siemens strongly recommends that product updates are applied as soon as they are
available and that the latest product versions are used. Use of product versions that are no
longer supported, and failure to apply the latest updates may increase customer’s exposure to
cyber threats.

To stay informed about product updates, subscribe to the Siemens Industrial Security RSS
Feed under
https:/lwww.siemens.com/cert (https://www.siemens.com/cert).

System Manual, 11/2022, A5E52420813-AA 9
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1.2 Scope of delivery for SIMATIC STEP 7 CFC

1.2 Scope of delivery for SIMATIC STEP 7 CFC

The scope of delivery includes:
* SIMATIC STEP 7 CFC V18

Configuring CFC charts
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1.3 What's new in SIMATIC STEP 7 CFC in TIA Portal V18?

1.3 What's new in SIMATIC STEP 7 CFC in TIA Portal V18?

CFC integration in TIA Portal V18

Compared with previous versions, SIMATIC STEP 7 CFC V18 supports the following additional
CPUs:

¢ Advanced Controllers:

— Technology CPUs

— Other redundant CPUs
 Distributed Controllers "ET200SP"

Supported data types: ARRAY
As of V18, the "ARRAY" data type is supported.
All data types except ARRAY and reference data types are permitted for the components.
Not permitted data types:
* ARRAY
e Pointer: ANY, POINTER, VARIANT
e Parameter types: COUNTER, TIMER

Format

¢ ARRAY[Low limit..High limit] of <Data type>

PLC data types (UDT): Updating the block type

After changing PLC data types in STEP 7, you must update the block instances in the CFC
charts.

Up to now, the interconnections were lost as a result of this update.

As of V18, the interconnections are automatically also updated. It is no longer necessary to
manually adapt the interconnections at the instances.

Requirement:
¢ All changed blocks that are currently interconnected are updated at the same time.

If you update only some of the instances or some of the changed blocks, the
interconnections to the non-updated block instances are lost.

The removed interconnections are listed in the log. Adapt these interconnections
afterward.

Configuring CFC charts
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1.3 What's new in SIMATIC STEP 7 CFC in TIA Portal V18?

TIA Portal Openness: Exporting and importing CFC charts

You can export and import CFC charts as XML files using the API for the automation of
engineering workflows.

e Exporting all CFC charts or selected CFC charts of a PLC

¢ Importing CFC charts

¢ Managing passwords of CFC charts

For more information, refer to the TIA Portal Openness documentation on:

e "CFCcharts (export/import) (Page 365)"

"Export/import CFC" dialog

You can also export and import CFC charts in the TIA Portal project view via the "Export /
Import CFC" dialog.

More information:

* Export/import via CFC dialog (Page 21)

TIA Portal Information System

See also

12

The documentation for SIMATIC STEP 7 CFC V18 is available in the information system of the
TIA Portal:

¢ "Programming a PLC > Creating CFC charts and configuring technologically > Configuring
CFC charts (Page 23)"

General information about SIMATIC STEP 7 CFC (Page|17)
CFC charts for S7 target systems (Page|229)

Configuring CFC charts
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1.4 System requirements for SIMATIC STEP 7 CFC

1.4 System requirements for SIMATIC STEP 7 CFC

Hardware requirements

¢ No change compared to TIA Portal V18.

Software requirements
e TIA Portal V18

Supported systems
CFCin the TIA Portal supports CPUs of the following product groups.
Requirement:

¢ Firmware version = V2.8

Advanced Controllers

e Standard CPUs

¢ Technology CPUs

* Fail-safe CPUs "

 Fail-safe technology CPUs "

* Redundant CPUs 2

1) Only with deactivated fail-safe functionality.

2) In the compatibility tool you find detailed information on which CPUs are supported.

Distributed Controllers
e ET 200SP CPUs
e Fail-safe ET 200SP CPUs "

1) Only with deactivated fail-safe functionality.

Software Controllers
e Standard CPUs:

- CPU 1507S

— CPU 1508S

Restrictions
e STEP 7 Safety and F-CPUs with enabled F-function are not supported.

You can use either CFC or the fail-safe functionality on a CPU.

Configuring CFC charts
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1.4 System requirements for SIMATIC STEP 7 CFC

Compatibility tool

With the compatibility tool, Industry Online Support gives you a function you can use to put
together a compatible selection of software products or to check existing configurations for
compatibility.

In the following entry you can call the compatibility tool and find additional information on
the operation of the tool:

* Internet: "Compatibility Tool for Automation and Drive Technology” (entry ID: 64847781)
(https://support.industry.siemens.com/cs/ww/en/view/64847781)

See also
CFC charts for S7 target systems (Page|229)

Configuring CFC charts
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1.5 SIMATIC STEP 7 CFC licensing

1.5 SIMATIC STEP 7 CFC licensing

License types

Configuring CFC charts

For CFC, you need an engineering license as well as runtime licenses for each CPU.

Engineering license

A license key must be installed on the PC to configure CFC charts.

Runtime licenses
You need a license key for each PLC.

Depending on the number of instance data blocks which are created during configuration
with CFC, you either need a limited or unlimited license:

¢ Alimited license allows you to create a limited number of instance DBs and load them to
the PLC.

e With an unlimited license, you can create and upload an unlimited number of instance
DBs.

You can find information on the instance DBs in the "Chart sequence and extras" editor in the
"Statistics" tab. The number of instance DBs is displayed which have been created in all CFC
charts under the PLC.

More information in the TIA Portal Information System:

¢ "Configuring technologically > Configuring CFC charts > Working with CFCs charts for S7 >
"Chart sequence & extras" editor for S7 (Page 235)"

Trial license

If you do not have a valid license, the system alerts you that you are working in a non-
licensed mode.

You have the one-time option of activating a trial license.

However, this trial license is valid for a limited period only and expires after 21 days.

System Manual, 11/2022, A5E52420813-AA 15
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1.5 SIMATIC STEP 7 CFC licensing

Licenses for SIMATIC STEP 7 CFC V18.0

License Display in the Comment
"Automation
Licence Manager"
SIMATIC STEP 7 CFC V18.0 SIMATIC STEP 7 CFC Trial license
Software Media Package Advanced 18.0 The license is already included in
the TIA Portal installation.
SIMATIC STEP 7 CFC 18.0 Advanced | SIMATIC STEP 7 CFC Engineering license
Engineering Advanced 18.0
SIMATIC STEP 7 CFC Runtime CPU | - Runtime license:
(limited)

¢ Unlimited runtime
e Limited number of instance DBs

SIMATIC STEP 7 CFC Runtime CPU - Runtime license:
(unlimited)

¢ Unlimited runtime

¢ Unlimited number of instance
DBs

More information

See also

16

Online catalog (Industry Mall)

e Internet: "STEP 7 (TIA Portal) options: STEP 7 CFC (TIA Portal)"
(https://mall.industry.siemens.com/mall/en/WW/Catalog/Products/10414342?tree=Catalog
Tree)

TIA Portal Information System

* ‘Installation > Licensing"

Automation License Manager (ALM)

To open the manual, in the Windows program group "Siemens Automation”, select the entry
"Documentation”.

The "Manuals" folder contains the link to the manual in the respective language folder.

CFC charts for S7 target systems (Page|229)

Configuring CFC charts
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1.6 General information about SIMATIC STEP 7 CFC

Content
The information in this readme file supersedes statements made in other documents.
¢ Important information on product properties
¢ Information that could no longer be included in the online help.

Read the following notes carefully because they include important information for installation
and use.

Read these notes prior to installation.

TIA Portal projects: Restrictions
The following functions are not supported when using CFC in the TIA Portal:
e Software units
Do not create software units on controllers for which CFC charts are configured.

The configuration of software units can lead to the TIA Portal project no longer being
compiled for this controller.

¢ UMAC-protected projects
¢ Downloading blocks generated by CFC from the device
¢ Load CFC charts on memory cards

¢ Interconnect PLC tags with complex data types

Configuring CFC charts
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1.6 General information about SIMATIC STEP 7 CFC

Global data blocks in CFC

To improve performance, create the block structure for global data blocks according to TIA
Portal recommendations.

More information:

¢ Industry Online Support: "How do you efficiently and effectively program for the S7-
1200/S7-1500 in STEP 7 (TIA Portal)?"

(https://support.industry.siemens.com/cs/ww/en/view/67582299)

¢ Industry Online Support: "Programming Guidelines and Programming Styleguide for
SIMATIC S7-1200 and S7-1500"

(https://support.industry.siemens.com/cs/ww/en/view/81318674)

A crution

Avoid changing the structure

When interconnecting global data blocks in CFC, the following constraints apply:
* Avoid subsequent modification of interconnected global data blocks.
* Avoid changing the structure of global data blocks.

Loading after a structure change causes the PLC to stop.

Download of changes during operation is not possible.

Password: No authorization, no know-how protection of the charts

To protect a CFC chart or hierarchical CFC chart from unintentional editing, you can protect
the chart with a password.

NOTICE

Activating password for CFC chart

The password serves only to protect a CFC chart from unintentional editing.
This type of access protection is not intended to increase the access security.
The password does not offer:

* Protection against unauthorized access to know-how in CFC charts
» Security-relevant authorization for access to CFC charts

Instructions: "LBCFC" library for download

The "LBCFC" block library supplements the instruction library installed with SIMATIC STEP 7
CFCV17.

More information:

* Industry Online Support: SIMATIC STEP 7 CFC V17 - "LBCFC" block library (ID 109800972)
(https://support.industry.siemens.com/cs/ww/en/view/109800972)

Configuring CFC charts
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Instructions: No version update
Always use the current version of the application library.

After the first import of an instruction in CFC you can no longer change the version. All
further instances of the instruction are created with the same version.

When you change an instruction version in the library later, the instruction is marked as "not
supported" with an asterisk.

GRAPH blocks: Using only in a block shell

You cannot insert GRAPH blocks as instances in a CFC chart. Any change of a GRAPH block
would then eliminate the ability to perform an online delta download and would require a
complete download in CPU Stop.

To work with a GRAPH block in CFC, create an organization block (OB) that uses a GRAPH
block.

Even if you change and re-initialize the GRAPH block, you can then update the CPU using a
delta download.

Using an FB as a call block

If, for example, a GRAPH block affects the CFC run sequence, create a function block (FB) as a
“call block" that calls an instance of the GRAPH block.

If input parameters and output parameters have been configured at the call block, you can
pass these values to the called instance of the GRAPH block.

Ensure that the interface of the GRAPH block is no longer changed. Interface changes
eliminate the ability to perform an online delta download.

Procedure:

1. Create a GRAPH block.

To create an instance of the GRAPH block, create a new data block (DB).
Select the GRAPH block as "Type".

Create a function block (FB) as call block.

In the FB, configure the call of the DB that you have created as the GRAPH instance.

o v ok W N

To exchange values with the called GRAPH instance, configure the corresponding input
parameters and output parameters at the FB.

7. Drag the FB into your CFC chart.

The FB instance in the CFC chart gives you access to the called instance of the GRAPH
block.

Configuring CFC charts
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1.6 General information about SIMATIC STEP 7 CFC

Data types
The following data types of the S7-1500 are not supported:
e WString
Exception: The WString data type is used with OPC UA.
e Block FB
e Block FC
The following data types of the S7-1500 are supported to a limited extent:
* ARRAY
More information in the TIA Portal Information System:
"Configuring CFC charts > Data types in CFC > Compound data types > ARRAY (Page|222)".
* VARIANT
No blocks with output parameters of the VARIANT data type

Do not change internal CFC blocks

CFC creates system blocks that are displayed in a number of views or lists, for example, under
"Program information".

You may not change these objects.

Only edit your own blocks and instructions using the STEP 7 editors.

Deleting CFC charts and deactivating CFC

When you delete all CFC charts, the option "SIMATIC STEP 7 CFC" remains active in the TIA
Portal.

Downloading to the PLC therefore causes the project to be saved.

To deactivate CFC in TIA Portal, delete all CFC components:

1. Select the entry "Charts" in the project tree.

2. Select the "Delete" entry from the shortcut menu and confirm with "OK".
The full contents of the "Charts" folder are deleted.

3. To reactivate the "CFC" option, double-click the entry "Add new chart" under "Charts".

See also

Notes on exportingl/importing CFC charts (TIA Portal Openness) (Page|21)

Configuring CFC charts
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1.7 Notes on exporting/importing CFC charts (TIA Portal Openness)

1.7 Notes on exporting/importing CFC charts (TIA Portal Openness)
Notes on CFC Openness applications

TIA Portal project view: Exporting and importing CFC charts

You can also export and import CFC charts in the TIA Portal project via the "Export / Import
CFC" dialog.

The dialog uses the Openness functions for exporting and importing CFC charts. The same
constraints apply as when using the Openness functions directly.

Follow the instructions under "Security measures for TIA Portal Openness applications":

¢ "Programming a PLC > Creating CFC charts and configuring technologically > Configuring
CFC charts > Openness: CFC (Page 365)"

Requirements
¢ "TIA Openness" is installed.
e The PLCis not online.
¢ The CFC charts to be exported are not password-protected.
CFC charts with configured passwords are ignored during the export.

¢ Import: The imported block types have been created and compiled under the PLC in the
TIA Portal.

If the imported XML file contains blocks that have not yet been created, the import is
canceled.

Procedure

1. Select the "Charts" entry or a CFC chart in the project tree.

2. Select the "Tools > Import | Export CFC" entry in the menu bar.
The "Export / Import CFC" dialog opens.

3. Select the action you want:
— Export all CFC charts of the PLC

The block types and the settings for tasks and run sequence are also exported along
with the CFC charts.

— Export individual CFC charts
The CFC charts are exported without block types, task settings, and run sequence.
Click "Next" and select the desired charts.

— Import CFC charts

You can select the scope of the import in the next "Data transfer - Generate/import”
dialog.

4. Click "Next".

Configuring CFC charts
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1.7 Notes on exporting/importing CFC charts (TIA Portal Openness)

5. Select the storage path of the XML file and click "Finish".
The export or import is started.

6. If you are exporting CFC charts, confirm the message that the XML file has been written.
The XML file with the exported data is located in the selected storage path.

7. If you are importing CFC charts, the "Data transfer - Generate/import" dialog opens.

Select the objects to be imported, and click the "Import objects from B to A" button in the
"Generatel/import" area: gg

The desired data is imported into the TIA Portal project under the PLC.
The Inspector window contains information on the import where appropriate.
More information on the "Data transfer - Generate/import" dialog:

* Industry Online Support: "SIMATIC Process Control System PCS 7 Help on data transfer
dialog” (https://support.industry.siemens.com/cs/ww/en/view/109812471)

Openness: "filter" parameter

The "filter" parameter is not evaluated during export and import in the current CFC version
and has no function.

Openness: Error message when importing

If the import using the TIA Portal Openness APl is aborted with an error message regarding
the work memory, check the work memory on the PC.

If necessary, increase the work memory according to the hardware requirements for large
projects:

¢ RAM: 32 GB for large projects

Import of function blocks: Alarm data comparison always reports difference

Function blocks show an alarm data attribute, which is always exported and imported. This
may also apply if no alarms are configured.

When matching the imported data in the "Data Transfer - Generate/Import" dialog, a
difference is always displayed for this attribute, even if the import was completed correctly.

If necessary, check your instance-specific messages.

See also
General information about SIMATIC STEP 7 CFC (Page|17)

Configuring CFC charts
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Introduction and basics

2.1 Basics of CFC

What is CFC?

Using CFC

See also

Configuring CFC charts

"CFC" stands for "Continuous Function Chart".

With CFC, you create user programs by simple placement, parameter assignment and
interconnection of instructions and blocks in the CFC charts.

You use extensive libraries with premade instructions and blocks. This means that
instructions and blocks do not need to be programmed. The likelihood of errors is reduced.

The "CFC" editor supports you with these functions when creating the user program:
¢ Automatic creation of the user program for all CFC charts

¢ Transfer of the user program to the device of the target system

You use CFCin particular for process engineering or structured automation solutions.

You interconnect, for example, blocks you have created yourself or instructions supplied by
CFC with the operands of your target system.

With the help of a CFC chart, even a complex user program remains clearly laid out.

You can monitor process values as well as input and output parameters of the instructions
and blocks online for testing.

Type and instance (Page|27)

Configuration options for CFC charts (Page 24)
Overview for configuration of CFC charts (Page 61)
"CFC" Editor (Page 43)

Basic settings for CFC charts (Page|41)

Icons in CFC (Page|51)
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2.2 Configuration options for CFC charts

2.2

Configuration options for CFC charts

Configuring CFC charts

In the "CFC" Editor, you configure the CFC charts either graphically by dragging and dropping
with the mouse or textually in the form of a list.

You can change from one configuration method to the other at any time with no restrictions.

When you create user programs with CFC, we recommend that the block programming is
complete and that the block types are no longer changed.

Graphic configuration of CFC charts in "Data flow" mode

When you configure graphically in "data flow" mode, you insert instructions and blocks in the
CFC chart from a library, for example.

You interconnect the input and output parameters with drag-and-drop, via a mouse click or
by using a keyboard shortcut and click.

To document the CFC chart, you use text boxes.
The advantages of graphic configuration compared with textual configuration are as follows:

¢ Simple wiring of input and output parameters using drag-and-drop, a mouse click, or a
keyboard shortcut

e Graphic representation of the signal path

¢ OQOutline of complex charts in chart partitions

Textual configuration of CFC charts in "Control flow" mode

See also

24

With the textual configuration method in "Control flow" mode, you insert the instructions and
blocks in a list.

The input and output parameters are not interconnected graphically, but you will assign
values to the parameters.

The advantages of textual configuration compared with graphic configuration are as follows:
¢ Simple adaptation of the run sequence

¢ Simple parameter assignment

Basics of CFC (Page 23)
"CFC" Editor (Page 43)

Configuring CFC charts
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2.3 Instructions and blocks

2.3 Instructions and blocks

With CFC, you create user programs by simple placement, parameter assignment and
interconnection of instructions and blocks in the CFC charts.

When you create user programs with CFC, we recommend that the block programming is
complete and that the block types are no longer changed.

Distinction between instructions and blocks

The designation depends on how they are created and the target system, for example.

Instructions

Instructions are predefined, basic functions, such as logic operations and arithmetic
functions.

Instructions are program components of CFC and are available in the "Instructions” task card.

Blocks
You can create blocks yourself or use predefined blocks from the library.
¢ Function blocks (FB):

Function blocks are code blocks that store their values permanently in instance data
blocks.

The values are still available after the block has been processed.

The data are available and accessible during processing across multiple cycles.
¢ Functions (FC):

Functions contain program routines for recurring tasks.

They have no data memory in which values of block parameters can be stored.

Therefore, when a function is called, all formal parameters must be assigned actual
parameters. A data block is not required.

You can also interconnect the parameters of function blocks and functions with elements of
global data blocks.

Blocks for the S7 target system

There are other block types in the S7 target system.

Additional information: "Working with CFC charts for S7 > Blocks in CFC charts for S7"

Configuring CFC charts
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2.3 Instructions and blocks

Properties of instructions and blocks

26

There are additional terms associated with instructions and blocks:

Type and instance
e Atypeis areusable, pre-defined block.

The block can be provided in a library or you can create it yourself.
* Aninstance is a use of a type, for example, in the CFC chart.

Additional information: "Type and instance (Page|27)"

Generic instructions

The number of inputs is variable in generic instructions and can be changed in the CFC chart,
for example, AND logic operation.

Additional information: "Adding or removing input parameters (Page 145)"

Family

The instructions/blocks are grouped according to their function characteristics, the instruction
or block families, e.g. CONVERT.

Configuring CFC charts
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2.4

2.4 Type and instance

Type and instance

Type-instance concept

Type

Configuring CFC charts

Configuration in CFC is made easier by using types or their instances.

A block type is a reusable, pre-defined function that you yourself create or copy from a
library.

You create a block instance by inserting a block type into a CFC chart.

The advantage of this type-instance concept is that you can implement any central change of
the type at a later time at all instances.

A type can be defined by the following options:

¢ When inserting a block from the "Program blocks" folder in the project tree into a CFC
chart.

The block in the "Program blocks" folder is imported into CFC and defined as type.
The "copy" in the CFC chart is an instance of this type.
¢ A block that you want to define as type is saved in one of the libraries.
This can be a block from the "Program blocks" folder, for example, or from a CFC chart.

If this saved block is added to a CFC chart from the library, the block is imported in CFC
and defined as type.

The "copy" in the CFC chart is an instance of this type.
A type can already be defined as supplied block in a library.
Central type change

When you change the type, you can update the instances of this type in all CFC charts of a
target system.

Additional information: "Central change of a type (Page 115)"

Note
Delete block type: Check instances

First delete the instances followed by the block type.

If you delete a type of which an instance still exists, then you will no longer be able to
compile the CFC charts of this target system.

You may find the information on the missing block types in the alarms of the Inspector
window or in the "Chart sequence & extras" editor.

System Manual, 11/2022, A5E52420813-AA 27



Introduction and basics

2.4 Type and instance

Instance

See also

28

An instance is the use of a type in the CFC chart.
You can create any number of instances from a type.

Within a CFC chart, each instance has a unique name. The instance name consists of the
name of the CFC chart in which the instance is located, the name of the type and the instance
number.

The instance normally inherits the defaults of the type, for example, the default values of the
parameters.

During configuration, you can enter individual initial values, change the instance name and
interconnect the input and output parameters.

Adding an instruction or block to the CFC chart (Page/108)
Updating instances of a changed block type (Page 119)
Creating a block type for CFC (Page 121)

Configuring CFC charts
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2.5 Hierarchical CFC charts

You can create CFC charts in hierarchical structures.

In doing so, you add one or more CFC charts as "subcharts" into a "basic chart".

Nesting depth
A subchart can contain additional subcharts so that you are creating a nested hierarchy.
Maximum nesting depth of hierarchical CFC charts:
¢ 8 hierarchy levels:

Basic chart + 7 subcharts

Managing hierarchical CFC charts
When inserting a CFC chart as subchart, a copy of the inserted chart is created under the basic
chart.
Editing subcharts

The original, added CFC chart and the newly created subchart are edited independently of
one another.

Changes in the subchart do not affect the originally inserted CFC chart and vice versa.

Copying or moving subcharts
The hierarchical CFC charts can be handled like blocks.
You can copy or move subcharts within a chart or to another basic chart.

If the selected subchart contains additional subcharts, these are copied or moved as well.

Deleting hierarchical charts

When you delete a CFC chart that was inserted as subchart, the subchart is retained.
When you delete a subchart that contains additional subcharts, these charts are deleted as
well.

Replacing subchart

You can replace a hierarchical CFC chart with a different hierarchical CFC chart.

If possible, the existing interconnections are retained.

The position in the run sequence is not changed.

Additional information: "Replacing hierarchical CFC charts (Page 89)"

Changing layers
You can elevate a subchart to the root level in the "Charts" folder.
In this case, however, the chart interface may not have an external interconnection.

Additional information: "Moving subcharts to the root level (Page 91)"

Configuring CFC charts
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2.5 Hierarchical CFC charts

Representation in the project tree
Hierarchical charts are displayed in the project tree in the "Charts" folder.
A basic chart is indicated using a folder icon.

The actual basic chart and all subcharts are displayed in this folder. When a subchart contains
additional subcharts, this subchart is also displayed as a directory.

To open a basic chart, double-click the "Chart" icon below the chart name: j#
Example

= [igj Charts
ﬁ Add new chart
i’ Chart sequence & extras
io} crc_ 1
~ e CFC_2
| Chart
ot crC 1
ok crc 2
> iz cFC 2 1
1 chart
Intcrc 2 2
ot crc 4
ntcrc 2 2
Nk crc 4
ol cFC_3
IO} crc_4

The chart "CFC_2"is a basic chart that contains the subcharts "CFC_1", "CFC_2", "CFC_2 1",
"CFC_2_2"and "CFC_4".

The subchart "CFC_2_1", in turn, is the basic chart for the contained subcharts "CFC_2 2" and
"CFC_4".

The subcharts called "CFC_4" were created as independent copies by inserting the chart
"CFC_4". To avoid confusion, assign meaningful names to the subcharts.

Configuring CFC charts
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Visualization of the subcharts in the basic chart

A subchart is visualized in a higher-level chart similar to a block with "subchart header" and
"chart interface".

However, a different icon is used in the "subchart header".

The following figure shows a section of the subchart "CFC_2_1" that is included in the basic
chart "CFC_2".

The subchart "CFC_2_1" contains the subcharts "CFC_4"and "CFC_2_ 2"
¢ Only the standard parameter EN exists at the subchart "CFC_4".

¢ The parameters that are defined in the chart interface are displayed in the subchart
"CFC_2_2".

» CFC 2 » CFC 2 1

] @ [100% M %2
CFC_4
CFC
1—EN
}D-l CFC_2 2
CFC
1
1—EN OutChart By}l——
InChart_By

Navigation within the hierarchy
The following navigation options are available in the CFC charts:
¢ Navigation "down":
— With double-click on the subchart icon.

— Select the subchart icon and execute the "Open" menu command from the shortcut
menu.

¢ Navigation "up":
— Execute the "Open parent chart" from the shortcut menu in the opened subchart.

— Double-click a sheet bar entry that contains an interconnection to the interface of this
subchart.

Use the entry "Back” in the shortcut menu to jump back to the last selected parameter.

Configuring CFC charts
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2.5 Hierarchical CFC charts

Interface of the CFC chart

Hierarchical CFC charts and standard CFC charts have an interface structure that is similar to
that of blocks. This means that these CFC charts can be configured and interconnected
externally similar to blocks.

The chart interface is displayed in the top area of the data flow and control flow section in the
"CFC" editor. When the "Interface" area is hidden, enlarge the area with the mouse or click the
unhide icon: ===

New parameters can be added, modified or deleted in the Input, Output, InOut sections of
the chart interface.

Interconnections of interface parameters with blocks within the CFC chart are displayed in the
sheet bar of the chart with connectors.

Additional information:
¢ "Adding, editing and sorting parameters of the chart interface (Page(92)"

¢ ‘"Interconnections to parameters of the chart interface (Page|141)"

Jump to the interconnected parameter

32

The shortcut menu of a parameter at the subchart icon contains the menu command "Track
signal”.

The menu command "Track signal” opens the subchart and selects the interconnected
parameter of the block.

You use this command to track the signal from the chart interface into the inside of the chart.

If multiple parameters are interconnected, select the required parameter from the shortcut
menu.

Use the entry "Back” in the shortcut menu to jump back to the last selected parameter.

Configuring CFC charts
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2.5 Hierarchical CFC charts

Interconnections in a hierarchical CFC chart

Run sequence

See also

Configuring CFC charts

You configure the interconnections in a hierarchical chart via the chart interface or directly to
blocks in the chart.

When you move a block with an interconnection to the chart interface to a different CFC
chart, the existing interconnection to the interface is deleted.

The following rules apply to interconnections between the parameters in the block and in the
chart interface:

You can only interconnect parameters from the same section of the chart and block
interfaces.

Example: An Input parameter of the chart interface is interconnected with an Input
parameter at the block.

Alternatively, you can interconnect the Input parameter of a block with an InOut
parameter of the chart interface.

The data types of the interconnected parameters and of the blocks are subject to the same
conditions.

On the S7 target system, it is not possible to interconnect individual elements of a STRUCT
parameter type with the chart interface.

Interface parameters of the Output type cannot be configured directly.

Enter the value at the interconnected output parameter.

The run sequence of the blocks is bound to the CFC chart.
Hierarchical CFC charts can be handled like objects within the run sequence.
Subcharts inherit the task assignment of the basic chart by default.

If a subchart that has further subcharts has a different task assignment, this different task
assignment is inherited by all child subcharts.

The "Reduction ratio" and "Phase shift" functions are only available for basic charts.

The subcharts are called in the run sequence in accordance with their associated basic
chart.

The "Enable chart" function is available for subcharts.
Requirements for processing the lower-level subcharts:

— The "Enable chart" setting is also set in the basic chart.

Creating a subchart for a hierarchical CFC chart (Page 87)

Overview of textual interconnections (Page 153)

Managing CFC charts and groups (Page 76)
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2.6 Protection from unintentional access to CFC charts

2.6

Overview

Principle

34

Protection from unintentional access to CFC charts

To protect a CFC chart or hierarchical CFC chart from unintentional editing, you can protect
the chart with a password.

The contents of the CFC chart can only be viewed after the correct password has been
entered.

NOTICE

Password: No authorization, no know-how protection of the charts
The password serves only to protect a CFC chart from unintentional editing.
This type of access protection is not intended to increase the access security.

The password does not offer:
* Protection against unauthorized access to know-how in CFC charts
» Security-relevant authorization for access to CFC charts

You will be asked for the password when you open the CFC chart.

The password-protected CFC chart can be handled as normal as long as it remains open in the
editor.

Once password protection has been set, the current password must be entered to change or
remove the password.

Hierarchical charts
Setting or removing a password for a basic chart does not affect the passwords of subcharts.

If subcharts are password-protected, you will need to enter the password again when you
open these charts.

As soon as a password is assigned to a basic chart, the behavior changes:

* Aslong as the basic chart is closed, the hierarchical view remains hidden in the project
tree

e For subcharts which do not have their own password, the "Access protection” entry in the
shortcut menu is hidden.

The "Protection” button is disabled in the chart properties.

To protect one of the subcharts from unintentional editing, open the subchart. In the
project tree, the "Access protection” entry is displayed in the shortcut menu of the
subchart. The "Protection” button is enabled in the chart properties.

Configuring CFC charts
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2.6 Protection from unintentional access to CFC charts

Properties of a CFC chart with password protection

Without a valid password, you only have limited access to the chart:

More information

Configuring CFC charts

The content of charts and subcharts is not visible.

References to chart contents via direct object selection with the mouse or text input are
not possible.

Compiling and loading is possible without entering a password.
During a type update, instances in password-protected charts are also updated.
Password input is not necessary for this.

You can copy the chart without entering the password.

The copied chart has the same password, however.

The display of the chart properties in the Inspector window is limited.
Users can only change the name and comment.

All other properties are either not visible or cannot be changed.

The chart interface is displayed as read-only.

The following parameter assignments can be applied:

— Value

— "Invisible" property

— Test settings

— External interconnections to the chart interface

The printout comprises only the chart interface and the limited information on the chart
properties.

Activating password for a CFC chart (Page 81)
Changing or deactivating password for a CFC chart (Page 82)
Opening a password-protected CFC chart (Page 84)
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2.7 Multilingual texts in CFC

2.7

Multilingual

Multilingual texts in CFC

The following languages are present in a project:
¢ Editing language
Each project has an editing language.
Any text you enter is always created in the editing language.
* Project language
Project languages are all languages in which a project will later be used.

Based on the editing language, all texts can be translated into the various project
languages.

Editing language and project languages are configured in the project tree folder "Languages
& resources" > "Project languages".

Note
User interface

The language of the user interface does not depend on the editing and project language.

Multilingual texts in CFC
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You can manage the following types of text in CFC in several languages:
e Comments from:

— CFCchart

— Instance

— Parameters
* Text block

You enter these texts in the "CFC" editor when you create the CFC chart in the editing
language.

These texts are then translated into the required project languages in the project text editor
of the TIA Portal.

Configuring CFC charts
System Manual, 11/2022, A5E52420813-AA



Introduction and basics
2.7 Multilingual texts in CFC

Translating texts
There are different ways of translating texts:
¢ Translating texts directly

You can enter the translations for the individual project languages directly in the "Project
texts" table.

¢ Translating texts using reference texts
For smaller amounts of text, you can change the editor language.

All the text cells are filled again with the default values and can be filled in the current
language.

More information in the information system of the TIA Portal:

e "Editing project data > Working with multi-language projects”

User interface language: Installing language packs
You can install additional interface languages using TIA Administrator:
1. Install the TIA Portal language packs for the desired user interface languages.
2. Select the tiles for the "SIMATIC STEP 7 CFC" language pack.

3. Load and install the CFC language pack for the installed TIA Portal user interface languages.

Configuring CFC charts
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2.8 Copying objects

2.8 Copying objects

Copy and paste

Copying objects

Copying objects

Copying objects

Moving objects

See also

38

You can copy within the TIA Portal either by dragging with the mouse or using the "Copy" and
"Paste"” commands.

If you want to copy an object in the same area by dragging it with the mouse, you can do this
by holding down the <Ctrl> key.

All selected objects are copied.

within a device
If you copy one or more objects within a device, the copies are numbered in ascending order.

If an object with this naming convention already exists, this number is skipped.

Example:

The chart folder contains the objects "Tag", "Tag_1" and "Tag_34".
If you copy "Tag", the copy is given the name "Tag_2".

If you copy "Tag_34", the copy is given the name "Tag_3".

to a different device
If you copy one or more objects to a different device, the object names are not changed.

If there is already an object with the same name at the destination location, you will be
prompted to decide what to do.

to a different project

To copy objects from one project to another, open the second project in a second instance of
the TIA Portal.

When you copy, the principles are the same as when copying to a different device.

To move objects from one project to another, copy the objects.

Then delete the source object manually.

Copying instructions, blocks and charts (Page|106)

Overview of textual interconnections (Page 153)

Configuring CFC charts
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2.9 CFC naming conventions

2.9 CFC naming conventions

Permitted characters

Special characters and umlauts are allowed in chart names and in instruction names.

However, to avoid compatibility problems, only use the following characters:

e Characters from
¢ Numbers from "0" to "9"

¢ Underscore" " for separation

atoz

Control characters for path and hierarchy information

There are control characters reserved for path and hierarchy information and that are used,
for example, in "control flow" or in connectors.

The control characters are relevant only for path and hierarchy information. Outside this
context, the control characters are interpreted as permitted parts of a name.

The following table shows the reserved control characters:

Control character Explanation
Dot . Reserved for path and hierarchy information.
Slashes l'and |\ + The dot indicates parameters at instructions/blocks.
e The slash represents hierarchical relationships.
Example:
The expression "Chart_1\Block_1.IN_1" addresses the input
parameter "IN_1" of the instruction "Block_1"in chart "Chart_1".
Quotes " Reserved for starting and completing a character string.
Percent sign % Reserved for starting address ranges.
Dollar sign $ Reserved as the escape character.
The control character following this is interpreted as a permitted
character.

Configuring CFC charts
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2.9 CFC naming conventions

Control characters as parts of names

If you edit chart and instruction names with control characters in the path or hierarchy
information, use the following syntax:

¢ Enter the name in quotes.
Example:
"Motor1.Temperature"
» Precede the control character with the escape character $.
Example:

— Motor1$.Temperature

Example

In the CFC chart "TempControl", the "Motor1.Temperature" instruction is configured for
temperature control of a motor.

The naming convention of the plant owner defines the dot as a separator.

To address the output parameter "OUT" of the instruction in "control flow", the following
notations are permitted:

* TempControl\"Motor1.Temperature".OUT
» TempControl\Motor1$.Temperature.OUT

Configuring CFC charts
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3.1 Basic settings for CFC charts

The basic settings of CFC charts refer to all charts that you have configured in a target system.

Default settings for new charts

Configuring CFC charts

You define the basic settings for new charts in the "Options > Settings > Charts" menu.

You can change the properties of each CFC chart at any time regardless of the basic settings.

Basic settings
The following settings are specified when you create new charts:
¢ Independent of the target system:
— Color of interconnection lines
* Dependent on the target system:
— Appearance of the CFC charts, e.g. sheet bar settings and layout

— If necessary, additional settings, such as the reserved number ranges for user blocks

Changing basic settings
Changes to the basic settings only affect newly created CFC charts.

Existing CFC charts remain unchanged.

Task assignment of CFC charts
Newly created CFC charts have an assigned main task.

Depending on the target system, you change this task assignment in the "Chart sequence &
extras" editor.

Additional information: "Runtime model (Page 161)"
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3.1 Basic settings for CFC charts

Representation of the CFC chart in the editor

If you adapt the zoom factor or the representation of the grid lines in a CFC chart, these
changes apply to all CFC charts you open from this point onwards.

This behavior also applies following a program restart.

Zoom function in the CFC chart

You zoom in the CFC chart with the <Ctrl> key and the mouse wheel.
The zoom focuses on the position of the mouse pointer.

Alternative zoom options:

¢ Keyboard shortcuts <Ctrl+"+"> and <Ctrl+"-">

* Zoom scale at the bottom of the editor window

* % entry or selection in the drop-down list

Position: in the toolbar or next to the zoom scale

See also
Adding an instruction or block to the CFC chart (Page/108)
Printing a CFC chart (Page 78)
CFC views (Page 64)
Extending a CFC chart (Page 71)
"Chart sequence & extras" Editor (Page 47)
Basics of CFC (Page 23)

Configuring CFC charts
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3.2 "CFC" Editor

3.2 "CFC" Editor
In the "CFC" Editor, you configure CFC charts graphically or as a list.

The two configuration methods have the same priority. You can change from one
configuration method to the other at any time.

Open "CFC" editor
You open the "CFC" editor for the first time by adding a new chart.
1. Open the "Charts" folder in the "Project tree".
2. Double-click "Add new chart".
A new CFC chart is created and opened in the editor.
3. To open an already-created CFC chart in the editor, double-click the chart.

The "CFC" editor always contains a CFC chart when it is opened.

Configuring CFC charts
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3.2 "CFC" Editor

Layout of the "CFC" Editor
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3.2 "CFC" Editor

Work area with the "Data flow" and "Control flow" tabs
¢ In the "Data flow" tab, you configure a CFC chart graphically.

¢ In the "Control flow" tab, you specify the run sequence of the instructions and blocks in
the CFC chart.

You also display the configured instructions and blocks with their input and output
parameters in form of a list.

You also select the input and output parameters for testing.

¢ Both in "Control flow" and "Data flow" mode, you can insert, interconnect and set
parameters for instructions and blocks.

Task cards
Task card Use
Instructions Access to all instructions provided by CFC.
Libraries Access to the project library and global libraries.
Testing Configure test settings.
Note

Depending on the target system

The availability and the content of the task cards depend on the target system for which you
are configuring.

Configuring CFC charts
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3.2 "CFC" Editor

Inspector window

See also
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Additional information on a selected object or executed actions are displayed in the Inspector
window.

The Inspector window includes the following elements or functions:
« Different tabs, e.g. "Properties", "Info", "Diagnostics":
Information on selected objects is displayed and editable properties can be changed.

In the "General" tab, you can enter additional details on the CFC chart, a comment or
version information, for example.

¢ Additional lower-level tabs in the "Info" and "Diagnostics" tabs

Alarms and warnings are displayed in the "Info" tab, for example, during compiling or
loading.

¢ Navigation functions within the tabs

You use the Inspector window for the following tasks:

* Set parameters of the instructions/blocks.

* Select parameters of the instructions/blocks for testing.

* Manage interconnections

Note
Depending on the target system

The properties or options in the Inspector window depend on the target system for which you
are configuring.

Basic settings for CFC charts (Page|41)

Configuration options for CFC charts (Page|24)

Overview of CFC instructions (Page|280)

Selecting parameters for testing (Page 171)

Adding an instruction or block to the CFC chart (Page/108)
"Chart sequence & extras" Editor (Page|47)

Overview for configuration of CFC charts (Page 61)
Keyboard operation in CFC (Page 49)

Icons in CFC (Page 51)

Configuring CFC charts
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3.3

Overview

Tab

Table layout

Configuring CFC charts

3.3 "Chart sequence & extras" Editor

"Chart sequence & extras" Editor

In the "Chart sequence & extras" editor, you configure the run sequence of charts.

The assignment of the instructions/blocks to the tasks and therefore the run sequence within
the target system is also displayed.

Note
Depending on the target system

The availability and the content of the tabs depend on the target system for which you are
configuring.

You are working in various tabs of the editor.

Depending on the target system, the following tabs are displayed:
¢ "Chart sequence": Run sequence of the CFC charts

e "Task assignment": Tasks and assigned blocks

¢ "Target system settings": Basic settings for chart folder

¢ "Block instances": Block types with their associated instances

Tabs that are not supported by the target system are not visible.

Information on S7 target systems

* "Working with CFC charts for S7 > "Chart sequence & extras" editor for S7"

In most tabs, you are working in a table.
Depending on the selected tab, you can adapt the representation of the columns in the table.
e Column width:

— You change the width of the individual columns with the mouse.

— You optimize the column width automatically via the shortcut menu.

¢ To change the sequence of the columns, move a column header with a drag-and-drop
operation.
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3.3 "Chart sequence & extras" Editor

See also
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Basic settings for CFC charts (Page 41)
"CFC" Editor (Page 43)

Keyboard operation in CFC (Page 49)
Icons in CFC (Page/51)

Adapting the run sequence (Page|161)

Configuring CFC charts
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Keyboard operation in CFC

3.4 Keyboard operation in CFC

In the TIA Portal and in CFC, keyboard shortcuts are also available for many functions.

Alternatively, you can use user-defined keyboard shortcuts.

Keyboard shortcuts in CFC

The following shortcuts enable operation without the mouse:

Function

Keyboard shortcut

Menu command

Go to the next open CFC chart

<Ctrl+F6>

Go to the previous open CFC chart

<Ctrl+Shift+F6>

Go to the next chart partition, if more than one
chart partition has been created

<Shift+PgDn>

Go to the previous chart partition, if more than
one chart partition has been created

<Shift+PgUp>

Project tree:
Go to the next CFC chart

<Ctrl+Arrow up>

Project tree:

<Ctrl+Arrow down>

Go to the previous CFC chart

Openl/close project tree <Ctrl+1> View > Project tree

Openlclose task card <Ctrl+3> View > Task card

Openl/close detail view <Ctrl+4> View > Detail view

Openlclose Inspector window <Ctrl+5> View > Inspector
window

Display or hide reference projects <Ctrl+9>

Download project data to the device <Ctrl+L> Online > Download to
device

Open Help <F1> Help > Show help

Open help on a block <Shift+F1>

TIA Portal: Operation with the keyboard

You can find an overview of all keyboard shortcuts and the option of assigning user-defined
keyboard shortcuts in the settings of the TIA Portal:

1. Select the "Settings" command in the "Options" menu.
The settings of the TIA Portal are displayed.
2. Open the "Keyboard shortcuts" entry in the area navigation.

You can see an overview of all default and user-defined keyboard shortcuts that are valid
for the currently installed products.

More information in the TIA Portal Information System:
¢ "User interface and operation > Keyboard operation in the TIA Portal"

You learn how to navigate in the TIA Portal using the keyboard, edit objects and customize
the TIA Portal to your needs.

Configuring CFC charts
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3.4 Keyboard operation in CFC

See also
"CFC" Editor (Page 43)
"Chart sequence & extras” Editor (Page 47)

Configuring CFC charts
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3.5 Icons in CFC

3.5 Icons in CFC

The tables below show the icons that you use when working with CFC and describe their
meaning.

Configuring CFC charts

TIA Portal project tree: CFC charts

— lcons under the "Charts" entry

— Online/offline comparison status

Project tree | Trend editor: Trend display/Dynamic display
Project tree / Toolbars: Other icons

CFC editor: Toolbar

CFC editor: Chart view in the "Data flow" tab

— lcons at the block instances

— Interconnections

— Othericons

"Chart sequence & extras" editor

— General

— "Chart sequence" tab

— "Textual interconnections” tab (S7 target system)
— "Block types" tab (S7 target system)

"Update blocks" dialog
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3.5 Icons in CFC

TIA Portal project tree: CFC charts

52

Icons under the "Charts" entry

Icon Meaning
v gt Navigation area for managing CFC charts
= Opens the "Chart sequence & extras” editor
E Creates a new CFC chart.
o CFC chart:
Opens the chart in the CFC editor.
k3 Hierarchical CFC chart:
Icon for a group of hierarchical charts, consisting of the basic chart and subcharts
ot Hierarchical CFC chart:
Opens the basic chart in the CFC editor.
1y Password-protected CFC chart
i The password serves only to protect a CFC chart from unintentional editing.
k3 Password-protected hierarchical chart
e

The password of basic charts does not affect the subcharts contained therein.

To protect the subchart of a protected basic chart from unintentional editing, open the
subchart. In the project tree, the "Access protection” entry is displayed in the shortcut
menu of the subchart.

Online/offline comparison status

The icons for the status display identify whether changes exist in the project and a download
to the device is required.

Icon Meaning

ot The CFC chart exists in the project but not in the device.

e The basic chart exists in the project but not in the device.

oy The CFC chart is identical in the project and device.

k3 The basic chart is identical in the project and device.

I The CFC chart has been changed in the project and exists in the device but is different.
. The basic chart has been changed in the project and exists in the device but is different.
) The basic chart is identical in the project and device, but a subchart has been changed.

Configuring CFC charts
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3.5 Icons in CFC

Project tree / Trend editor: Trend display/Dynamic display

Icon

Meaning

-

)

Project tree:
Navigation area for the "Trend display", "Dynamic display", "Force table" components

L

Project tree:
Creates a new trend display or dynamic display

[

Project tree:
Opens the dynamic display in the table editor

Project tree:
Opens the trend display in the trend editor

Trend editor:
Adds an analog axis in the trend display

Trend editor:
Adds a digital axis in the trend display

Project tree / Toolbars: Other icons

Icon Meaning

= Opens the force table.
You find the entry in the project tree under "Charts - Trend/dynamic display & force
table"

o Refreshes the display
The icon is used in multiple editors and views.

] TIA Portal toolbar:

Split editor area horizontally or vertically
Use the split editor areas to drag interconnections between charts or chart partitions.

Configuring CFC charts
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3.5 Icons in CFC

CFC editor: Toolbar

Icon

Meaning

Fartition_1

[Fartition 2____|

| Partition_2 |t

L

List of created chart partitions in the open CFC chart
Clicking on an entry changes the view to the selected chart partition.

o

Create new chart partition

Delete displayed chart partition
Requirement: The CFC chart consists of at least 2 chart partitions.

o X

Zoom in Jout on the display of the CFC chart:
e Zoomin

e Fitchart to work area

e Fit selection to work area

e Zoom out

100 % -

Select zoom factor of work area

Open displayed CFC chart in a second editor window

This can be used, for example, to simultaneously edit two chart partitions of the
same CFC chart.

Select sheet bar view:
¢ Static sheet bars
¢ No sheet bars

¢ Dynamic sheet bars

Select display of sheet bar entries:
¢ One-line

¢ Two-line

Show [ hide sheet borders
Requirement: The chart or chart partition is divided among at least 2 sheets.

Show [ hide sheet numbers

Show [ hide grid in chart background

Show [ hide position number in the run sequence above the block header.

Show [ hide assigned task above the block header.

Show / hide unit of measurement of the parameters
Requirement: A unit of measurement has been configured for the parameter.

Signal flow highlighting: The signal flow is highlighted in color.
Requirement: The instance of a block or subchart has been selected.

Change between the display of parameter names and comments
Requirement: A comment has been entered for the parameter.

Insert new subchart

54
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3.5 Icons in CFC

Icon Meaning

R Insert text box

i Optimize run sequence in a CFC chart according to the signal flow

=go Place blocks in the displayed chart according to the data flow

= Show selected object in the control flow

e

[Vererbt (Gydlic intd =] Task assignment of the open CFC chart

o Monitoring on/off
Activates the display of the current values during testing.
If you have connected online, all input and output parameters selected for
testing are supplied with current values from the device and also highlighted in
color.

{m Control flow:
Collapse display and show only the top elements

= Control flow:

Expand display and show all lower-level elements

i

Control flow:
Show selected object in data flow

CFC editor: Chart view in the "Data flow" tab

Configuring CFC charts

Icons at the block instances

Icon

Meaning

g

Identifies the instance of a function block (FB) in the open chart.

Identifies the instance of a function (FC) in the open chart.

ol

Identifies the instance of a subchart in the open chart.

Without icon /

= g

Instances of instructions can be marked with different icons or only with the
instruction name.

Identifying instruction instances: The entry "Go to block type" is missing in the
shortcut menu of instruction instances.

C&

Colored border:
The instance has been positioned automatically in the chart.

£

Instances with a colored background:
Not enough space for a complete display or the objects lie on top of each other.
Move the instance or increase the sheet size.

Block is not processed.

The reason is that the enable input "EN" at the block is "FALSE" or the "Enable
chart" option of the chart has been disabled.

Block is processed conditionally.

The reason is that the enable input "EN" at the block or the "Enable chart" option
of the chart has been interconnected.
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Icon Meaning
& An interconnected parameter is hidden.
s A non-interconnected parameter is hidden.
i Add additional input parameters at an instruction instance
The icon is hidden in the following cases:
e Addition is not possible.
e The maximum number of possible input parameters has been reached.
Connector display for an interconnection that cannot be fully displayed:
¢ Light beige: The destination connector lies within the sheet or in the sheet
bar.
» Dark beige: The destination connector lies in the extended sheet bar.
The interconnection is represented by connectors with the same numbers.
To jump between the connectors, double-click the corresponding connector.
O & Status display for the "Forcing" function
0

e Brown (online) / light brown (offline):

The "Add forcing" option has been enabled.
* Blue (online) / light blue (offline):

The "Add forcing" and "Forcing active" options have been enabled.

Interconnections in the data flow

The color of the interconnection lines depends on the data type of the data source. You select
the colors in menu "Options > Settings > Charts > CFC > General".

For interconnections to operands whose data type is not defined, the default value "black" is

used.
Icon Meaning
_inclp Create interconnections
““"'—incDown . .
R When you move the mouse over the input parameters, the interconnectable
mHnGount

parameters are displayed with a green background.
The selected parameter is displayed with a light green background.

Colored signal flow marking

Requirement: The "Highlighting for signal flow" option has been enabled in the
toolbar.

Interconnections in online mode

For BOOL-type interconnections, the display of interconnection lines in online
mode is dependent on the current value.

e Green line: Value="1"

e Dashed blue line: Value ="0"

Identifies textual interconnections in the sheet bar

Configuring CFC charts
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Other icons
Icon Meaning
Shows and hides window areas
=T =1
— Footer:
Slider for zoom factor of the work area
& Footer:
Opens a window for navigation in the chart
Inheritance status of attributes of a selected parameter in the Inspector
window (tab "Properties > General")
e The value of the attribute is handed down from the type to the
instance.
ot Inheritance status of attributes of a selected parameter in the Inspector

window (tab "Properties > General")

¢ The value is not handed down from the type to the instance
because it was changed at the instance.

To restore the inheritance, click on the icon.

Object/parameter  Cperand

~ 3B FE_D1 fb_01_1
in_intD1:= 0
in_int02:= ..Mb_3 l.ou..

Data flow:

Open textual interconnections of interface parameters have the
background color "yellow" in the "Operand" column.

MName Data type
i = CFC2_INT  |Int
i = CFC2_BOOL |Bool

Chart interface:

As long as an interface parameter has not been interconnected, the
table cell of the "Data type" column has a "light gray" background
color.

Upon interconnection, the background color changes to "medium
gray".

Configuring CFC charts
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"Chart sequence & extras" editor

58

General

Icon Meaning

jm Expand display and show only the top elements
= Expand display and show all lower-level elements
o Refreshes the display

"Chart sequence" tab

Icon

Meaning

Optimize run sequence of CFC charts

Show selected object in data flow

Show selected object in the control flow

"Textual interconnections" tab (S7 target system)

Icon Meaning
= Select all displayed textual interconnections
Undo selection of textual interconnections and select no interconnection
e Close textual interconnection
% Delete textual interconnection

"Block types" tab (57 target system)

The "Differences" column displays the status of the block in comparison with the block types.

Icon Meaning
2 There are no differences between the compared blocks.
No action required.
No instances of this imported block are currently used in the CFC.
e Existing differences have no effect in the CFC.
o There are differences between the compared blocks.
The differences are displayed in the Inspector window in the "Properties >
Differences" tab.
0 The block type of the imported block was not found in the block folder.
Other status Status information is displayed in the "Properties" tab of the Inspector
Example: ‘=LIII window. . .
Example: The block is not compiled.

Configuring CFC charts
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"Update blocks" dialog

The icons are displayed in the last column of the "Differences" window.

Icon Meaning

i No download necessary:

o Identifies changed blocks that can be inserted without a download to the CPU.
STEP 7 downloads changed blocks to the PLC where appropriate, irrespective of
CFC.

d Download of software necessary

* Download with CPU Stop necessary

See also
Basics of CFC (Page 23)
"CFC" Editor (Page 43)
"Chart sequence & extras" Editor (Page 47)
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Configuring and adapting CFC charts 4

4.1 Overview for configuration of CFC charts

Preparing the configuration

Basic procedure

Configuring CFC charts

There is normally a planning phase prior to the configuration of CFC charts.

During this planning phase, you specify, for example, how the open-loop and closed-loop
control is structured in the CFC charts.

You can, for example, create a separate CFC chart for each measuring point.

With this strategy, you have greater flexibility when reacting to expansions in the plant.

Note
Using the functions "Undo" and "Redo"

Use the "Undo" and "Redo" buttons in the toolbar to undo or redo any basic actions you have
executed in CFC.

The options on how you can influence the actions with the two buttons also depend on the
target system.

Additional information: "Undo" and "Redo" functions in CFC (Page 63)"

1. Create a controller and program block types.
Create a CFC chart, or open an existing CFC chart for editing.
Add and manage objects in the CFC chart, e.g. blocks, instructions, text boxes.

Configure input and output parameters by interconnection or parameter assignment.

ik wWwN

Adapt the run sequence (*):
— Sequence of blocks/instructions within a CFC chart
— Sequence of the CFC charts
6. Compile and download the CFC chart. (*)
You can find additional information in the documentation for the specific target system.
7. Test the CFC chart or user program. (*)

(*): Whether and to what extent you perform these steps depends on the target system you
are using.

Additional information on the S7 target system: "Working with CFC charts for S7 (Page 249)"

System Manual, 11/2022, A5E52420813-AA 61



Configuring and adapting CFC charts
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See also
"CFC" Editor (Page 43)
Basics of CFC (Page 23)
Creating a CFC chart (Page 69)
Adding an instruction or block to the CFC chart (Page/108)
Interconnecting input and output parameters (Page|135)
Setting the parameters of the input and output parameters (Page|122)
Adapting the run sequence within the CFC chart (Page 166)
Adapting the run sequence of CFC charts (Page|168)

Configuring CFC charts
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4.2 "Undo" and "Redo" functions in CFC

4.2 "Undo" and "Redo" functions in CFC

Use the "Undo" and "Redo" buttons in the toolbar to undo or redo any actions you have
performed.

Action stack
Every action you perform is saved in an action stack.
When undoing actions, the list is processed from top to bottom.

In other words, if you undo an action that lies further down in the list, all actions located
above it in the list will also be undone automatically.

If you perform a new action, then the redo list is emptied.

Displaying the undo/redo list

The "Undo" button in the toolbar is enabled as soon as you perform an action that can be
undone.

This button is split; you can use the arrow down to open a drop-down list.
It contains all actions of the action stack that you can undo.

If you performed actions in an editor other than the currently displayed editor, then the
corresponding editor will also be displayed as a subheading.

This allows you to always identify the point at which the undo operation is applied.

Points to note
The listed actions empty the action stack.
You cannot redo or undo actions after such an action.
¢ Saving the project

¢ Project management (creating a new project, opening project, closing a project, deleting a
project)

¢ Compile

¢ Restoring blocks

¢ Establishing an online connection

* Download

Additional information in the information system of the TIA Portal:

¢ ‘"Introduction to the TIA Portal > Undoing and redoing actions"

Configuring CFC charts
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4.3 Creating and managing CFC charts

4.3

4.3.1

Overview

Creating and managing CFC charts

CFC views

When configuring a CFC chart, you have the following CFC chart views available:
» CFC chart with static sheet bars

e CFC chart with dynamic sheet bars

» CFCchart without sheet bars

You can change the sheet bar view in the toolbar of a CFC chart as required.

Additional information: "Changing the sheet bar view of a CFC chart (Page 86)"

CFC chart with static sheet bars

64

A static area is reserved to the right and left in a CFC chart for the sheet bars.

This area is intended solely for sheet bar entries, for example for interconnections between
charts.

The following figure shows a CFC chart with sheet bars:

Motor drive beh ?
“Motor]_ON... < & — 14 and_3.n1
H
Motor cutter
“Motor2_0ON... <« & — {4 and_3.IN2
“
Sheet bar width

You can change the width of the sheet bars by dragging with the mouse or in the Inspector
window of the CFC chart.

The right and left sheet bars of a chart are always of the same width.

Configuring CFC charts
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CFC chart with dynamic sheet bars

A CFC chart with dynamic sheet bars displays the sheet bar entries only when required and
has the following features that differ from a CFC chart with static sheet bars:

* You can place instructions, blocks or text boxes in the sheet bar area.
¢ The sheet bar area is not highlighted.
The following figure shows a CFC chart with dynamic sheet bars.

The text boxes are placed in the sheet bar area:

Motar drive beft }
“Motor1_ON... < |} & —] i4 and_3.N1
[
Motor cutter
“Motor2_ON.. < | & —] {4 and_3.InN2
]

CFC chart without sheet bars
The CFC chart is displayed without sheet bars.

Interconnections to other CFC charts or to operands are displayed by connectors. The
connectors are placed next the interconnected input or output parameters.

Interconnections between sheets are displayed as if they were on one sheet.

The following figure shows a CFC chart without sheet bars with sheet borders displayed:

Motor drive belt
“Motorl_0... — &
[
& “Motor3_0...
Motor cutter N
“Motor2 0., ——M— & —
1

Printing CFCs without sheet bars
Instructions or blocks in sheet borders are not shown completely when printed.

If you configure without sheet bars, make sure that you do not place these objects in sheet
borders.

In this case, show the sheet borders during configuration.

Configuring CFC charts
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Sheet bar extension

If you create more sheet bar entries than there is room for in the sheet bar, then the sheet
bar is automatically extended.

If a sheet bar has been extended, you will see an arrow in the sheet bar at the bottom of the
sheet.

The following figure shows a sheet bar with the arrow for an extended sheet bar:

Hr_EX_1 7 PDZcrl_pid_7.LIOP MARN_SEL
CTRL_Ex

JSAMPLE_T QEFF
ADEADE_W QY H_ALM [

PIDZctrl_pid_1.AUTOP_EN

(4 PIDZorl_pid_1.005
4GAIN QP H_MWAN

4 QP L_ WA {4 PIDZctrl_pid_1.M_SUP_AH
dmv OPYL_ALM

ATM_LAG QUPRLM 14 PIDZatrl_pid 1.M_SUP_4WH
JLMN_OFF QOMRALM

AHM_LMNHR QSP_HLME T ] 14 PID2ctrl_pid_1.M_SUP_WL
4SPEXON_L {4 PIDZctrl_pid_1.LMM_SEL
LFSEL ]

JPFDE_SEL t4  PIDZarl_pid_1.LMMOP_ON
AOFOB_SEL

JINT_HPOS s PID2atrl_pid_1.ANDP_EN
JINT_HNEG 4
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Configuring CFC charts

Show the extended sheet bar

4.3 Creating and managing CFC charts

If you click on the arrow, the extended sheet bar is shown.

The extended sheet bar is displayed slightly offset above the sheet bar.

The following figure shows an extended sheet bar.

If you click on the arrow at the top border, you return to the sheet bar.

L atrl_E¥ 1
CTRL_EX

—SAMPLE_T
—DEADE_W
—GAIN
—TN
—Tv
—TM_LAG
—LMN_OFF
—NM_LMNHR
—NM_LMNLR
—PY_IN
—OC_PY_IM
—NM_PYHR
—NM_PYLR
—MO_PYHR
—MO_PYLR
— P H_ALM
— PV H_WRN
— P LRI
—PYL_ALM
HYS

|5
—005
—M_SUP_AH
—M_SUP_WH
—M_SUP WL
—M_SUP_AL
—CSF
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Representation and signal tracking of interconnections

Interconnections that cannot be displayed

If the connection line of an interconnection cannot be displayed, the interconnection is
displayed with connectors.

The color of the connector indicates the type of interconnection.
The following color coding can be seen in the figure above:
¢ Connector color "Light beige":

The associated target connector is displayed in the sheet at a parameter or in the sheet
bar.

These are connectors "1" to "5" as well as "7" in the figure.
¢ Connector color "Dark beige":
The selected target connector is displayed in the extended sheet bar.

These are connectors "6" and "8" in the figure.

Signal tracking

If you click on an interconnection or a connector, the interconnection or the associated
connector is highlighted in color.

Interconnections to other sheets are also highlighted.

Additional information on the representation and signal tracking of interconnections:
"Representation and properties of interconnections (Page 126)"

See also
Placing instructions and blocks in the CFC chart (Page|104)
Basic settings for CFC charts (Page 41)

Representation of instructions and blocks (Page 94)
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4.3.2 Creating a CFC chart

Overview
CFC charts always belong to one target system.
A CFC chart is uniquely identified by its name.

The settings, such as sheet number and sheet size, are taken from the basic settings of
charts.

Additional information: "Basic settings for CFC charts (Page 41)"

Display in the overview window
The created CFC charts are displayed in the overview of the project tree.

The column "Author" contains the user who created the chart. To sort by user, double-click on
the column title.

Storage of CFC charts
CFC charts are stored in the project tree under the target system in the "Charts" folder.

You cannot rename the "Charts" folder.

Creating groups
To structure the storage of CFC charts, create groups within the "Charts" folder.
Storing CFC charts in groups has no effect on interconnections or the run sequence.

Additional information: "Managing CFC charts and groups (Page 76)"

Requirement
* The target system has been created.

¢ The Inspector window is open.

Procedure
1. Double-click "Add new chart" in the project tree.
The CFC chart is added to the "Charts" folder and displayed in the editor window.
— The configuration data are displayed in the Inspector window in the "Properties” tab.
— The chartinterface is displayed in the top area of the editor window.

In the "Interface" area you create, delete and interconnect the parameters of the CFC
chart.

You can create interconnections to other CFC charts and block elements.
2. Under "General", enter a meaningful name for the CFC chart in the Inspector window.

3. If necessary, change the sheet number and sheet size under "Sheet bars/layout".

Configuring CFC charts
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S7 target systems: Advanced settings

Result

See also

70

1. If necessary, change the assigned main task under "S7 specific > Sequence”.

2. If necessary, change the settings for the run sequence.

The CFC chart has been created and is open in the work area of the CFC editor.

Additional information on the CFC editor: ""CFC" Editor (Page 43)"

Create CFC chart partitions (Page|73)

CFC naming conventions (Page 39)

Changing the sheet bar view of a CFC chart (Page 86)
Runtime model (Page 161)

Options for determining the run sequence (Page|163)
Extending a CFC chart (Page 71)

Adding an instruction or block to the CFC chart (Page|/108)

Configuring CFC charts
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4.3.3 Extending a CFC chart

Overview

When it is created, a CFC chart consists of a sheet on which you place and interconnect
instructions and blocks.

If there is not enough space for placing or displaying interconnections, extend the CFC chart.
You can extend an existing CFC chart in the following ways:
¢ Increase the number of sheets, for example in the vertical direction.
¢ Increase the sheet size, for example from A4 to A3.
¢ Add chart partitions.
Additional information: "Create CFC chart partitions (Page 73)"

Requirement

¢ The CFCchartis open.

* "Data flow" is displayed.

¢ The Inspector window is open.
Procedure

1. Click in a free area of the CFC chart.
Select the "General" tab in the Inspector window.

Select the "Sheet bar/Layout” entry in the area navigation.

> W N

To extend the CFC chart, increase the number of sheets or enlarge the sheet size.
Change the vertical and horizontal outline of the sheets, if necessary.

The layout settings apply to all chart partitions of a CFC chart.

5. To display all sheets for an overview, select the zoom view "Fit to screen”.
Alternatively, switch to this view with a double-click in the sheet background.

With a double-click in a sheet, you switch from the overview to the clicked sheet.

Alternative procedure
You can also increase the number of sheets by dragging with the mouse.

If you move an instruction or a block beyond the borders of the sheet with drag-and-drop, the
number of sheets increases automatically.

Configuring CFC charts
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Reducing the number of sheets or sheet size

Result

See also

72

When you reduce the sheet size or the number of sheets, some objects may be located
outside the new sheet borders.

These objects are automatically positioned in the remaining area.

If the area is not large enough for all objects, the objects are placed at the top left in the CFC
chart.

Increase the number of sheets and place the objects manually.

The CFC chart is extended.
Use the following keyboard shortcuts to navigate between sheets:
* <Ctrl+Right/Left>

* <Ctrl+Top/Bottom>

Placing instructions and blocks in the CFC chart (Page|104)
Representation and properties of interconnections (Page|126)
Managing CFC charts and groups (Page 76)

Basic settings for CFC charts (Page 41)

Create CFC chart partitions (Page|73)

Configuring CFC charts
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434 Create CFC chart partitions

Overview

When it is created, a CFC chart consists of a sheet on which you place and interconnect
instructions and blocks.

If there is not enough space for placing or displaying interconnections, extend the CFC chart.
You can extend an existing CFC chart in the following ways:

¢ Add chart partitions

¢ Increase the sheet size or the number of sheets

More information: "Extending a CFC chart (Page 71)"

Working with chart partitions

Configuring CFC charts

You work in chart partitions as you do in the sheets of a CFC chart.

You can interconnect and move instructions and blocks between the chart partitions. The
placement in chart partitions has no effect on the control flow.

When you add a block to the control flow, the block is placed in the first chart partition.

Chart partition names

You can give each chart partition its own name:
¢ Maximum 15 characters

¢ The name must be unique in the CFC chart.

¢ The name is always language-neutral.

Configuration limits
A CFC chart contains a maximum of 6 chart partitions with up to 6 sheets each.

When you add additional sheets to a chart partition, this setting also applies to all the other
chart partitions of the CFC chart.

System Manual, 11/2022, A5E52420813-AA 73



Configuring and adapting CFC charts

4.3 Creating and managing CFC charts

Requirement

Navigating between chart partitions

When you open a CFC chart for the first time after starting the TIA Portal, the first chart
partition is displayed. The name of the chart partition is displayed grayed out.

As soon as you add a second chart partition, the drop-down list "Changes to another chart
partition" is activated. The drop-down list box contains the chart partitions sorted
alphabetically by name.

Navigate between the chart partitions using this drop-down list:

{ Partiticn_2 |- ‘
Fartition_1 |
E

Alternatively, change between the chart partitions of the open CFC chart with the following
keyboard shortcuts:

* Next chart partition: <Shift+PgDn>
* Previous chart partition: <Shift+PgUp>

The CFC chart is open.

"Data flow" is displayed.

Procedure: Creating a chart partition

74

1. In the toolbar, click on the button "Adds a chart partition in the CFC chart": &F
The new chart partition is displayed in the editor.
New chart partitions are always created with the name "Partition_<consecutive number>".

2. To change the name, select the entry "Displayed chart partition" in the "General" tab of the
Inspector window.

Enter a meaningful name and a comment, if necessary.
You can enter up to 1000 characters in the comment field.
3. To return to the previous view, select the desired chart partition in the drop-down list.

4. To delete a chart partition, display this chart partition and click on the button "Deletes the
currently displayed chart partition": X

All objects and interconnections of the chart partition are also deleted.

Configuring CFC charts
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Procedure: Configuring interconnections between chart partitions

1.

To display both chart partitions, click on the button "Opens the CFC chart in a second
window": [T

The CFC chart is displayed in two editor windows.
To display both windows, click on one of the buttons for splitting the editor area: = ||

Select the required chart partition from the drop-down list.

. Create the interconnection between the two chart partitions, for example, by using drag and

drop or copy and paste.

The connector at the sheet bar contains the name of the chart partition and the sheet
number.

Alternative procedure: Example "Click Clack"

1.

Result

Click on a parameter so that it is displayed in magenta.

2. Use the drop-down list to switch to the required chart partition.
3.
4

Move the mouse pointer to the required parameter.

. Click on the parameter as soon as it is displayed in green.

The CFC chart is divided up into chart partitions.

See also

Extending a CFC chart (Page 71)
Creating a CFC chart (Page 69)

Creating a subchart for a hierarchical CFC chart (Page 87)

Configuring CFC charts
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4.3.5

Add group

Managing CFC charts and groups

The names of a group or CFC must be unique within a target system.

Inside the target system, you can move or copy the CFCs to any other group within the
"Charts" folder.

Create groups to structure the CFCs in the "Charts" folder.

You can create additional subgroups to an existing group.

1.

Copying a group

Select the "Charts" folder or an existing group in the project tree.

2. Select "Add new group" from the shortcut menu.
3.
4

Enter a meaningful name for the group.

. Move the CFCs you want to move from the "Charts" folder or another group to the new

group using drag-and-drop.
You can also copy the required CFCs and add them to the new group.

To create a new CFC in a group, select the item "Add new chart" in the shortcut menu of
the group.

. Select the group you want to copy in the project tree.

Select "Copy" from the shortcut menu.

Highlight the position of the group you want to create in the project tree within the "Charts"
folder.

Select "Paste” from the shortcut menu.

Note
Naming conflicts during copying

If you copy one or more groups, only the group is checked for name conflicts at the
destination location.

If the group is replaced, charts with the same name are automatically renamed in the group.

Renaming a CFC or group

76

1.
2.

Select the CFC or the group in the project tree.
Select the "Rename" command in the shortcut menu.

Alternatively, press the <F2> key.

. Enter the new name.

Configuring CFC charts
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Deleting a CFC

4.3 Creating and managing CFC charts

Note
Checking interconnections

If you delete a CFC, interconnections to other charts are also deleted.

Before deleting a CFC, you should therefore check whether the chart has interconnections to
other charts.

The values of the respective input and output parameters are reset to the values preset in the
block type.

Correct the reset parameters if necessary.

Procedure

1. Select the CFC in the project tree.

2. Select the "Delete" command in the shortcut menu.
The CFCis deleted.

Interconnections to other charts are also deleted.

Deleting a group

See also

Configuring CFC charts

When you delete a group, you also delete all the objects it contains.

Procedure
1. Select the group in the project tree.

2. Select the "Delete" command in the shortcut menu.

Copying objects (Page 38)

Copying instructions, blocks and charts (Page|106)
Creating a CFC chart (Page|69)

Overview of textual interconnections (Page 153)
Hierarchical CFC charts (Page|29)
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4.3.6 Printing a CFC chart

Overview
You can print CFC charts, for example, to create documentation.
Using multiple selection, you can print several CFC charts at the same time.
In addition to the selected view, the instructions and blocks configured in the CFC chart and
their input and output parameters are also printed.
Settings

You can select different print settings for printing the CFC charts, e.g. sheet bars, number of
sheets, sheet size.

Menu bar: Basic settings for all CFC charts to be newly created

e "Options > Settings > Charts"

Chart properties in the Inspector Print settings for one or more selected CFC charts
window

e "General > Sheet bars/Layout"

Note
Taking into account format and sheet borders

If you use CFC charts without sheet bars, make sure that instructions/blocks are not placed on
sheet borders.

If the sheet size used in the CFC chart does not match the sheet size in the printer, the CFC
chart is scaled automatically when it is printed.

If you select a smaller sheet size for a CFC chart, the position of the objects in the chart is
maintained.

Objects that would be outside the sheet size after the size reduction is positioned
automatically.

Configuring CFC charts
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Printer Select the desired printer from the list or via the "Advanced" button.

Document information Select the desired layout from the list.

The frame stored in the document information is used for the printout.

Print the cover page The cover page from the layout selected under "Document

information” is used.

Print table of contents The table of contents contains the structure of the CFC charts in the

navigation area.

Properties e All: Prints all project data of the selected CFC charts.

e Compact: Prints the project data in compact form.

Additional information in the information system of the TIA Portal:

"Edit project data > Print project contents > Print project documentation”

Procedure: Displaying print preview

1.

Select the CFC charts you want to print in the project tree.

2. Select the "Print preview" command in the shortcut menu.
3.
4

Select the print settings.

. Start creating the print preview by pressing the "Preview" button.

The print preview is opened in the work area.

You can also print the CFC chart from the print preview.

Procedure: Printing a CFC chart

1.

Check the chart settings:
— By using the "Options > Settings > Charts" menu command
— In the properties of the CFC chart in the Inspector window under "Sheet bars/Layout"

Select the CFC charts you want to print in the project tree.

. Select the "Print" command from the shortcut menu.

Alternatively, use the keyboard shortcut <Ctrl+P>.
Select the print settings.
Start the printout with the "Print" button.

Alternative procedure: Print a group

Instead of selecting multiple CFC charts, you can also select a group and then the "Print"
command from the shortcut menu of the group.

in this case, all the CFC charts in the group are printed.

The order in which they are printed is decided by the order of the CFC charts in the project
tree.

Configuring CFC charts
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Result
The CFC chart is output on the printer.
Chart partitions are sorted alphabetically in a CFC chart.
If you have selected several CFC charts, they are printed in the order in which you selected
them.
See also

Basic settings for CFC charts (Page 41)
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4.3.7 Limiting editing of CFC with password

4.3.7.1 Activating password for a CFC chart

To protect a CFC chart or hierarchical CFC chart from unintentional editing, you can protect
the chart with a password.

NOTICE

Password: No authorization, no know-how protection of the charts

The password serves only to protect a CFC chart from unintentional editing.
This type of access protection is not intended to increase the access security.

The password does not offer:
* Protection against unauthorized access to know-how in CFC charts
e Security-relevant authorization for access to CFC charts

More information:

* "Protection from unintentional access to CFC charts (Page 34)"

Procedure
1. Go to the required CFC chart in the project tree.

2. To open the "Enable protection” dialog, select the menu command "Access protection” from
the shortcut menu.

Alternative procedure:
— Double-click on the CFC chart to open it.
— Select the entry "Protection” in the "Properties” tab of the inspector window.
— Click the "Protection” button.
3. Enter the desired password in both boxes.

4. Click "OK" to close the dialog box.

Result
The password is activated for this CFC chart.

This is indicated by a small padlock symbol on the icon of the CFC chart in the project tree.

See also
Protection from unintentional access to CFC charts (Page|34)
Changing or deactivating password for a CFC chart (Page 82)
Opening a password-protected CFC chart (Page 84)
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4.3.7.2

Procedure

Result

82

Changing or deactivating password for a CFC chart

When a password was assigned for a CFC chart, you can change or deactivate the password.

1. Go to the required CFC chart in the project tree.

2. To open the "Change protection” dialog, select the menu command "Access protection” from
the shortcut menu.

Alternative procedure:
— Double-click on the CFC chart to open it and enter the password.
— Select the entry "Protection” in the "Properties” tab of the inspector window.
— Click the "Protection” button.
3. Enter the current password in the "Old password" box.
4. Select whether you want to change or deactivate the password:
— To deactivate the password, click on the "Remove" button.

— To change the password, enter the new password in the boxes "New password" and
"Confirm password".

5. Click "OK" to close the dialog box.

The password is activated or changed for this CFC chart.

When you have deactivated the password, the small padlock symbol is no longer shown on
the icon for the CFC chart in the project tree.

NOTICE

Password: No authorization, no know-how protection of the charts

The password serves only to protect a CFC chart from unintentional editing.
This type of access protection is not intended to increase the access security.

The password does not offer:
* Protection against unauthorized access to know-how in CFC charts
» Security-relevant authorization for access to CFC charts

More information:
» "Protection from unintentional access to CFC charts (Page 34)"
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See also
Protection from unintentional access to CFC charts (Page|34)
Activating password for a CFC chart (Page 81)
Opening a password-protected CFC chart (Page 84)
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4.3.7.3

Requirement

Procedure

Result

84

Opening a password-protected CFC chart

¢ The password is activated in the CFC chart.

Charts with activated password are indicated by a small padlock symbol on the icon of the
CFC chart in the project tree.

1. Go to the required CFC chart in the project tree.
2. Double-click on the CFC chart.
The "Access protection” dialog opens.
3. Enter the password and click "OK".
The CFC chart is open in the "CFC" editor.
The contents of the chart and the interface can be edited.

4. To open the CFC chart write-protected, click the "Cancel" button in the "Access protection”
dialog.

— A message is displayed in the editor window, but the contents of the chart are not
displayed.

— Editing the chart interface is possible to a limited extent.

The CFC chart is opened as editable.

NOTICE

Password: No authorization, no know-how protection of the charts
The password serves only to protect a CFC chart from unintentional editing.
This type of access protection is not intended to increase the access security.

The password does not offer:
* Protection against unauthorized access to know-how in CFC charts
» Security-relevant authorization for access to CFC charts

More information:

» "Protection from unintentional access to CFC charts (Page 34)"
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See also
Protection from unintentional access to CFC charts (Page|34)
Activating password for a CFC chart (Page 81)
Changing or deactivating password for a CFC chart (Page 82)
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4.3.8 Changing the sheet bar view of a CFC chart

Layout of the sheet bars

The following sheet bar views are available:

Static sheet bars

No sheet bars

Dynamic sheet bars

Procedure

—_

. Click in a free area of the CFC chart.

N

. Select the required sheet bar view under "Sheet bars/layout” in the Inspector window.

Alternative procedure

You can also change the sheet bar view using the icon in the toolbar.

Result
The sheet bar view changes.
Connectors in the sheet bars are positioned either in the sheet bar or beside the input or
output parameters on the sheet bar view you have set.

See also

CFC views (Page 64)

Configuring CFC charts
86 System Manual, 11/2022, A5SE52420813-AA



Configuring and adapting CFC charts
4.3 Creating and managing CFC charts

4.3.9 Creating a subchart for a hierarchical CFC chart
You can create CFCs in hierarchical structures.

In doing so, you add one or more CFCs as "subcharts" into a "basic chart".

Procedure: Create a new subchart
1. Open the CFC in which you want to insert a different chart as subchart.

2. Toinsert a new CFC as subchart, click the "Insert a new subchart" icon in the toolbar of the
"CFC" editor: yif

The mouse pointer transforms into an attached subchart icon.

3. Click the position at which you want to insert the new subchart.
The new subchart is displayed as an icon in the opened CFC.
The changes are displayed in the "Charts" folder:

— If the CFCinto which the new subchart was inserted did not contain any subcharts, it is
now displayed as a basic chart.

— The new CFC was created automatically and is now displayed as subchart.

— The new subchart has the name of the basic chart with the suffix " _1".
Assign a meaningful name to the subchart.

4. Configure the newly created subchart.

Alternative procedure: Shortcut menu
1. In the open chart, right-click the location where you want to insert a subchart.

2. Select the "Insert a new subchart" command from the shortcut menu.

Alternative procedure: Insert existing CFC
1. Open the CFC in which you want to insert a different chart as subchart.
2. Drag a CFC from the project tree or a library to the open CFC in the editor.
The new subchart is displayed as an icon in the opened CFC.
The changes are displayed in the "Charts" folder:

— If the CFCinto which the new subchart was inserted did not contain any subcharts, it is
now displayed as a basic chart.

— The CFCyou inserted is copied and displayed as subchart in the tree structure of the
basic chart.

The new subchart and the CFC inserted as source can be configured independently of one
another.

When you change the original, inserted CFC and want to apply the change to the
subchart, you can replace the subchart.

Additional information: "Replacing hierarchical CFC charts (Page 89)"
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Result
You have inserted a subchart in a CFC that represents a hierarchical chart with basic and
subcharts.
In the subchart and basic chart, you can configure new parameters and create
interconnections to parameters in the chart interface.

See also

Hierarchical CFC charts (Page 29)
Create CFC chart partitions (Page|73)
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Use case

Requirement

Procedure

Result

Configuring CFC charts

4.3 Creating and managing CFC charts

Replacing hierarchical CFC charts
You can replace a hierarchical CFC with a different hierarchical CFC.

If possible, the interconnections of the "old" chart are retained.

Replacement can be used, for example, in situations where subcharts are configured as sub-
functions that are intended for use in different applications.

Example

You configured a sub-function as hierarchical CFC and interconnected this subchart in a CFC.

This sub-function could be a control for a ventilation system that is available in different
variants, depending on the application.

You can always interchange these variants in the overall structure without having to change
the interconnections.

The CFC that is to replace a specific subchart is available in a library in the "Charts" folder
as a basic chart, or in a different CFC.

. Open the basic chart that contains the subchart you want to replace.

. Inthe project tree or in a library, navigate to the CFC that is to replace the subchart.

You can also open a different CFC that contains the desired CFC.

. Drag-and-drop the CFC from the project tree, from the library, or a different CFC into the

subchart that is to be replaced.

. Release the mouse button as soon as the mouse pointer is positioned exactly over the CFC to

be replaced.

Alternatively, copy the CFC and select the "Paste” command in the shortcut menu at the
icon of the subchart to be replaced.

A dialog opens and prompts you to confirm the replacement of the CFC.

. Confirm the replacement with "Yes".

The subchart is replaced by the inserted CFC.

The name of the replaced subchart remains the same.
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See also
Hierarchical CFC charts (Page 29)
Creating a subchart for a hierarchical CFC chart (Page 87)
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4.3.11 Moving subcharts to the root level

Requirement

* The CFC to be moved may not contain any external interconnections to the chart
interface.

Procedure
1. Select the subchart that is to be moved to the root level from the "Charts" folder of the
project tree.
2. Drag-and-drop the subchart to the root level of the "Charts" folder.
You can also copy and paste the subchart to the root level.
Result
You have successfully moved or copied the previous subchart to root level in the "Charts"
folder.
See also

Hierarchical CFC charts (Page 29)
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4.3.12 Adding, editing and sorting parameters of the chart interface

Chart interfaces

Procedure

92

Hierarchical CFC charts and standard CFC charts have an interface structure that is similar to
that of blocks.

This means that these CFC charts can be configured and interconnected externally similar to
blocks.

Interconnections with chart interface parameters are visualized using the chart sheet bar or
via connectors.

. Open the CFC chart whose interface you want to change.

The chart interface is displayed in the top area of the "Data flow" or "Control flow" section
in the "CFC" editor.

The properties of the attributes are displayed in the Inspector window.

When the "Interface" area is hidden, enlarge the area with the mouse or click the unhide
icon:

i B s

. If you want to add a new parameter, click the "<add>" line in the "Name" column in the

required Input, Output or InOut section.
The new parameter is added in the selected line.
The "Name" field is opened for editing.

To add a line, select the item "Insert line" or "Add line" from the shortcut menu of the line.

3. Enter the name of the new parameter.

. Select the desired data type in the "Data type" column.

All CFC data types are supported in the chart interface except:
— TIMER
— COUNTER

— Hardware data types

. If necessary, change the other attributes of this parameter, for example, "Value" or

"Configurable".

. If you wish to change a parameter, click the required field in the table line.

Depending on the type of field, it is opened for editing or a drop-down list is displayed.
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7. To change the sequence of parameters in the table, drag the name of the parameter or the
line to the new position.

You can only change the sorting within a section, for example, the parameters in the
section "Input”.

8. If you wish to delete a parameter, select the name of the required parameter.
Select the "Delete" command in the shortcut menu.

The line of this parameter is removed from the table.

Result
A parameter was added, edited or deleted in the chart interface.

The sorting of the parameters was changed, if necessary.

See also
Hierarchical CFC charts (Page 29)
Interconnections to parameters of the chart interface (Page 141)

Data types in CFC (Page|203)
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4.4

4.4.1

Overview

Adding and managing objects in the CFC chart

Representation of instructions and blocks

The following section contains information related to instructions/blocks in the CFC chart:
* Block icon: visualization, layout, editing options
* Block interface: layout, editing options

» Additional information at the block icon: For example, display of run sequence, processing
display, display of hidden parameters

* View in the CFC chart: Zoom function, signal flow

Note
Use of the terms "instruction” and "block"

The following description applies to both instructions and blocks.

For simplification, however, we only use the term "block”, for example, "block header".

Representation of the block icon

94

An instruction or a block is represented as a symbol in the CFC chart.
The following options are available for the representation:

* You cannot change the representation of the block icon in the case of instructions from
the "Instructions" task card.

e For blocks, several options are available for the representation of the block icon in the CFC
chart.

More information: "Representation options for the block icon in the CFC chart (Page/101)"
Additional icons are used for representation of the basic and subcharts.

More information: "Hierarchical CFC charts (Page 29)"
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Structure of the block icon

In principle, the block icon in the CFC chart consists of the so-called block header and the
block interface.

However, this is not true for the smallest representation option "Builtin;SmallBlock" of the

block icons.
Cyclicinterrupt_2 :_. g
@—7 myfb_2_2 ]
' MyFB_2 —®
Block used for testing |
input_BOOL output_1—}—
1 —input_INT output_2— 2
INOUT_1 |
A A

) Block header

(2) Block interface

3) Display for hidden parameters

(4) Processing display

(5) Run sequence: Position number, assigned task (optional display)
Change size

* You can change the width as required.

¢ The height of the icon depends on the number of input and output parameters.

To change the height of the icon, show or hide the input and output parameters.
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Block header (1)

96

The block header can display the following information:

Instance name (e.g. "myblock_1 1"
Type name (e.g. "MyBlock _1")
Instance comment

Processing display

The information shown in the block header depends on the instruction or block and the
target system you are using.

With some types of instructions and blocks, the block header may be missing altogether or
simply contain a small icon, for example, an instruction for an OR logic operation.

21

B

Editing options in the block header

In the work area, you have the following options for editing the block header:

Changing the instance name and instance comment

Selecting a block/instruction

Configuring CFC charts
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Block interface (2)
The block interface displays the input and output parameters:
e Left: Input parameters
¢ Right: Output parameters
Normally, the block parameters have the parameter values of the type by default.
The name of the input and output parameter is displayed in full length or truncated
depending on the width of the symbol.
Comments of the block type
You can show the comments instead of the names of the input and output parameters.

To toggle between names and comments, use the following button in the toolbar:

Parameter: Tooltips

When you hover your mouse over an input or output parameter, a tooltip with the following
information is displayed:

¢ Name of the parameter

¢ Data type of the parameter

¢ Comment of the parameter

When you expand the tooltip, the following information is displayed:
¢ Value of the parameter

e Parameter section

Editing options in the block interface

In the work area, you have the following options for editing the block interface:
e Set the parameters of the input and output parameters.

¢ Interconnect the input and output parameters using drag-and-drop.

¢ Select the input and output parameters.

¢ Selecting a block/instruction

Navigation with the keyboard

¢ To select individual parameters with the keyboard, click on the block and press the
<Down> arrow key:

* Use the <Right> and <Left> arrow keys to switch between the parameters: [,
« Use the <Up> arrow key to return to the block level:

¢ When the entire block is selected, use the <Right> and <Left> arrow keys to switch
between the blocks.
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Display for hidden parameters (3)
The icon indicates that the "Invisible" property of the parameter is activated.

If input or output parameters are set to "invisible" and are therefore hidden in the block icon,
this fact is indicated by an additional triangle symbol at the bottom of the icon.

Icon Meaning
% A non-interconnected parameter is hidden.
& An interconnected parameter is hidden.

More information: "Hiding input and output parameters (Page|148)"

Processing display (4)

The processing display at the top left corner of the block header indicates whether the block
is processed in the program sequence.

If the block header is missing, for example in the case of instructions, the processing display
is shown at the block interface.

The processing of a block depends on the following elements:
e Enable input "EN" at the block
¢ "Enable chart" option of the CFC chart in which the block is added

The display shows the following states:

Icon Meaning
No symbol Block is always processed.
- Block is processed conditionally.

The reason is that the enable input "EN" at the block or the "Enable chart" option
of the chart has been interconnected.

B Block is not processed.

The reason is that the enable input "EN" at the block is "FALSE" or the "Enable
chart" option of the chart has been disabled.
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Additional information at the block icon

Mouse pointer

The change in the mouse pointer over the instruction or block icon indicates the various
editing options available, for example, moving or selecting.

Tooltip

When you hover your mouse over the block icon, a tooltip with the following information is
displayed:

¢ Instance name
* Type name

e Task

e Comment

If the instance has no comment, the comment of the type is displayed.

Display of the run sequence (5)

Using the toolbar of the data flow, you can show the position of the instruction or block in
the run sequence.

Icon Meaning

The position number in the run sequence is displayed above the block header.

The name of the assigned task is displayed above the block header.

For subcharts, information that the task was inherited from the basic chart is
added where appropriate.

J

= =1
[ [

Data flow: Zoom function

You can set the zoom ratio and customize the size of the view in the CFC chart using the data
flow toolbar functions.

If you select multiple objects in the CFC chart and then run the "Zoom in" or "Zoom out"
function, the view is zoomed automatically to the center of the selected objects in the work
area.

The objects may also extend to other sheets.
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Highlighting for signal flow

See also

100

You can highlight the flow of signals in the CFC chart.

The signal is highlighted starting from the selected block or subchart, ending at the /O of the
signal in the sheet bar of the CFC chart. All relevant interconnections and blocks are marked
in color here.

The signal is highlighted only within the CFC chart, but not in other charts.
The signal flow is only displayed when a block or subchart is selected.

The function is enabled using the "Highlight signal flow" toolbar icon: i

Example

The following figure shows an example of the highlighted signal flow for an interconnection
of type "BOOL". The example in this figure shows a chart section with three instructions.

The arrow marks the click position for the "AND" instruction.

The highlighting is continued to the left and right of the click position up to the chart
boundaries because all three instructions are involved in the signal flow.

—ap—

Representation and properties of interconnections (Page|126)

Placing instructions and blocks in the CFC chart (Page|104)

Adding an instruction or block to the CFC chart (Page|/108)

Setting the parameters of the input and output parameters (Page|122)
Adapting the run sequence within the CFC chart (Page 166)

CFC naming conventions (Page 39)

Options for determining the run sequence (Page|163)
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44.2 Representation options for the block icon in the CFC chart

Overview

You specify the representation of the block icon in the CFC chart with an attribute at the
block type.

There are multiple options for displaying the block instances.

Note
Block instances

The configured representation option at the block type cannot be changed for specific
instances.

Changing the representation option at the type affects all instances.
Instructions

You cannot change the representation option for instructions from the "Instructions” task
card.

Basic procedure

You specify the size of the block icon in the CFC chart in the properties of the type with the
attribute "Block representation”:

1. Open the properties via the shortcut menu of the block type.
2. Inthe "General" tab, select the "Attributes” item.

3. Enter the required representation option in the "Block representation” field in the "User-
defined attributes" area.

Use the following syntax for this:

Large BuiltIn;Block

Medium BuiltIn;MediumBlock
Medium / narrow BuiltIn;NarrowMediumBlock
Small BuiltIn;SmallBlock

4. Save and compile the changed block.

If you wish to use the changed block as type in a library, copy the changed block into the
respective library.

5. Update the instances of this type in CFC.
Additional information: "Updating instances of a changed block type (Page|/119)"
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Representation options for the block icon

102

The table shows the various representation options.

The same block is displayed in the "Example" column in the corresponding representation

option.

Representation option/syntax

Example

“"Large" version

B22.1
Syntax: B35
e BuiltIn;Block all datatypes
. L. . L. —Input_1 Output_T—
The block icon is displayed in full size in the CFC —Input_2 Output_2—
chart with all details in the block header and —Input_3 Output_3—
block interface. —Input 4 Output 4—
—Ilnput 5 Output 5—
—Ilnput 6 Output_ 6—
—Ilnput 7 Output_ 7 —
—Ilnput_8 Output_ 5—
—Ilnput 9 Output 9—
—Input_10 Output_ 10—
—Input_11 Output 11—
—Input_12 Output_12—
—Input_13 Output_13—
—Input_14 Output_14—
—Input_13 Output_15—
"Medium" version
S . E22_1
yntax. —Ilnput... Outp...—
e BuiltIn;MediumBlock — lEELE T —
i L X X L —Input... Outp...—
The block icon is displayed in medium size in the —Input... Outp...—
CFC chart. —Input.. Outp...—
. . . . —Ilnput... Outp...—
The block header is reduced in size and displays _mEm__ UUIE___
only the block name. —Input.. Outp..—
The parameter names in the symbol are —:”Pu‘--- SU‘P---—
displayed in abbreviated form in the block :lzﬁi D::E“:
interface. —Inpit. Outp..—
The complete parameter name is displayed as a —Input... Outp..—
tooltip. —Input... Outp...—
—Ilnput... Outp...—

Configuring CFC charts
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Representation option/syntax Example
"Medium/narrow" version
Svntax: B22_1
yntax: —Ihp... Ou.—
. . . —Ihp... Ou.—
* BuiltIn;NarrowMediumBlock np.. Ou
This version corresponds to the "Medium" version —lInp.. Ou.—
in the representation of block header and —Inp... Du..—
interface. — DI —
. . . —Ihp... Ou..—
The width of the block icon is also reduced. —inp.. Ou.—
—Ihp... Ou..—
—Ihp... Ou..—
—Ihp... Ou..—
—Ihp... Ou..—
—Ihp... Ou..—
—Inp... Ou..—
—Ihp... Ou.—

"Small" version
Syntax: N N
* BuiltIn;SmallBlock — i
The block icon is displayed in the smallest size. W
The block header is hidden. = =

The parameter names in the block interface are —E
only displayed as tooltip. - =

See also

Representation of instructions and blocks (Page 94)

Configuring CFC charts
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4.4.3

Placing instructions and blocks in the CFC chart

Adding instructions and blocks

The positioning of instructions/blocks on the sheet of a CFC chart depends on whether you
are working in "data flow" or "control flow" tab.

* Data flow:
Position the inserted object by dragging it with the mouse.
e Control flow:

The inserted object is automatically placed at a free location in the CFC chart.

Automatic placing of instructions/blocks

Objects, such as instructions/blocks, are positioned automatically in "data flow" mode under
the following conditions:

* You add the object in the control flow.
* You add instructions to the CFC chart by double-clicking in the library.
* You enable automatic positioning in the shortcut menu of the object.

If the location of an automatically placed object is occupied by another object, then this
object is moved automatically to a free location.

The property "Position automatically" is set at the properties of an object.

The following figure shows two instructions; automatic positioning is enabled for the
instruction on the left.

The automatically positioned instruction has a colored border:
—_& ™ _&~
B E
You disable automatic positioning of an object as follows:
* You disable automatic positioning using the shortcut menu.

* You move the object.

Positioning objects in the CFC chart according to the data flow

104

Use the function "Place blocks according to the data flow" to place the objects in the CFC
chart, e.g. blocks and instructions, according to the data flow.

This option makes for clearer positioning of objects and data flow as well as easier signal
tracking.

The function is executed only manually in the open CFC chart and you cannot enable it
permanently.

Additional information: "Positioning objects according to the data flow (Page/112)"

Configuring CFC charts
System Manual, 11/2022, A5SE52420813-AA



Configuring and adapting CFC charts

4.4 Adding and managing objects in the CFC chart

Instructions/blocks that cannot be fully displayed

See also

Configuring CFC charts

Under the following conditions, objects such as instructions/blocks are displayed without
interconnections and in a different color:

e Automatic placing: There is not enough space for all objects on the sheet of a CFC chart.

¢ Manual placing: You position objects on top of each other, on an interconnection or on a
sheet border.

Interconnections to objects that cannot be fully displayed are shown as connectors.

If objects are located on top of each other, the lowest object is shown completely. All objects
above it are shown incompletely.

The following figure shows an instruction located on the sheet bar.

The interconnection between the two instructions is displayed as a connector in the sheet
bar:

and_18.0UT 14 &~

Representation and properties of interconnections (Page|126)
Adding an instruction or block to the CFC chart (Page 108)
Deleting an instruction or block from the CFC chart (Page|113)

Aligning objects in a CFC chart (Page|111)

System Manual, 11/2022, A5E52420813-AA 105



Configuring and adapting CFC charts

4.4 Adding and managing objects in the CFC chart

4.4.4

Copying instructions, blocks and charts

Blocks with interconnections to external tags

106

If you interconnect an input or output parameter with an external tag, a connector is created.
The connector has the name of the external tag.

If you copy an instruction or a block with an interconnection to an external tag, the connector
is also copied.

The name of the tag will remain the same in the copy of the connector.

Check the interconnection with the external tag in the copy and change the name, if
necessary.

A warninG

Check the user program before using it

Despite a valid criteria check, the algorithm can be different in the instructions or blocks.

To avoid possible errors in the plant, check the code of the user program in the instruction
or block if you are uncertain.

Configuring CFC charts
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Copying CFCs

See also

Configuring CFC charts

4.4 Adding and managing objects in the CFC chart

If you copy a chart, an instruction or a block across devices or projects, then the following

conditions will apply:

Condition

Resulting action

The block that is to be copied is
missing in the target system.

The block is copied completely, including all necessary called
blocks, to the "Program blocks" folder.

At the same time, the block is imported as type into the CFC of
the target system.

The block / type that is to be
copied differs only in the block
numbering in source and target
system.

The CFCis copied to the target system. The type remains the
same in the target system. The copied CFCs in the target system
is adapted.

A type, instruction or block with
the same name already exists in
the target system.

The two instructions/blocks are compared based on their input
and output parameters and the following criteria:

e Quantity
* Name

¢ Data type
e Section

e Order

The copy function will only be performed if all the criteria match.
Otherwise, the copy function is canceled.

The task of the CFC to be copied
does not exist in the target
system.

The CFCis not copied to the target system.
Special considerations for the S7 target system

The CFCis copied to the target system. The assignment of the
CFC to the task is retained. A non-existent task is created during
the next compilation of the software, if the target system
supports this task.

Copying objects (Page 38)

Interconnecting the input and output parameters with an external tag (Page|143)

Overview of textual interconnections (Page 153)

System Manual, 11/2022, A5E52420813-AA
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4.4.5

Requirement

Procedure

Adding an instruction or block to the CFC chart

For configuration of a CFC chart insert the instructions or blocks to the chart and configure
interconnections and parameters.

A CFC chart is open.

The "Instructions” or "Libraries" task card is open.

. Navigate to the storage location of the selected instruction or block.

Possible storage locations:

“Instructions” task card
— Library

"Program blocks" folder in the project tree
Drag-and-drop the instruction or block to the CFC chart.

Place the instruction or block at the desired location in the CFC chart.

Alternative procedure

Result

108

You can insert one or more existing blocks using copy and paste:

Keyboard shortcuts <Ctrl+C> and <Ctrl+V>
Blocks copied in are placed at an offset over the blocks that serve as the copy source.
Shortcut menu: "Copy" and "Paste" entries

The position of the mouse pointer when selecting the "Paste" entry determines where the
blocks are inserted.

The instruction or block is inserted into the CFC chart.

Note
Inserting a deleted instance again

Before you insert the deleted instance of a block type again, transfer the change to the
controller via a full download or 2x download of changes.

This prevents name conflicts during download.

Additional information: "Deleting an instruction or block from the CFC chart (Page 113)"

Configuring CFC charts
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See also
Interconnecting input and output parameters (Page|135)
Adapting the run sequence within the CFC chart (Page 166)
Representation and properties of interconnections (Page 126)
Deleting an instruction or block from the CFC chart (Page|/113)
Type and instance (Page|27)
Updating instances of a changed block type (Page/119)
"CFC" Editor (Page 43)

Configuring CFC charts
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4.4.6

Overview

Requirement

Procedure

See also
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Adding a text box to a CFC chart

To document the function of the CFC, add texts and images to the CFC:
* You can use texts, for example, to document the signal path.

e With an image, you can, for example, represent the part of the plant that is processed by
the CFC.

Use the text boxes to add texts and images to the CFC.

Text boxes can be located in the foreground or background of the CFC and can contain text
as well as a background image.

Text boxes in the background are ignored by blocks, instructions and interconnections.

e ACFCisopen.
* "Data flow" is displayed.

1. Click "Insert text box" in the toolbar.

2. Keep the mouse button pressed to move the text box to the required position in the CFC and
adjust it in size.

3. Select the "Text box in background" option under "General" in the Inspector window.

4. Todisplay a graphic, select the "Use background image" option under "General".
Select the graphic in the file selection dialog.

5. If necessary, enter the "text" for the text box.

6. If necessary, you can set additional properties of the text box in the Inspector window, such
as border, font or font size.

Aligning objects in a CFC chart (Page[111)

Configuring CFC charts
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44.7 Aligning objects in a CFC chart

You can align objects, such as instructions, blocks and text boxes, in the CFC or distribute
them evenly.

First, select the required objects.

Alignment

The reference object on which the other objects will orient themselves is decided
automatically within the selection.

The following criteria apply:

Align

The selected objects are aligned with each other.

The object used as the reference is the furthest object in the required alignment direction.
Example: If you want to right align the edges of three objects, the objects are aligned with
the object located furthest right.

Distributing

The selected objects are distributed evenly.

The reference value used is the average position value of all the objects included in the
selection.

Requirement
¢ ACFCisopen.
¢ "Data flow" is displayed.
¢ Multiple objects have been added.

Procedure
1. Select the objects in the chart.

2. Select the command you require under "Align" in the shortcut menu of the selection.

Result

The selected objects are aligned or distributed evenly depending on the command you select.

See also
Adding an instruction or block to the CFC chart (Page|/108)
Adding a text box to a CFC chart (Page|110)
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44.8 Positioning objects according to the data flow

Overview

When you configure a CFC, objects, such as instructions, blocks and text boxes, are added,
positioned and interconnected one after the other.

The representation of the chart can get confusing when you have a large number of objects
and interconnections.

Use the function "Place blocks according to the data flow" to place the objects in the CFC, e.g.
blocks and instructions, according to the data flow.

This option makes for clearer positioning of objects and data flow as well as easier signal

tracking.
Response
* The objects in the CFC are sorted automatically in columns one below the other and
aligned on a mutual axis in the columns.
The width of a column is determined by the widest object in the column.
* Independent subnets are listed one after the other and have columns independent of one
another.
* Each object is placed automatically in the chart this way so that it does not intersect the
sheet bar or other objects.
* For all objects that do not take part in the data flow, e.g. text boxes, the property "Position
automatically” is selected.
The function is executed only manually in the open CFC and you cannot enable it
permanently.
Requirement
e ACFCisopen.
* "Data flow" is displayed.
* Multiple objects have been added.
Procedure
1. In the toolbar select the symbol "Place blocks according to the data flow": "
The selected objects are aligned automatically.
2. Use the "Undo" button in the toolbar to undo this change.
Result

The objects in the CFC are sorted according to the data flow.

Configuring CFC charts
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44.9 Deleting an instruction or block from the CFC chart

You can delete instances of instructions and block types in a CFC chart.

Note
Checking interconnections

If you delete an instruction or a block with interconnections, the interconnections are also
deleted.

Before deleting an instruction or block, you should check whether the chart has
interconnections.

The values of the respective input and output parameters are reset to the values preset in the
block type.

Correct the reset parameters if necessary.

Deleting instances in the device

When you insert a new instance of the same block type in the CFC chart after deleting an
instance, this instance is given the same name as the deleted instance.

As long as the deleted instance is still in the controller, this leads to a conflict during
download.

To restore consistency, perform one of the following actions:
e Full download
e 2x consecutive downloads of changes

After the first download of changes, the instance in the device may still not have been
fully deleted.

Requirement
¢ The CFCchartis open.

¢ Aninstruction or block has been created.

Procedure
1. Select the instruction or block.
2. Select the "Delete" command in the shortcut menu.
3. Start either a full download or two consecutive downloads of changes.

This also deletes the instance in the device.

Configuring CFC charts
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Result

The instruction or block is deleted.

All incoming and outgoing interconnections are also deleted.

As default, the affected input and output parameters are assigned the values of the type.
See also

Adding an instruction or block to the CFC chart (Page/108)

Configuring CFC charts
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4.4.10 Central change of a block type

Overview

A block type is a reusable, pre-defined function.
You can create your own block type or use a block type from a library.
You create an instance by inserting a block type into a CFC chart.

The advantage of this type-instance concept is that any change of the block type can be
implemented at all instances.

Changing the block type

Configuring CFC charts

If the interface, the system attributes or the algorithm is changed at a block type, then an
update of the instances in the CFC charts becomes necessary.

To this end, the changed block is added to a CFC chart.

All instances of this block are also changed in all CFC charts of this target system so that they
match the new block.

Options for block change
You can change the following blocks:
¢ Self-created block type in the "Program blocks" folder in the project tree

¢ Provided block type in a library

A cruton

Interface change can result in full download

After interface changes at the block type and subsequent update of the block type in the
target system, you will often only be able to compile and load the entire software.

An interface change is, for example, the change of the parameter data type.

Loading of the entire software with the S7 target system requires a CPU stop.
Effects of the block change

Note the effects on the instances with every change.
Do not change internal CFC blocks

CFC creates system blocks that are displayed in a number of views or lists, for example,
under "Program information".

You may not change these objects.

Only edit your own blocks and instructions using the STEP 7 editors.
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Note
"Instructions" task card

You cannot change block types in the "Instructions" task card because they are an integral
part of CFC.

Updating the instances

To update the instances after a block type change, you will have to import the new version of
the block type into the CFC.

You have the following options to do this:
¢ Blocks from a library:
Adding the changed block type to a CFC chart
¢ Blocks from the "Program blocks" folder:
— Adding the changed block from the "Program blocks" folder

— Use the "Chart sequence & extras" editor in the "Block types” tab (depending on the
target system)

Before the changed block type is imported, the block versions are compared.
The differences are displayed in the "Update blocks" dialog.

An icon in the last column indicates whether or not the change requires a download of the
software.

Additional information: "Updating instances of a changed block type (Page/119)"

Effects on the instances

116

Note
Checking the effects

When you update an instance after a central block type change, all other block instances in
the CFC charts of the CPU are changed automatically.

This also applies to instances in password protected CFC charts.

Therefore, check the effects in the instances before you perform the update.

Block name
Changing the block name does not affect existing instances.
Only the name of the block type is changed in the "Type data" area of the instance properties.

The instance name in the "Instance data" area is not changed.

Configuring CFC charts
System Manual, 11/2022, A5SE52420813-AA



Configuring and adapting CFC charts

Comments

4.4 Adding and managing objects in the CFC chart

Comments are usually overwritten at the instances.

However, comments that were changed for specific instances are not overwritten.

Parameter

Examples of typical changes to block type parameters:

Change to the block type

Effect

Parameter is added

This change takes effect in the instances.
The system attributes are set to default values.

Check and update the parameter assignment or interconnection of the
new parameter at the instances.

The interconnections are hidden when the block instance becomes too
large for display in the CFC chart due to an increase in the size of the
block type.

If necessary, move the instance so that it is displayed completely in the
chart.

Parameter was deleted

The parameter is deleted in the instances.
If the parameter is interconnected, the interconnection is also deleted.

After the deletion, check the parameter assignment at the
interconnection partner.

Changed data type of a
parameter

The behavior corresponds to deleting and creating a new parameter.

Changed parameter name

The system cannot automatically make a connection to the old name.
This happens when you delete a parameter and create a new one.

Changed sequence of
parameters

The sequence of parameters is taken into account.

The interconnection, the parameter assignment, and the attributes are
retained.

However, moving two subsequent parameters with the same data type
only corresponds to renaming the two parameters. It does not include
the interconnection of the parameters.

Configuring CFC charts
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See also
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Values, comments and system attributes of the parameters

Effect of attribute changes:

¢ Changes that cannot be made for a specific instance are made automatically at the

instances.

¢ Instance-specific values, comments, and system attributes are usually overwritten.

However, values, comments or system attributes that were changed for specific instances

are not overwritten.

The table shows examples of deviations from this rule:

Change to the block type Effect
The "Configurable" attribute | The "Configurable" attribute cannot be changed for specific instances.
is deleted. The change has an effect on all instances:
e Existing parameter assignments of the input or output parameter
are maintained.
The "Interconnectable” The "Interconnectable" attribute cannot be changed for specific
attribute is deleted. instances.
The change has an effect on all instances:
e Existing interconnections are deleted.
The "Low limit" and "High "Low limit" and "High limit" cannot be changed for specific instances.
limit" attributes are The change has an effect on all instances:
configured. o o )
e When an existing parameter value exceeds a limit value in the
instance, the parameter value is set to the default value of the
block.

Type and instance (Page|27)
Creating a block type for CFC (Page 121)

Configuring CFC charts
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4.4.11 Updating instances of a changed block type

Overview

Requirement

Configuring CFC charts

Blocks added in the CFC chart represent an instance of a block type.

The block type exists, for example, in a library or in the "Program blocks" folder of the project
tree.

After changing a block type, you can update the instances of this block in all CFC charts of a
target system.

Additional information: "Type and instance (Page 27)"

A cruton

Interface change can result in full download

After interface changes at the block type and subsequent update of the block type in the
target system, you will often only be able to compile and load the entire software.

An interface change is, for example, the change of a default value.

Loading of the entire software with the S7 target system requires a CPU stop.
Effects of the block change

Note the effects of the change on the updated instances.

Additional information: "Central change of a block type (Page|115)"

¢ A CFCchartis open.

¢ The changed block type exists in a library, for example.
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Procedure

1. Select the changed block type in a library or in the project tree in the "Program blocks"
folder.

2. Drag the symbol in the CFC chart.

If at least one instance of the block is used in a CFC chart of the CPU, the "Update blocks"
dialog is displayed.

— The changes and their effects are listed.

— Anicon in the last column indicates whether or not the change requires a download of
the software:

i@ No download necessary *)
i@ Download of the software required
= Download with CPU Stop required

*) Regardless of CFC, changed blocks may be downloaded by STEP 7 into the
controller.

3. To update the instances, click "OK".

The block instances are updated in all CFC charts of the same target system to the
changed version.

If necessary, change the interconnections at the instances.

S7 target systems: Alternative procedure

You can also update block types in the "Program blocks" folder in the "Block types" tab of the
"Chart sequence & extras" editor.

The functionality in this tab is specific to the target system.

Additional information: "Working with CFC charts for S7 > Updating block type imported in
CFC"

Result

The instances of a changed block type are updated in all CFC charts of the target system.

Configuring CFC charts
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4412 Creating a block type for CFC

Requirement

Procedure

Result

See also

Configuring CFC charts

Complex functions can be combined and reused in a block in the type-instance concept.

You can define a block you have created yourself as a type and save it in the project library or
a global library.

The "Libraries" task card is displayed.

You have created a block in the project tree.

. Select the pane with the library in the "Libraries" task card in which you want to define a

block type:
— The "Global libraries" pane for the required global library

— The "Project library" pane

. Click the "Master copies" folder in the selected library.

Any existing subfolders are displayed.

You can create a new subfolder, if necessary, in the shortcut menu with the "Add folder"
command.

. Copy the required block with drag-and-drop to the intended position in the "Master copies"

folder.

The shape of the mouse indicates where you can add the block.

A new block type has been defined in the project library or in a global library.

You can create instances of this block type and use them in CFCs.

Type and instance (Page 27)
Central change of a block type (Page 115)
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4.5 Configuration and interconnection of input and output
parameters

4.5.1 Setting the parameters of the input and output parameters

Overview

If you add an instruction from the "Instructions" task card or a block from a library to a CFC,
then the parameters are assigned with the values of this object type by default.

Values that were changed at the type are passed to the instance in the CFC the next time a
type import is performed.

If you assign parameter values to the input or output parameters, passing on the parameter
value from the type to the instance is interrupted.

You can re-enable the passing on of these values at any time in the Inspector window. The
assigned parameter value is then once again replaced by the default value of the type.

When you assign a parameter value, the entered value is checked for plausibility and syntax
depending on the data type.

Requirement

e ACFCisopen.

* "Data flow" is displayed.

¢ Aninstruction or block has been added.
Procedure

1. Select the required input or output parameter in the CFC.
2. Enter a value for the input or output parameter in the "Value" field of the Inspector window.
This stops the value from being passed on by the type of this instruction or block.

If the values for "Low limit" and "High limit" are configured at the type, these limits are
taken into consideration when you make an entry in the "Value" field.

3. If necessary, enter a measurement unit in the "Unit" field or select a unit from the list.
If a unit is assigned at the type, this unit is passed on to the instance.

You can disable this process by making an entry or selecting from the list.

Alternative procedure
As an alternative, you can set the input or output parameters directly in the CFC.

If you need to set many parameters for the input or output parameters, use the "control flow"
mode.

Configuring CFC charts
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Result
The input or output parameter has been assigned.

When you download the CFC to the device, the input or output parameter has the assigned
value as default.

Configuring CFC charts
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4.5.2 Pre-assignment of attributes for input and output parameters

Attributes at the block type

You can configure the attributes of an input or output parameter at each instance of a block.

It is also possible to pre-assign the attributes of an input or output parameter at the block
type.

These pre-assigned values are passed on at an instance of this type.

You can either accept this pre-assignment or, if necessary, change it for specific instances.

These attributes include, for example:

Basic procedure

124

Can be changed for specific instances:

— Comments

— Attributes, e.g., "Value", "Unit", "Invisible", "For test"

Cannot be changed:

— e.g. the attributes "Configurable”, "Interconnectable" "Low limit", High limit"

. Open the block used as type, for example, in the "Program blocks" folder of the project

navigation.
Select the required input or output parameter in the interface.
The "General" tab is displayed in the Inspector window.

Under "Attributes”, make the required settings to be passed on as pre-assignment to the
associated instances.

Save and compile the changed block.

If you wish to use the changed block as type in a library, copy the changed block into the
respective library.

. Update the instances of this type in the CFC.

Additional information: "Updating instances of a changed block type (Page[119)"
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Display and update at the instance

If the input or output parameter is selected, the pre-assigned values are displayed in the
"Type data" column under "General" in the Inspector window.

The pre-assignments for values and functions configured in the type are passed on to the
instance.

You can make your own configurations in the instance, e.g., enter start values, select units.
This stops the respective value from being passed on by the block type.

The following symbols display the status:

Icon Meaning

The value is passed on from the type to the instance.

ot The value is not passed on from the type to the instance because it was changed at
the instance.

You can re-enable the passing on by clicking on this symbol.

Updating instance

Instance-specific changes are not automatically overwritten when the type is updated.

Notes: "Low limit" and "High limit"

The low limit and high limit values are displayed after the data type as additional information
at the parameter of the block instance in the "Type data" column of the "Type" field.

"Low limit" and "High limit" cannot be changed for specific instances.
These two values have an effect on all instances when the type is updated:

If an existing parameter value exceeds a limit value, the parameter value is set to the default
value of the type and a log entry is made.

Example

e Data type = INT

e Lowlimit=10

¢ High limit=90
Display in the "Type" field:
e Int (10..90)

Configuring CFC charts
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45.3 Representation and properties of interconnections

Routing of an interconnection

Interconnection

126

When configuring interconnections, you only specify which output parameter is
interconnected with which input parameter.

The routing of the interconnection is handled by the editor. Other objects in the CFC chart are
automatically avoided.

If you move interconnected instructions or blocks in the CFC chart, the routing of the
interconnections is adapted automatically.

The following figure shows the routing of an interconnection around a third object:
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If you have marked text boxes as being in the "background”, these are ignored by the routing.

options

The following options are possible for interconnections:

* From one output parameter to one or several input parameters

* From one input or output parameter to one external tag

e Several options are available for input and output parameters of STRUCT data type.

More information: "Interconnections with structures as input and output parameters
(Page 132)"

Note

Interconnections to constants are not possible.

Interconnections from one output parameter to several input parameters
You can use the value of an output parameter as the value for several input parameters.
You need a multiple interconnection for this purpose.

An interconnection node is inserted for each branch to an input parameter. An
interconnection node corresponds to an interconnection at the output parameter.

If you drag an interconnection node to an output parameter, all interconnections leaving the
interconnection node is interconnected to this output parameter.

Configuring CFC charts
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The following figure shows an interconnection from one output parameter to two input
parameters with one interconnection node:
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Interconnection that cannot be fully displayed

Every object and every interconnection requires space in the CFC chart. If interconnections
cannot be displayed fully, the editor automatically uses connectors.

The following figure shows an interconnection between two AND logic operations that
cannot be displayed completely:
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The interconnection is represented by connectors with the same numbers.
If there are multiple connectors, the numbers are incremented continuously.

To jump between connectors in the view, double-click the respective connector.

Interconnection beyond sheet borders

If you interconnect instructions or blocks beyond sheet borders, the interconnection leads as
far as the sheet bar of the sheet.

A connector is inserted in the sheet bar. The connector has the name of the target object and
the parameter.

If the destination of an interconnection is located in a different CFC chart, the name of the
CFC chart is also displayed. When the CFC chart contains multiple chart partitions, the chart
partition name and the sheet number are also displayed.
Color display
The color of the connector shows the type of interconnection.
¢ Connector color "Light beige":
The selected target connector is displayed in the sheet bar.
¢ Connector color "Dark beige":

The selected target connector is displayed in the extended sheet bar.

Configuring CFC charts
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Connectors 1 to 8 are shown in the following figure at the different output parameters.

¢ Connectors "1" to "5" as well as "7" are "light beige".

This means the selected target connector is displayed in the sheet bar.

¢ Connectors "6" and "8" are "dark beige".

This means the selected target connector is displayed in the extended sheet bar.
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When you double-click on a connector or sheet bar entry, the destination of the
interconnection is displayed centered in the work area.

To jump back, select the "Back" command in the shortcut menu of the chart.

To continue configuration, use "Back” to switch between the last two positions.

Configuring CFC charts
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Display in the sheet bar view

The following figure shows an interconnection between two instructions on different sheets
of a CFC chart with the sheet bars enabled.
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If the sheet bar view is disabled, the following rules apply to interconnections between sheets
or between charts:

* Between sheets:
The interconnection is displayed normally on one sheet.
* Between charts:

The connector is placed next to the parameter.

Placing a connector manually

In a chart with disabled sheet bar view, you can manually move connectors between sheets
and between charts:

¢ Automatic placing of the moved connector is disabled.
The connector remains in this position, regardless of the associated instruction position.

¢ To reenable automatic positioning, select the "Position automatically” option from the
shortcut menu of the connector.

Signal tracing for interconnections
If you click on an interconnection or a connector, the interconnection is highlighted in color.

If output parameters have several interconnections, which interconnection is highlighted
depends on where you click. Depending on the position of the click, either all
interconnections or only some of them are highlighted.

You have the following options to track a signal for an interconnection across sheets:

¢ Asingle click on the connector at the parameter of the block or instruction displays the
associated connector in the sheet bar or the extended sheet bar.

* If you double-click on a connector in the sheet bar, then the destination of the
interconnection is displayed in the work area.

Depending on the position of the interconnection target, the respective sheet of the same
CFC chart or chart partition is displayed or the respective CFC chart opened.

To jump back or to switch between positions, select the "Back" command in the shortcut
menu of the chart.

For navigation between the chart partitions, also use the drop-down list or the keyboard
shortcuts <Shift+PgUp> and <Shift+PgDn>.

Configuring CFC charts
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Example

The following figure shows an output parameter with multiple interconnections of a sheet-
internal interconnection.

The arrow shows the click position and the resultant color highlighting.
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Color of connection lines depends on the data type

The interconnection lines in the "Data flow" view of the CFC chart are displayed in different
colors depending on the data type.

The assignment of the data type and color can be changed.
The data type of the data source determines the shown color.

For interconnections to operands whose data type is not defined, the default value "black” is
used.

More information: "Changing the color of interconnection lines (Page|134)"

Configuring CFC charts
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See also

Configuring CFC charts

4.5 Configuration and interconnection of input and output parameters

CFC views (Page 64)

Placing instructions and blocks in the CFC chart (Page|104)

Interconnecting input and output parameters (Page|135)

Working with multiple interconnections (Page|139)

Changing an interconnection (Page|150)

Changing the color of interconnection lines (Page 134)

Deleting an interconnection (Page|[152)

Adding or removing input parameters (Page 145)

Hiding input and output parameters (Page|148)

Interconnecting the input and output parameters with an external tag (Page 143)
Interconnections with structures as input and output parameters (Page|132)
Negating input parameters (Page 147)

TERMINAL: Summary of interconnections (Page 283)
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454 Interconnections with structures as input and output parameters

Interconnecting structures and structure elements

In CFC, it is possible to interconnect the input or output parameters of the STRUCT data type
as a complete structure.

However, you can also interconnect individual structure elements of a parameter of the
STRUCT data type.

Structure elements can be of an elementary data type or "STRUCT in STRUCT".

Note
Configuration depending on the target system

Interconnection of structures and their elements depends on the target system.
Target system S7: Interconnection with the chart interface

The individual structure elements cannot be interconnected for a parameter of the STRUCT
type in the chart interface.

Only the complete structure can be interconnected.

Requirement for interconnection

To interconnect the structure and its elements at the block icon, the "invisible" option must
be disabled for the parameter containing the structure or structure element. The
corresponding parameter is visible at the block icon.

If you only need to interconnect individual structure elements, the parameter containing the
corresponding structure element must be visible, but not necessarily the parameter
containing the structure itself.

The "invisible" option is enabled by default and must be disabled at specific instances for each
parameter that contains a structure or structure element.

Configuring CFC charts
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Appearance

Interconnection

See also

Configuring CFC charts

4.5 Configuration and interconnection of input and output parameters

Block icon in the CFC

Parameters of the STRUCT data type and their elements are displayed at the block icon similar
to other block parameters. Requirement is that the "invisible" option is disabled in the
parameter properties.

The visible parameters of structure elements are displayed with indent, even if the "invisible"
option is set for the parameter containing the structure itself.
Control flow

Structure elements are displayed in the control flow with right indent.

Invisible structures and structure elements at the block

In CFC, the triangular icons below the block icon are normally used to indicate whether this
block contains hidden parameters, or hidden interconnected parameters.

For parameters of the STRUCT data type, the triangular icons are only used to indicate the
hidden, interconnected structures and structure elements, as structures and structure
elements are normally hidden in CFC.

options
¢ Input parameter "Input” or "InOut" with the STRUCT data type:

The parameter can either be interconnected as a complete structure or the individual
structure elements of this input parameter can be interconnected individually.

¢ Qutput parameter "Output" with the STRUCT data type:
The complete structure, as well as individual structure elements, can be interconnected.

¢ Individual structure elements of input or output parameters of the STRUCT data type can
be interconnected to a different, compatible input or output parameter.

Interconnecting the input and output parameters with an external tag (Page|143)
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45.5 Changing the color of interconnection lines

Line color and data type

The interconnection lines in the "Data flow" view of the CFC are displayed in different colors
depending on the data type.

The assignment of the data type and color can be changed.
The data type of the data source determines the shown color.
For interconnections of operands whose data type is not defined, the default value is "black”.

Changing the color assignment has an effect on the display of interconnection lines in an

open CFC.
Procedure
1. Select the "Settings" command in the "Options" menu.
2. Select the "Charts > CFC > General" group in the area navigation.
3. Select the desired colors for the data types in the "Color of interconnection lines" area.
You can also use the "Default values" button to reset all settings to the default values.
Result

The color setting for the interconnection lines has been changed.

Configuring CFC charts
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4.5.6 Interconnecting input and output parameters

Overview

You always interconnect an output parameter with an input parameter.

When you click on an instruction or block while creating an interconnection, the possible
destination points are shown in color.

The following rules apply to interconnecting input and output parameters:

You can only interconnect an input parameter once.
You can interconnect an output parameter more than once.

An interconnection is only possible if the data types of the input and output parameters
are compatible.

Possible procedures

You can create interconnections using the following methods:

Requirement

Configuring CFC charts

Double-click / Click
Drag-and-drop
Click Clack

<C> key and click
Copy&Paste

Manual input of the interconnection target (Textual interconnection)

All CFC charts are open whose parameters you want to interconnect.
"Data flow" is displayed.

Instructions/blocks have been inserted.
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Procedure

. Double-click on the required output parameter.

An interconnection line is shown between the output parameter and the mouse pointer.

. If the interconnection destination is in the same chart, click on the input parameter at the

target object that you want to interconnect.

Interconnectable parameters are displayed with a green background when the mouse is
moved over the input parameters.

The selected parameter is displayed with a light green background.
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The interconnection is inserted and the interconnection line displayed.

. If the interconnection destination is located in another CFC chart, move the mouse pointer

onto the respective CFC chart in the taskbar after step 1.

The CFC chart is displayed in the work area.

. In this CFC chart, click on the input parameter at the target object that you want to

interconnect.
The interconnection is inserted and the interconnection line displayed.

Depending on the space available in the CFC chart, the interconnection is displayed either
fully or by connectors.

. To cancel the interconnection, click on a free location in the CFC chart or press <Esc>.

Alternative procedure: Drag-and-drop

1. Select the input or output parameter and keep the mouse button pressed.

2. Drag the interconnection line to the desired parameter and release the mouse button.

Drag-and-drop between charts

1. Open the CFC chart and the target chart in the data flow.

2. To display both charts, click one of the buttons for splitting the editor area: — ||
3. Drag the cross-chart interconnection with the mouse button.

As an alternative, drag the parameter to the target chart using the taskbar of the open charts.

Alternative procedure: Click Clack
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1. Select the interconnection line at the input or output parameter.

The selected parameter turns magenta.

2. Select a parameter that is shown in green when you place the mouse cursor over it.

Configuring CFC charts
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Alternative procedure: <C> and click
1. Select the input or output parameter and press the <C> key.
The selected parameter turns magenta.
2. Click on a parameter that is displayed in green.

3. To create multiple interconnections, click on additional parameters displayed in green while
pressing the <Ctrl> key.

The interconnections for the clicked parameters are created.

Alternative procedure: Copy&Paste

Keyboard
1. Select the output parameter and press <Ctrl+C>.
2. Select the output parameter and press <Ctrl+V>.

Use the arrow keys to switch between the parameters of a block or between blocks.

Mouse operation
1. Select the "Copy" entry in the shortcut menu of the output parameter.

2. Select the "Paste" entry in the shortcut menu of the input parameter.

Alternative procedure: Manual input

Enter parameter manually
Interconnection possibilities:
¢ Direct entry of the parameter in the input field
You are supported by the auto-complete function in this process.
¢ Opening a selection dialog with the triangle symbol to the right of the input field
Syntax for manual input:
* Interconnection destination is in the other CFC chart:
"\<«Chart name>\<Object name>.<Parameter name>"
Example: \Chart_1\AND_1.0UT2
* Interconnection destination is in the same CFC chart:
"<Object name>.<Parameter name>"

Example: AND_1.0UT2

Configuring CFC charts
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Result

See also
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Enter operand manually
Interconnection possibilities:
¢ Direct entry of the operand in the input field
You are supported by the auto-complete function in this process.
Syntax for manual input:
e Interconnection destination is an external tag.
- "<Tag name>"
Example: "StartMotor"
* Interconnection target is a data block:
"<DB name>.<Parameter name>"

Example: "MotorDB.Start"

Procedure

1. Select the parameter to be interconnected at the block in "Data flow" or the corresponding
cell in "Control flow".

2. To create an interconnection to an address:
— Select "Interconnection to operand..." from the shortcut menu.
— Enter the interconnection destination manually or use the selection dialog box.

3. To create an interconnection to a parameter select the command "Textual interconnection
to chart..." from the shortcut menu.

— Enter the interconnection destination manually or use the selection dialog box.

Additional information: "Creating, editing and closing textual interconnections (Page| 156)"

The parameters of the two instructions/blocks are interconnected with each other.

Depending on the space available in the CFC chart, the interconnection is displayed either
fully or by connectors.

Representation and properties of interconnections (Page|126)
Working with multiple interconnections (Page|139)

Deleting an interconnection (Page|152)
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4.5.7 Working with multiple interconnections

Overview
You can interconnect an output parameter with several input parameters.

Place instructions or blocks with multiple interconnections in the CFC chart so that few
interconnection nodes are necessary.

The following figure shows the same interconnection, the only difference being the
positioning of the objects:
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Creating multiple interconnections

You create multiple interconnections by connecting the output parameter to the input
parameters of the target objects.

Depending on the positions of the target objects, this step results in one or more
interconnection nodes.

You have the following options to interconnect an output parameter with several input
parameters:

Procedure: <C> key and click

1. Click on the output parameter.

2. Press the <C> key.

3. Press and hold down the <Ctrl> key and click on the input parameters one after the other.

Alternative procedure: Copy&Paste

1. Click on the output parameter.

2. Press the shortcut <Ctrl+C>.

3. Click on the input parameters, one after the other, and press <Ctrl+V>.

Instead of the keyboard shortcuts, you can also use the "Copy" and "Paste” entries in the
shortcut menu of the parameters.

Configuring CFC charts
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Alternative procedure: Drag&drop, double-click, Click Clack
With this procedure you need to return to the output parameter for each interconnection.
1. Create an interconnection from the output parameter to the input parameter.

2. Select the output parameter again and create the next interconnections, one after the other.

Editing multiple interconnections
If you point to an interconnection with the mouse, editing areas are marked.

The following figure shows the editing areas with two multiple interconnections:

@ Interconnection at the input parameter.
Drag-and-drop: Interconnection with another input parameter.

Signal tracking: If you click on an editing area at the input parameter, the interconnection is
highlighted in color.

(@ Represents the interconnection at the output parameter of the source block.

Drag-and-drop: Interconnection with another output parameter. The interconnection then no
longer belongs to the multiple interconnection.

(® Represents some of the interconnections at the output parameter of the source block.
If several interconnection nodes result, these are arranged hierarchically.
Drag-and-drop: Interconnecting the input parameters with another output parameter.

® Represents all interconnections at the output parameter of the source block.
Drag-and-drop: Interconnecting all input parameters with another output parameter.

See also
Representation and properties of interconnections (Page|126)

Interconnecting input and output parameters (Page|135)
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4.5.8 Interconnections to parameters of the chart interface

Overview

Interconnection

Configuring CFC charts

Hierarchical CFCs and standard CFCs have an interface.

This means that these CFCs can be configured and interconnected externally similar to
blocks.

Interconnections of interface parameters with blocks within the CFC are displayed in the
sheet bar of the chart with connectors.
Parameters and data types

New parameters can be added, modified or deleted in the Input, Output, InOut sections of
the chart interface.

All CFC data types are supported in the chart interface except:
* TIMER
e COUNTER

More information: "Adding, editing and sorting parameters of the chart interface (Page 92)"

Note
S7 target system: Interconnection of structure elements

The S7 target system does not support interconnections of individual structure elements of
parameters of the STRUCT data type in the chart interface.

You can only interconnect the complete structure.
S7 target system: No hardware data types

Chart interfaces do not support any hardware data types.

between interface and block parameters

You create a new interconnection between the input or output parameters of a block and an
existing parameter in the chart interface.

Drag the required block parameter with the mouse to the desired location in the chart
interface, for example, to the "Output” section for an output parameter of a block.

When you release the mouse button, the new interconnection is created and displayed in the
sheet bar of the chart with connectors when the data type matches.
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Interconnection with the creation of a new interface parameter

You can also create a new interconnection when the interface parameter does not exist yet.

Drag the required block parameter to an empty line of the matching section of the chart
interface, for example, to the "Input” section for an input parameter of a block.

When you release the mouse button, the new interface parameter with the matching data
type is created. The attributes of the associated block parameter are applied.

Rewire interconnection: Blocks

In a rewire you change an existing interconnection between the input and output parameters
of blocks in the chart interface.

Drag the required interconnection at the block parameter to an existing parameter in the
chart interface using drag-and-drop.

The mouse pointer indicates if this interconnection is possible.

When you release the mouse button, the selected interconnection is rewired to the required
parameter in the chart interface.

Rewire interconnection: Interface and block parameters

See also
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You can also rewire an interconnection between a block parameter and an interface
parameter to an existing interface parameter.

Drag the connector of this interconnection in the chart sheet bar, for example, "Input2" to an
existing parameter of the chart interface, for example, "Input7"”.

The mouse pointer indicates if this interconnection is possible.

When you release the mouse button, the selected interconnection is rewired to the required
parameter in the chart interface. The associated connector in the sheet bar is renamed, for
example, to "Input7".

As long as an interface parameter has not been interconnected, the table cell of the "Data
type" column has a "light gray" background color.

Upon interconnection, the background color changes to "medium gray".

Hierarchical CFC charts (Page 29)

Interconnecting input and output parameters (Page|135)
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4.5.9 Interconnecting the input and output parameters with an external tag

Overview

If you need values from the device in the CFC, or want to return values to the PLC,
interconnect an input and output parameter with an external tag.

Depending on the target system you are using, an external tag represents signals from
modules or the device.

An external tag can also be a structure.

Note
Interconnection only possible in the target system

You can only use external tags that belong to the same controller as the CFC.
Synchronization while compiling the chart

Only the name of the external tag is stored in the connector.

Whether or not a tag with this name exists in the target system is only checked when the
chart is compiled.

Interconnecting structures
You can interconnect structures with input and output parameters of the STRUCT data type.

You can interconnect the complete structure, as well as individual structure elements with
the compatible block parameters.

Additional information: "Interconnections with structures as input and output parameters
(Page 132)"

Requirement
¢ ACFCisopen.
¢ The detail window is displayed.
¢ "Data flow" is displayed.
¢ Instructions/blocks have been inserted.

e The data types of the external tag and the input or output parameters are compatible.

Procedure
1. Select the folder in the project tree in which the external tags are stored.
The position of the folder depends on the target system you are using.

2. Drag the external tag from the detail window to the input or output parameter.
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Alternative procedure

As an alternative, you can also interconnect the external tag using the shortcut menu of the
input or output parameter.

If you have created a tag for a signal, you can drag a signal of a module to an input or output
parameter directly from the device configuration.

Result
The input or output parameter is interconnected to the external tag.
The connector with the tag name is positioned either in the sheet bar or besides the
parameter depending on the sheet bar view you have set.

See also

Setting the parameters of the input and output parameters (Page 122)
Copying instructions, blocks and charts (Page|106)

Interconnecting input and output parameters (Page|135)
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4.5.10

Overview

4.5 Configuration and interconnection of input and output parameters

Adding or removing input parameters

When you insert an instruction to a CFC chart, this object already comes with a certain
number of input parameters by default.

You have the option to change the number of input parameters with generic instructions.

There are generic instructions in CFC in the "Instructions” task card in the following
instruction families:

¢ BIT_LGC: Bit logic operations

¢ MATH_FP, MATH_INT: MathFloat (arithmetic instructions)

¢ MULTIPLX: Multiplexer

¢ WRD_LGC: Word logic operations

¢ Additional instructions: TERMINAL (compilation of interconnections)

When an instruction can be extended, the following symbol is displayed at the bottom of the
instruction icon: g

The symbol is hidden once the maximum number of possible input parameters has been
reached.

Changing the number of parameters

Configuring CFC charts

You can change the number of input parameters using the following options:
¢ Adding or removing input parameters:

You can make both changes in the properties of the Inspector window.
* Adding input parameters:

To add an input parameter to the instruction, click on the icon at the instruction symbol: g

Note
Reducing the number

The value cannot be lower than the number of interconnected input parameters, because
only non-interconnected input parameters can be deleted.

If several parameters are not interconnected, the highest index number of the interconnected
parameters determines the value. If the 1st and the 5th of 10 parameters are interconnected,
the lowest value corresponds to the index of the 5th parameter.
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Requirement

Procedure

Result

146

Example

21

B

The figure shows an "OR" instruction with two input parameters that are not interconnected.

The following icons are displayed at the bottom of the instruction symbol:

Icon Meaning

The number of input parameters can be increased.

il At least one input or output parameter is invisible.

A CFC chart is open.

An expandable instruction has been added.

. Select the required instruction in the CFC chart.

. In the Inspector window, select the "Properties” tab and then the "General" tab.

The current number of inputs are displayed in the "Number of input parameters" field.

. If you want to add an input parameter, simply increase the value in the "Number of input

parameters"” field.

You can also add an input parameter by clicking the icon in the CFC chart below the
instruction symbol.

. If you want to delete an input parameter, simply decrease the value in the field "Number of

input parameters".

One or several input parameters have been added or removed.

You can see an overview and the status of all input and output parameters in the Inspector
window in the "Properties” tab under "Parameters".
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4.5.11 Negating input parameters

Requirement
¢ The input parameter is interconnected.

¢ The input parameter has the BOOL data type.

Procedure
1. Select the interconnection of the input parameter.
2. Select the "Negate" option in the shortcut menu of the interconnection.

Alternatively, select the option in the properties of the interconnection in the inspector
window.

Result
The negation symbol is shown at the input parameter.
The value at the input parameter is negated.
If you move or copy the negated interconnection, the negation is retained.
The following figure shows a negated interconnection:
2T Z&T

See also
Representation and properties of interconnections (Page|126)

Setting the parameters of the input and output parameters (Page|122)
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4.5.12 Hiding input and output parameters

The space available for objects, such as instructions, blocks and interconnections, in a CFC
chart is limited by the sheet size.

To gain more space for displaying objects on a sheet, you can hide the input or output
parameters. This makes the CFC chart clearer to read.

Manage hidden parameters

To display the overview and the status of all parameters, select the instance in the chart and
click on "Properties > Interface" in the Inspector window.

If the hidden parameter is interconnected, it is also listed under "Invisible interconnections".

To

edit the interconnection of a hidden parameter, make the interconnection listed in

"Invisible interconnections” visible again. As a result, the interconnected parameter is visible
again.

Display at the icon

Hidden parameters of an instruction or block are identified at the associated icon separated

by

input and output parameters:

A&

One or more interconnected parameters are hidden.

i)

One or more non-interconnected parameters are hidden.

Display at the partner block

The interconnection to a hidden parameter is displayed at the partner block depending on the

settings:
Sheet bar mode Display
Static sheet bar In the sheet bar
Dynamic sheet bar In the sheet bar
No sheet bar As connector

Requirement

Procedure

148

A CFC chart is open.

An instruction or block has been added.

. Select the input or output parameter.

. Select the "Invisible" option under "General" in the Inspector window.

Configuring CFC charts
System Manual, 11/2022, A5SE52420813-AA



Configuring and adapting CFC charts

4.5 Configuration and interconnection of input and output parameters

Result

The input or output parameter has been hidden.

See also

Representation and properties of interconnections (Page|126)

Configuring CFC charts
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45.13 Changing an interconnection
You can change the existing interconnection with drag-and-drop.

Additional information: "Working with multiple interconnections (Page 139)"

Requirement
e ACFCisopen.

* The parameters are interconnected.

Procedure
1. Select the interconnection.

2. Perform one of the following actions:

@ Drag-and-drop: Interconnection with another output parameter.
® Drag-and-drop: Interconnection with another input parameter.

See also
Deleting an interconnection (Page|152)
Representation and properties of interconnections (Page|126)

Interconnecting input and output parameters (Page|135)
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4.5.14 Changing an interconnection to an external tag

Requirement
¢ ACFCisopen.
¢ Instructions/blocks are interconnected.

¢ "Data flow" is open.

Procedure
1. Select the connector with the tag name.
2. Select the external tag from the object list.
Result
The interconnection has been changed.
As an alternative, you can also change the interconnections of an instruction or block in the
control flow.
See also

Interconnecting input and output parameters (Page|135)
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4.5.15 Deleting an interconnection

Requirement
e ACFCisopen.
¢ Instructions/blocks are interconnected.

¢ "Data flow" is open.

Procedure
1. Select the interconnection line at the input parameter.
2. Select "Delete" in the shortcut menu of the interconnection line.
Result
The interconnection is deleted.
As an alternative, you can also delete the interconnections of an instruction or block in the
control flow.
See also

Representation and properties of interconnections (Page|126)
Changing an interconnection (Page|150)
Hiding input and output parameters (Page| 148)

Interconnecting input and output parameters (Page|135)
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4.5.16 Overview of textual interconnections

Textual interconnections

Configuring CFC charts

Textual interconnections are used for interconnections at which the interconnection source,
for example a block or chart output, does not yet exist.

A textual interconnection serves as the placeholder for a future interconnection.

Enter a free text with up to 1000 characters as the textual interconnection. The same
characters are permitted as for interconnections.

You can create, edit, delete and close textual interconnections in the "Data flow" or "Control
flow".
"Chart sequence & extras" editor

Depending on the target system, the textual interconnections of a project are displayed in the
"Textual interconnections" tab.

You can close or delete the interconnections in the editor.

You can change the path of the interconnection only in the data flow or control flow.

More information
¢ "Creating, editing and closing textual interconnections (Page 156)"

¢ "Textual interconnections in the "Chart sequence & extras" editor (Page| 159)"
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Overview
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A textual interconnection can only be created at a block/chart input and always references a
block or chart output in the CFC.

Entering text of the textual interconnection

If, after the completion of the entry, the entered text of the textual interconnection can be
interpreted as a reference to a valid path "\Chart\Block.Parameter", the textual
interconnection is closed immediately and is replaced by a real interconnection.

This means that each object can be addressed in the same chart, in a different chartor in a
lower level chart.

If the configured text of the textual interconnection cannot be interpreted as a reference
to a valid path, this textual interconnection remains "open". The entered text is displayed.

In the "Data flow", an interconnection is then established to the sheet bar and the "Textual
interconnection" symbol is displayed.

When a referenced interconnection source is created after the textual interconnection has
been created, this textual interconnection remains "open" until the user closes it manually.

Textual interconnections to other sources, such as tags, are not possible.

Copying a chart object

When a chart object is copied, a textual interconnection at this object is not copied.

Moving a chart object

When a chart object is moved, a textual interconnection at this object is retained.

Importing block types

When block types are imported, the textual interconnection behaves like any other
interconnection.

Compiling and loading

Textual interconnections are not relevant for the automation system and operating system
and are therefore ignored during compiling and loading.

Configuring CFC charts
System Manual, 11/2022, A5SE52420813-AA



Configuring and adapting CFC charts

4.5 Configuration and interconnection of input and output parameters

Effects of actions with the CFC chart

See also

Configuring CFC charts

Copying
When a chart is copied, the textual interconnections are copied as well.

This is true when the chart is copied within a CPU, between different CPUs and between
different projects.

In the copied chart, all existing interconnections to input parameters of the chart or its blocks
are replaced by textual interconnections.

Moving

Existing textual interconnections are moved with the chart.

If existing interconnections are disconnected by moving a chart, a new textual
interconnection is created for each disconnected interconnection.

In this process, the new textual interconnection is created depending on the previous
interconnection target, because a textual interconnection can only arise at a block/chart
input.

The newly created textual interconnections contain the reference to the path of the
interconnection before the move.

* Moving a chart into a different folder of the same CPU:
Because all the interconnections lie within the same CPU, they can still be reached.
Interconnections and textual interconnections are retained.

¢ Moving a subchart to a different folder of the same CPU:
Interconnections to chart objects and textual interconnections are retained.
Interconnections to chart interfaces are converted to textual interconnections.

¢ Moving a chart to a different CPU or a different project:
To move a chart, copy the chart to the other CPU or project and delete the original chart.
Interconnections to input parameters are converted to textual interconnections.
The interconnections of output parameters of the chart or its blocks to other charts are
removed in all charts.

Deleting

When a CFC chart is deleted, all interconnections of the chart are also deleted.

Interconnections from other CFC charts to the deleted chart are not converted into textual
interconnections but are also deleted.

Managing CFC charts and groups (Page 76)
Hierarchical CFC charts (Page 29)

Copying objects (Page 38)

Copying instructions, blocks and charts (Page|106)
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4.5.17 Creating, editing and closing textual interconnections

You can create, edit or close textual interconnections in the "Data flow" or in the "Control
flow".

Requirements
e ACFCisopen.
e Instructions/blocks have been inserted.

¢ "Data flow" or "Control flow" is open.

Procedure in "Data flow"

Creating a textual interconnection

1. Select the input parameter at the desired block or chart at which you want to create the
textual interconnection.

2. Select the command "Textual interconnection to chart..." from the shortcut menu.
An input field is opened at the parameter.

3. Enter a text.
A maximum of 1000 characters is permitted.

Result:

e If the entered text can be interpreted as a valid path to the interconnection source, a real
interconnection is created.

e If the entered text cannot be interpreted as a valid path to the interconnection source, an
interconnection to the sheet bar is created.

The entered text and the "textual interconnection" symbol are displayed in the sheet bar
to identify the textual interconnection: mo

Edit

1. Click the desired textual interconnection in the sheet bar.

2. Edit the text.

3. Exit your entry with the <Enter> key.

Result:

e If the entered text can be interpreted as a valid path, the textual interconnection is
replaced by a real interconnection.

¢ If the entered text cannot be interpreted as a valid path to the interconnection source, the
textual interconnection remains.

The changed text is displayed in the sheet bar.

Configuring CFC charts
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Delete
1. Click the desired textual interconnection in the sheet bar.
Alternatively, click the interconnection line in the chart.

2. Press the <Del> key or select the "Delete" command from the shortcut menu.

Closing an "open" textual interconnection

When a referenced interconnection source is created after the textual interconnection has
been created, this textual interconnection remains "open" until the user closes it manually.

Depending on the target system, you can also close an "open" textual interconnection in the
"Chart sequence & extras" editor.

1. Click the desired textual interconnection in the sheet bar.
2. Select the menu command "Close textual interconnections” from the shortcut menu.
Result:

¢ |If the entered text can be interpreted as a valid path, the textual interconnection is
replaced by a real interconnection.

¢ If the entered text cannot be interpreted as a valid path, the textual interconnection
remains and is displayed in the sheet bar.

¢ A message for the procedure is displayed in the Inspector window in the "Info > General"
tab.

Procedure in "Control flow"

Creating a textual interconnection

1. Navigate in the table to the input parameter of a block at which you want to create the
textual interconnection.

2. Click in the row of this input parameter in the table cell of the "Operand" column.
3. Select the command "Textual interconnection to chart..." from the shortcut menu.
An input field is opened in the table cell.
4. Enter a text.
A maximum of 1000 characters is permitted.
Result:

¢ If the entered text can be interpreted as a valid path to the interconnection source, a real
interconnection is created.

¢ If the entered text cannot be interpreted as a valid path to the interconnection source, the
textual interconnection is created in the table cell.

As identification of the textual interconnection, a colored background is assigned to the
entered text.
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Edit

1. Click in the table on the table cell in the "Operand” column that belongs to the desired
textual interconnection.

2. Edit the text.
3. Exit your entry with the <Enter> key.
Result:

* If the entered text can be interpreted as a valid path, the textual interconnection is
replaced by a real interconnection.

e If the entered text cannot be interpreted as a valid path to the interconnection source, the
textual interconnection remains.

The changed text is displayed in the table cell.

Delete
1. Click the desired textual interconnection in the table.

2. Select "Delete interconnection" from the shortcut menu.

Closing an "open" textual interconnection

When a referenced interconnection source is created after the textual interconnection has
been created, this textual interconnection remains "open" until the user closes it manually.

1. Click the desired textual interconnection in the table.
2. Select the menu command "Close textual interconnections” from the shortcut menu.
Result:

* If the entered text can be interpreted as a valid path, the textual interconnection is
replaced by a real interconnection.

* If the entered text cannot be interpreted as a valid path, the textual interconnection
remains.

* A message for the procedure is displayed in the Inspector window in the "Info > General"
tab.
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4.5.18 Textual interconnections in the "Chart sequence & extras" editor

Table columns

Configuring CFC charts

All open textual interconnections are displayed in the "Textual interconnections" tab of the
"Chart sequence & extras" editor in a table. This display depends on the target system.

The interconnections are displayed below the associated CFC.

Note
Configuration depending on the target system

You can use the "Chart sequence & extras" editor to check, close or delete open textual
interconnections.

The availability and the content of the tabs depend on the target system for which you are
configuring.

"Chart/Textual interconnection" column

The associated chart and the text of the textual interconnection are displayed for each textual
interconnection.

"Interconnected with" column

The column contains the input parameter at which the textual interconnection is configured.

"Status” column

The status or a possible action is shown in a comment.
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Functions

160

Various functions for textual interconnections are available through the toolbar and the
shortcut menu:

Hierarchy

In the "Chart/Textual interconnection" column you can completely show or hide the
hierarchy.

List entries

You can select or deselect all list entries.

Deleting textual interconnections
You can select multiple textual interconnections. All selected interconnections are deleted.

When all textual interconnections of a CFC were deleted, the CFC is removed from the table.

Closing textual interconnections
You can select textual interconnections as well as CFCs.
A comment is displayed in the "Status" column to help with the selection.

When you select a chart and start the "Close textual interconnections" function, all displayed
"open" textual interconnections of this chart are closed. You do not need to select the textual
interconnections additionally.

After the process has been completed, a message is displayed for each selected textual
interconnection in the "Info > General" tab in the Inspector window.

When all "open" textual interconnections of a CFC are closed, the CFC is removed from the
table.
Jump to "Data flow" or "Control flow"

When a textual interconnection is selected, you can use the symbols to jump to the "Data
flow" or the "Control flow".

When several textual interconnections are selected, the first textual interconnection in the
selection is displayed.

Configuring CFC charts
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4.6

4.6.1

Overview

4.6 Adapting the run sequence

Adapting the run sequence

Runtime model

The runtime model describes the following functions:
¢ If and when CFC charts are to be executed

¢ When and in which sequence the blocks and instructions in the CFC charts are to be
executed in the user program

Note

Configuration depending on the target system

You can use the "Chart sequence & extras" editor to check and change the run sequence and
task assignment.

The availability and the content of the tabs depend on the target system for which you are
configuring.

How the runtime model functions

Configuring CFC charts

Task assignment of the CFC charts
The runtime model is based on the assumption that the target system has one or more tasks.

¢ In the "Chart sequence & extras" editor you specify the task assignment for the chart
folders of the target system.

When you create a new CFC chart, this task is assigned to the chart as the main task.

For S7 target systems, you select the main task of a CFC chart in the "Target system
settings" tab.

* You can change the task assignment of the chart in the CFC chart properties.

Run sequence within the CFC chart
When you insert an instruction or block in the CFC chart, it is assigned to the main task.

However, you can specify the run sequence and the task assignment in the CFC chart
individually for each instruction or block.

Additional information: "Adapting the run sequence within the CFC chart (Page|166)"
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Run sequence of the CFC charts

The chart sequence determines the order in which the various CFC charts of the target system
is run.

Depending on the target system, you are able to determine the time of the execution of a
CFC chart with additional functions, e.g. "Reduction ratio", "Phase offset".

Additional information: "Options for determining the run sequence (Page 163)"

Optimization of the run sequence

You can have the run sequence optimized automatically:

* Run sequence of the CFC charts

* Run sequence of the instructions or blocks within the CFC charts

Additional information: "Optimizing the run sequence of CFC charts automatically
(Page|169)"

Run sequence and task assignment
Instructions and blocks are always assigned to one or more tasks of the target system.
Because of this, the following rules apply:
* If a block or instruction is assigned to several tasks, this object is executed in every task.

* Within a task, the instructions/blocks assigned to it execute in the configured run
sequence.

Example for target system S7
All blocks of the main task of the chart "task_1" are assigned in a CFC chart.
¢ Aninstruction "and_1"in this chart is assigned to another task "task 2".
The instruction "and_1"is not executed in "task_1" of this CFC chart.
* Aninstruction "and_2" has been assigned "task_1"and an additional "task_2":

The instruction "and_2" is executed in both tasks, "task_1"and "task_2".

See also
Adapting the run sequence of CFC charts (Page 168)
Basic settings for CFC charts (Page 41)
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4.6.2 Options for determining the run sequence
Run sequence of instructions and blocks

The run sequence within the CFC chart is determined by the order in which you insert the
instructions or blocks in the CFC chart.

You change the run sequence in the control flow.

Note
Depending on the target system

The display of the options "Enable chart", "Optimize chart", reduction ratio and phase offset
depends on the target system.

This means these options may not always exist and be adjustable in the properties of a chart.

"Enable chart" option

CFC charts are enabled or disabled for execution with the "Enable chart" option.

Configuration

You set the option at the "EN" parameter:
e 1=Chartisenabled

e 0 =Chartis not enabled

To interconnect the "EN" parameter, select the output parameter of a block or CFC chart in
the "Enable chart" field.

Configuring CFC charts
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* "EN" parameter

Editor Selected object Configuration Interconnections
Chart sequence & "Enable chart" column | Create
extras > "ghart Change
sequence" tab
Delete
Data flow > Inspector CFC chart "S7 specific": Create
'\Q}Qdow > "Properties” | (No object is selected.) |« “Enable chart” field | Change
Delete
Subchart in a CFC chart | "Interface™ Interconnected

parameters cannot be
edited.

"EN" parameter of a
subchart

"General":
e "Value" field

Interconnected
parameters cannot be
edited.

Control flow

"EN" parameter of a
subchart

"Operand” column

Change
Delete

Test mode

The "Enable chart" option can be changed online.

When the option is interconnected with a parameter, it cannot be edited online.
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"Optimize chart" option

Reduction ratio

Phase offset

164

You enable the setting "Optimize chart" in the chart properties.

When this setting is enabled the following options for optimizing the run sequence of this
CFC chart are available:

Editor Button Effect
Chart sequence & extras: Optimize run sequence according | Chart sequence and / or content of
to the signal flow the CFC charts are optimized.

e Chart sequence

CFC chart: Optimize run sequence of the CFC | The content of the CFC chart is

« Dataflow chart according to the signal flow | optimized.

e Control flow

When the "Optimize chart" field is disabled, the buttons in the editors have no function.

The reduction ratio specifies if the CFC chart is executed with each task call or only after a
specified number of runs.

The reduction value R is always a power of 2:
e R=2t
WithO<t<7
This means possible values are:
e 1,2,4,8,16,32, 64,128
Example for SIMATIC S7:
* Basic cycle of a cyclic interrupt:
500 ms
* Possible cycles due to reduction ratio:
500ms, 1s,2s,8s,165s,325,64s

In hierarchical charts you can only use the reduction ratio in basic charts and not in subcharts.

Phase offset enables an even load distribution within the target system.
The phase offset always depends on the reduction ratio "R".

The charts are processed as frequently as configured with the reduction ratio "R" and are each
shifted by "m" units of the task cycle.

* "m"is an integer

With0O<m < (R-1)

Configuring CFC charts
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Example with reduction ratio and phase offset

Configuring

See also

Configuring CFC charts

Settings:
¢ Basic cycle of a cyclic interrupt: 500 ms
e Reduction ratio=16
(The chart is executed every 8 seconds.)
e Phase offset=3
The chart is executed after 1.55s;9.55; 17.5 5, etc.
The default setting is "0".

The configuration of the reduction ratio and the phase offset depends on the target system.

Configuration for S7 target systems

You configure the reduction ratio and the phase offset in the chart properties under "General
> S7 specific > Sequence".

You check and configure other settings for the run sequence in the "Chart sequence & extras"
editor, for example, the task assignment or the run sequence of the charts.

The Editor gives you an overview of the settings of all CFC charts.

Runtime model (Page 161)

Representation of instructions and blocks (Page 94)
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4.6.3 Adapting the run sequence within the CFC chart

When you insert an instruction or a block in the CFC chart, the instruction or block is assigned
to the task of the CFC chart.

The run sequence of the instructions and blocks is decided by the order in which you have
inserted them in the CFC chart.

You change the run sequence in the control flow.

Optimizing the run sequence
You can also have the run sequence optimized automatically in the CFC chart.
You start this function using the toolbar in the control flow or data flow.

Additional information: "Optimizing the run sequence of CFC charts automatically
(Page 169)"

Requirement
e The CFCchartis open.
e "Control flow" is displayed.

* Instructions/blocks have been configured.

Procedure in the control flow

Adapting the run sequence manually

1. Drag the required instruction or block to the new position in the table.

Adapting the run sequence automatically
1. Enable the "Optimize chart" property for the chart.

2. Inthe toolbar, click on "Optimize run sequence of the CFC chart according to the signal
flow": &

Configuring CFC charts
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Alternative procedure: Data flow

Result

See also

Configuring CFC charts

Adapting the run sequence manually
You can specify the run sequence in a CFC chart while adding additional instructions/blocks:
1. In the data flow, select an inserted instruction or an added block.

2. In the shortcut menu of the instruction or block, select the entry "Use as predecessor in the
run sequence".

The next instruction or block is added in the run sequence after this object.

Adapting the run sequence automatically
1. Enable the "Optimize chart" property for the chart.

2. In the toolbar, click on "Optimize run sequence of the CFC chart according to the signal
flow":&

The run sequence is adapted.

Optimizing the run sequence of CFC charts automatically (Page 169)

Runtime model (Page 161)
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4.6.4 Adapting the run sequence of CFC charts

Requirement
¢ Two or more CFCs have been created for a controller.
¢ The CFCs have interconnections between charts.
e The "Chart sequence & extras" Editor is open.

* "Chart sequence" is displayed.

Procedure

1. Select a CFC.

2. Move the CFC to the new location by dragging it with the mouse.
Result

The run sequence is adapted.
See also

Optimizing the run sequence of CFC charts automatically (Page|169)

Runtime model (Page 161)
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4.6.5 Optimizing the run sequence of CFC charts automatically

Overview

To keep the dead times in the user program of a target system low, use the automatic
optimization of the run sequence.

The automatic optimization of the run sequence is based on the fact that the objects
executed first are those whose output values are used as input values for other objects.

You can, however, also exclude CFC charts explicitly from the automatic optimization.

Additional information: "Adapting the run sequence within the CFC chart (Page|166)"

Optimization options
You start the automatic optimization in the toolbar of the "Chart sequence & extras" editor.

In the "Optimize run sequence" dialog, you select the scope of the optimization:

Option Response

Chart sequence and contents of all Optimizes the run sequence of the charts as well as the

charts instructions and blocks within the charts.

Chart sequence Optimizes only the run sequence of the charts.

Contents of all selected charts Optimizes only the run sequence of the instructions and
blocks within the selected charts.

Include/exclude chart content

To enable the automatic optimization within a chart, enable the "Optimize chart" property for
the CFC chart.

If the setting is disabled at a chart, the following applies to this chart:
¢ The content of this chart is not optimized.

¢ The chartis taken into account during the optimization of the chart sequence.

Requirement
¢ Cross-chart interconnections or interconnections in the CFC charts are configured.
¢ The "Chart sequence & extras" editor is open.

¢ The "Chart sequence" is displayed.
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Procedure
1. Select the CFC charts whose run sequence you want to optimize automatically.
2. In the toolbar, click on "Optimize run sequence of the CFC chart according to the signal
flow": &
The "Optimize run sequence" dialog opens.
3. Select the required option in the dialog.
4. Click "OK".
The selected optimization of the run sequence is started.
Result
Depending on your selection, the run sequence of instructions and blocks within the CFC
charts and/or the chart sequence are optimized automatically.
See also

Adapting the run sequence within the CFC chart (Page|166)
Adapting the run sequence of CFC charts (Page 168)

Runtime model (Page 161)
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4.7 Testing the CFC chart

4.7.1 Selecting parameters for testing

Basic procedure

After configuration of the instructions and blocks in the CFCs, you can test the function of the
CFCs.

Values from the device are displayed at the input and output parameters for this.

Configuration takes place in the following steps:
1. Start by selecting the input and output parameters for the test.

2. Then you start the actual test in which values from the device are displayed at the input and
output parameters.

Additional information: "Testing the CFC (Page|173)"

Note
Value display depending on the interconnection

Input parameters of instructions and, for example, of "FC" functions in S7 can only display
values from the device if they are interconnected.

Although they can be selected in the table of parameters for testing, no values are displayed
for existing online connections.

Test settings
Various test settings are available depending on the target system you are using.
In test mode, you have the option to register or unregister parameters for testing.

Additional information: "Testing the CFC (Page 173)"

Deregister input and output parameters from testing

Requirement

Configuring CFC charts

To deregister an input or output parameter from the test, disable the option "For test".

¢ The CFCis open.
¢ Instructions/blocks have been configured.

¢ "Data flow" is shown in the work area.

System Manual, 11/2022, A5E52420813-AA 171



Configuring and adapting CFC charts

4.7 Testing the CFC chart

Procedure
1. Select the required instruction or block.

2. Enable under "Parameters" in the Inspector window for the required input and output
parameters the "For test" option.

3. If you want to select all input and output parameters for testing, select the "Activate all"
command in the shortcut menu of the header.

4. If you want to test several instructions/blocks of the CFC, repeat steps 1 to 3.

5. If necessary, configure the settings of the update times in the "Testing" task card for the
visible area of the CFC and the selected parameter or the interconnection.

Result

The required input and output parameters have been selected for testing.

See also

Setting the parameters of the input and output parameters (Page 122)
"CFC" Editor (Page 43)

Configuring CFC charts
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4.7.2 Testing a CFC chart

Overview

After configuration of the instructions and blocks in the CFC charts, you can test the function
of the CFC charts.

Values from the device are displayed at the input and output parameters for this.

Note
Procedure depending on the target system

The following section explains the procedure without covering properties of the specific
target system.

Additional information is available in the target system documentation e.g. for the S7 target
system under:

e "Working with CFC charts for S7"

Basic procedure
You always need to perform the following steps to test CFC charts:
1. Start by selecting the input and output parameters for the test.
Additional information: "Selecting parameters for testing (Page 171)"

2. Then you start the actual test in which values from the device are displayed at the input and
output parameters.

Configuring CFC charts
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Conditions for the test

Requirement

174

The following conditions apply to the test:

Displaying the latest values

The input and output parameters only receive the latest values for testing at the following
conditions:

¢ The parameters have been selected for the test.
¢ The parameters are available in the visible part of the CFC chart within the work area.
¢ Data memory is assigned to the parameters.
No values are displayed at parameters without data memory.
* Theinput parameters are connected to a source.

In the table of parameters, all parameters can be selected for testing, including
parameters that are not connected.

Comparison status of the block parameters

The values of the input and output parameters are highlighted in color:

. [ 1] miyfb add_w_1 WAND_W
iyt 2dd w1 WAND. W = T
ivaH Add W N OUT— FHEHE e Nz
[ ee— T T iy
#0505 —ini outt — 1680506 L g I:I A pch
| i minz | ‘ o o ‘
his J
Yellow The display of the parameters is uninterrupted.

The CFC charts and blocks are identical in the project and on the device.

The usual editing functions can be performed. For S7 target systems, for example, you
can change unconnected input parameters.

Red The status in the project and on the device does not match.
The chart has been changed, for example, but not yet downloaded to the device.

Editing functions are restricted. For example, you cannot change any parameters in
the CFC chart for S7 target systems.

Testing structures

If you select a parameter of the STRUCT data type for testing, the value of the first structure
element of the configured structure is displayed.

* The online connection to the device can be established.
* Rules for the device containing the CFC charts to be tested:

— The corresponding software must be compiled and loaded.

— Todisplay value changes, the CPU of the device must be in "RUN" mode.
¢ The required CFC chart is configured and open.

¢ "Data flow" is shown in the work area.

Configuring CFC charts
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Procedure
1. Click in the CFC chart, or select an instruction, or a block.
2. Click "Go online" in the toolbar.

Once you are online, all input and output parameters selected for testing are provided
with the current values from the device and are highlighted in color.

To monitor the values, click the "Monitor on/off" icon in the CFC editor: °%

3. If necessary, you can register or deregister a selected input or output parameter in the
"Testing" task card for testing.

You do not have to open the Inspector window for this purpose.

4. If necessary, select additional parameters for testing or remove previously tested parameters
in the Inspector window under "Parameters".

5. Depending on the target system, the "Testing" task card may contain additional settings that
may be relevant to the test.

Example S7 system: Update time of the visible area of the CFC chart.

Alternative procedure
You can also use the following options in the "Data flow" online mode to show values from
the device:
Value as tooltip

If you point to the input or output parameter with the mouse pointer, then the latest value
from the device is shown as tooltip.

Use the shortcut menu command "For test" to display the value.

Value with the STRUCT data type

The structure with all structure elements appears as a tooltip when you move the mouse
pointer over a parameter of STRUCT data type.

Display value permanently

If you have not selected the input or output parameter for testing, then you can keep the
<Ctrl> key pressed and click on an input or output parameter or an interconnection with the
mouse pointer.

The parameter is permanently selected for the test and the latest value from the device is
displayed.

Repeat this step to revert this function and no longer display the value.

Result

All input and output parameters in the visible work area that have been selected for testing
are supplied with the latest values from the device.

This enables you to test the function of the instructions and blocks.

Configuring CFC charts
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4.7.3 Effects of test mode on object properties

There are different special considerations in test mode that have an effect on specific
functions or editing options.

Properties of CFCs

"Enable chart" option
The "Enable chart" option can only be changed when online test mode is running.
When the option is interconnected with a parameter, it cannot be edited online.

You set the option at the "EN" parameter.

Properties of blocks and instructions

Interconnection

You cannot change an interconnection online which means it is blocked from changes in test
mode.

Any changes to an interconnection will have to be made offline and transferred by
compilation and downloading to the device.
Changes in parameter assignment

In test mode, changes to the parameter assignment of input/output parameters of blocks and
instructions are transferred directly to the device and into the project.

Such changes do not require a new download.

Representing interconnections

The connection lines of interconnections of data type BOOL are visualized in online mode
based on their current values.

¢ Value ="1": Green line
¢ Value ="0": Dashed blue line

The example in the following figure shows an interconnection of data type BOOL in online
mode.

_& & T TTTTTTEE &~
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Additional information

Notes on special considerations in test mode are included in the description of the respective
target system.

See also
Optimizing the run sequence of CFC charts automatically (Page 169)

Options for determining the run sequence (Page|163)
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4.7.4

Overview

Testing with the "Forcing" function

Individual parameters of a block can be set to a defined value for testing with the "Forcing"
function.

The so-called force table includes all parameters for which the "Add forcing” option is
selected.

The force table also provides an overview of all these parameters.

The use of the force table makes sense if you want to test several parameters with the
"Forcing" function and if these are located in different charts, for example.

Supported parameters and data types

* The "Forcing" function only supports parameters of the type "IN" or "INOUT".

e Parameters in the interface of a CFC are not supported.

* The table "Data types" contains the list of the data types that are supported or not
supported.

Configuration and use

In offline mode, configure the function "Add forcing".

You can enable the function "Forcing active" in online or offline mode and enter the desired
values.

However, the effects of the force value in the program are only visible in online mode.
Configuration consists of the following steps:
1. "Add forcing" at the parameter of a block

2. Enable forcing and enter the test value

1."Add forcing" at the parameter of a block

178

Configuration

¢ Enable the option at the parameter of a block in "Data flow" or "Control flow" of an open
chart.

Effects

* The "Forcing active" and "Force value" columns of an interconnected parameter can be
edited.

If the parameter has not been interconnected, the "Forcing active" option and the "Force
value" input field remain grayed out.

* The status "Add forcing" is indicated by a corresponding status display at the associated
parameter in the "Data flow".

* The parameter registered for forcing is also displayed in the so-called force table.

Configuring CFC charts
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2. Enable forcing and enter the test value

Configuring CFC charts

Enable the "Forcing" function for the desired parameter and enter the respective test value.

Configuration at the block parameter in "Data flow" or "Control flow"

Enable the option "Forcing active" for an interconnected parameter and enter the required
force value in the input box.

For a parameter that is not interconnected, you can enter the required value as a
parameter value in the "Value" input box in the "Instance data" area.

Effects:

The status "Forcing active" is indicated by a corresponding status display at the associated
parameter in the "Data flow".

The "Forcing active" status and the force value appear simultaneously in the row of the
force table belonging to the parameter.

Configuration in the force table

Enable the "Forcing active" option in the associated table row of an interconnected
parameter.

Enter the desired force value in the "Force value" column.

For a parameter that is not interconnected, the table lines associated with the parameter
for "Forcing active" and "Force value" are deactivated.

In this case, select the required parameter in the table.
The configuration data are displayed in the "Instance data" area in the Inspector window.

Enter the required value as a parameter value in the "Value" input box in the "Instance
data" area.

Effects:

The entered force value is also displayed at the associated parameter in "Data flow" or
"Control flow".

The status "Forcing active" is indicated by a corresponding status display at the associated
parameter.
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Status displays for "Forcing" function in "Data flow"

Data types

180

The status displays are shown at the associated block parameter in "Data flow":

¢ The "Add forcing" option has been enabled: the associated parameter is identified by a

brown rectangle.

¢ The "Add forcing" and "Forcing active" options have both been enabled: the associated
parameter is identified by a blue rectangle.

Example

In this example, the following status displays are shown at a block in "Data flow":

e Istinput parameter:

The "Add forcing" option has been enabled. The "Forcing active" option has been disabled.

e 2nd input parameter:

The "Add forcing" and "Forcing active" options have both been enabled.

—_ &

Offline display

Online display

The following tables show the supported and unsupported data types.

Data type category

Unsupported data types

Parameter types

TIMER
COUNTER

BLOCK_DB
BLOCK_FB
BLOCK_FC

Pointer

POINTER
ANY
VARIANT

Data structures

ARRAY

Configuring CFC charts
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See also

Configuring CFC charts

4.7 Testing the CFC chart

Data type category

Supported data types

Binary numbers

BOOL
BYTE
WORD
LWORD
DWORD

Integers

SINT
USINT
INT
DINT
UDINT
LINT
ULINT

Floating-point numbers

REAL
LREAL

Times

S5TIME
TIME
LTIME

Date and time

DATE
TOD
LTOD
DT
LDT
DTL

Strings

CHAR
WCHAR
STRING
STRING[N]

Data structures

STRUCT

The data types listed above are supported in each level of the
structure for the STRUCT data type.
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4.7.5 Setting parameters to defined values for testing ("Forcing" function)

Overview

Basic procedure

Requirements

182

Parameters of a block can be set to a defined value for testing with the "Forcing" function.
If you want to test several parameters with the "Forcing” function that are, for example,
located in different charts, use of the so-called force table is recommended.
Additional information
* Supported data types:

"Testing with the "Forcing" function (Page 178)"

* "Setting several parameters to defined values with the "Forcing" function (Page|184)"

Configuration basically takes place in two stages in "Data flow" or "Control flow":
1. "Add forcing" at the parameter of a block

2. Select the "Forcing" function for this parameter and enter the required force value of the
parameter.

In offline mode, configure the function "Add forcing".

You can enable the function "Forcing active" in online or offline mode and enter the desired
values.

However, the effects of the force value in the program are only visible in online mode.

* The online connection to the device has been established once before.
* Rules for the device containing the CFCs to be tested:
— The corresponding software must be compiled and loaded.
— The CPU of this device must be in "RUN" operating mode.
* The required CFC is configured and open.
» "Data flow" or "Control flow" is shown in the work area.

The following section explains the procedure in "Data flow".

Configuring CFC charts
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Procedure

Result

Configuring CFC charts

4.7 Testing the CFC chart

. Select the required parameter of an instruction or block.

The "General" tab is displayed in the Inspector window.

. Select the "Add forcing" option in the "Instance data" area under "General" in the Inspector

window.

In "Data flow", a green rectangle at the associated parameter indicates that the parameter
is registered for "Forcing".

The parameter is also displayed in the so-called force table under "Charts - Trend/dynamic
display & force table".

. Further configuration depends on whether or not the parameter is interconnected.

— If the parameter is interconnected, the check box "Forcing active" and the input box
"Force value" are shown.

Select the "Forcing active" check box and enter the required force value in the "Force
value" input box.

— If the parameter is not interconnected, the check box "Forcing active" and the input
box "Force value" are not shown.

. To test the effects of the force value in the CFC, click "Go online" in the toolbar.

. All force values are transferred to the device once you are connected online.

All input and output parameters in the visible work area that have been selected for
testing are supplied and displayed with the latest values from the device.

You can change the force values in online mode.

When you change force values offline, these values will not become effective until after
they were downloaded to the PLC.

The parameter of an instruction or a block is registered for "Forcing".
The "Forcing" function is selected for this parameter and a force value is configured.

The effect of the force value can be tested in the chart with an existing online connection.
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4.7.6 Setting several parameters to defined values with the "Forcing" function

The "Forcing" function
Parameters of a block can be set to a defined value for testing with the "Forcing" function.

The following section explains how to use the so-called force table with which you use the
"Forcing" function for several block parameters.

The use of the force table makes sense if you want to test several parameters with the
"Forcing" function and if these are located in different charts, for example.
Additional information
* Supported data types:
"Testing with the "Forcing" function (Page 178)"

» "Setting parameters to defined values for testing ("Forcing” function) (Page| 182)"

Basic procedure
Configuration basically takes place in two stages:
1. "Add forcing" at a block parameter in "Data flow" or "Control flow":

2. Select the "Forcing" function for this interconnected parameter and enter the required force
value of the parameter.

The following paragraph describes the method for working with the force table.

You can also make this configuration for individual parameters in the "Data flow" or
"Control flow" of a chart.

In offline mode, configure the function "Add forcing".

You can enable the function "Forcing active" in online or offline mode and enter the desired
values.

However, the effects of the force value in the program are only visible in online mode.

Requirements
* The online connection to the device has been established once before.
* Rules for the device containing the CFCs to be tested:
— The corresponding software must be compiled and loaded.

— The CPU of this device must be in "RUN" operating mode.

Configuring CFC charts
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Procedure

1. To use the parameters of instructions or blocks in the force table for testing, you first have to
select the "Add forcing" option at the required individual parameters.

If you have already made this configuration, you can continue with step 5.

Open the CFC of a required parameter in "Data flow" or "Control flow" that is to be
available for testing in the force table.

2. Select the required parameter of an instruction or block.
The "Forcing" function only supports parameters of the type "IN" or "INOUT".
The "General" tab is displayed in the Inspector window.

3. Select the "Add forcing" option in the "Instance data" area under "General" in the Inspector
window.

In "Data flow", a green rectangle at the associated parameter indicates that the parameter
is registered for "Forcing".

The parameter is also displayed in the so-called force table under "Charts - Trend/dynamic
display & force table".

Repeat steps 1 - 3 for each parameter that is to be available for testing in the force table.
Download the program to the device.

Click "Go online" in the toolbar.

N oo oA

Open the force table.

Double-click the "Force table" entry in the "Charts - Trend/dynamic display & force table"
folder of the project tree.

The force table is opened in the work area.

— You can turn the sorting of the table on/off or change it by clicking the respective table
column.

— You can manipulate the display and width of the table columns with the shortcut menu
of a column header.

— The "Tag" column displays all parameters with the
"<Chart>\<Block_name>.<Parameter_name>" path for which the "Add forcing" option is
selected.

— Double-click the path in the "Tag name" column to open the associated CFC and select
the configured parameter.

— When you select a table line, the "General" tab with the configuration data of this
parameter is displayed in the Inspector window.

— If you clear the "Add forcing" option for a parameter, this parameter is removed from
the table.

Configuring CFC charts
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8. Further configuration depends on whether or not the parameter is interconnected.

— If the parameter is interconnected, the "Forcing active" option and the input box in the
"Force value" column can be configured in the table.

Select the "Forcing active" option for the required parameters and enter the required
force value in the table column of the same name.

— If the parameter is not interconnected, the "Forcing active" option and the "Force
value" input box cannot be configured in the table.

9. All force values are transferred to the device because you are already in online mode.

10.To check the effects of the force value of a parameter, open the associated chart with a
double-click on the path in the "Tag name" column.

All input and output parameters in the visible work area that have been selected for
testing are supplied and displayed with the latest values from the device.

Result

Several parameters of instructions or blocks are registered for "Forcing" and are displayed in
the force table.

The "Forcing" function is selected for these parameters and a force value is configured, if
necessary.

The effect of the force value can be tested in the chart with an existing online connection.

Configuring CFC charts
186 System Manual, 11/2022, A5SE52420813-AA



Configuring and using the trend and dynamic 5
displays

5.1 Overview of the trend and dynamic displays
The following options are available for monitoring multiple static and online values:
e Trend display
This allows you to visualize multiple values in a trend chart.
e Dynamic display
This allows several values to be displayed in the form of a watch table.

The compilations of selected tags/parameters are stored for reuse.

General properties

e The trend and dynamic displays are stored and managed in the project tree, in the "Charts
- Trend/dynamic display & force table" folder.

The objects can be copied to or deleted from this folder.

* You can create several trend and dynamic displays for each target system.

Configuring CFC charts
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5.1 Overview of the trend and dynamic displays

Overview of the trend display

188

The trend display configured in the editor window consists of the following objects:
* Definition table

¢ Trend window with operator controls and trend chart

Parameters in the trend display
The parameters to be monitored can be added to the trend display as follows:

* Using drag-and-drop with trend display opened in the editor window, or using copy/paste
to the definition table.

The parameter you inserted can be assigned directly to an axis.

* If the trend display is not open, you can drag-and-drop the parameter to the trend display
in the project tree.

In this case, the parameter is assigned automatically to an appropriate axis
(digitallanalog).

If it does not yet exist, the axis is generated automatically.
The values are assigned to digital and analog axes and displayed.

A trend display can contain several digital and analog axes.

Exporting values

The values of the trend chart can be exported or imported in CSV format.

Printing the trend display

You start the print in the project navigation via the shortcut menu or from the opened trend
display.

Alternatively, you can open the "Print" dialog in the definition table with the key combination
<Ctrl+P>.

* Print the axis and curve definition table in the project navigation or in the definition table.

* In the open trend display, print the trend chart using the "Print" button.

STEP 7 traces
Alternatively, you can also display the parameters of the CFC blocks in STEP 7 traces.

During trace configuration, the block parameters are listed in the "Signals" table in the
selection dialog.

Additional information in the TIA Portal Information System:

* "Using online and diagnostics functions > Using the trace and logic analyzer function”

Additional information

e "Creating a trend display (Page 196)"

e "Using the trend display (Page 198)"

* "Trend display - Functions and operating options (Page 190)"
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Overview of the dynamic display

Configuring CFC charts

Parameters in the dynamic display
The parameters to be monitored can be added to the dynamic display as follows:

Using drag-and-drop with dynamic display opened in the editor window, or using copy/paste
to the definition table.

If the dynamic display is not open, you can drag-and-drop the parameter to the
corresponding dynamic display in the project tree.

Printing the dynamic display

You start printing in the project navigation via the shortcut menu.

Alternatively, you can open the "Print" dialog in the open dynamic display with the <Ctrl+P>
key combination.

¢ In offline mode, the offline values are printed.

* In online mode, the corresponding online values are printed.

Additional information
¢ "Creating a dynamic display (Page 200)"
¢ "Using the dynamic display (Page 202)"
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5.2 Trend display - Functions and operating options

5.2

Trend display - Functions and operating options

Layout and operating options

The trend display consists of the following objects:
» Definition table
¢ Trend window with operator controls and trend chart

The trend window provides various functions for operating and controlling visualization in
the trend chart.

The tables below contain the following descriptions:
* Toolbar functions
* Trend window elements and operating options

e User actions for rapid working

Overview of the trend view layout

190

. 7

The following figure provides an overview of the elements.
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Toolbar functions

5.2 Trend display - Functions and operating options

The toolbar provides the following functions.

Element | Function Description
(icon / selection box)
(1) Zoom The zoom icons can be used to zoom the horizontal and vertical axes separately.
(icons) The toolbar provide a zoom in and a zoom out icon.
)] Display mode The display mode for the x time axis of the trend chart can be set up using the
(selection box) selection box of the toolbar.
The following display modes are available:
e "Static" option (static time range display)
The time interval is not refreshed. You can set any range. This mode can be
used to visualize all logged values in detail.
It is recommended to use this display mode for static values.
e "Strip" option (dynamic display)
The time axis always displays the current time at the far right. The duration of
the time interval can be changed.
e "Scope" option (jumping time range display)
The time axis displays a fixed time interval. Once the trend values reach the
right edge, the display changes so that the current time is shown at the left
edge.
e "Sweep" option (sweep mode display)
Similar to "Scope”. However, the values of the "last sweep" continue to be
displayed until they are overwritten by the current values.
(3) Trend manager The trend manager visualizes the trend to axis assignments.

("Select trend:" selection
field)

You can hide trends by disabling the corresponding check box. Hidden trends are
no longer recorded in the trend chart, but still displayed in the legend in grayed
out mode.

Select trends to be edited in the trend manager.

In addition to a color code, the trends in the trend chart are also provided with a
marker to enable their quick identification in the legend and trend manager.

4) Import/export The trends can be exported or imported in CSV format.
(icons) The export icon is enabled once you have selected a trend in the trend manager
(3).
Imported trends are visualized on separate x and y axes. You can improve the
comparison of an imported trend with a trend from active logging by linking the
x axis of the imported trend with the existing axis.
(5) Customizing the user This menu can be used to show and hide display elements such as the legends,
interface rulers, or markers.
("View" menu)
(6) Linking x axes When a trend is imported, the new x axis (axis "B") can be linked to the existing x
("Link axes" selection field) | axis (axis "A"). In linked mode, axis "B" moves simultaneously with axis "A", but
can be adjusted without interfering with axis "A". This mode allows you to
compare history trends with the current trend.
(7) Printing The print dialog can be used to print the currently displayed trends of the trend
("Print" icon) chart. The printout can include a comment.
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Trend view elements and operating options

The following operator controls are provided in the trend view.

Element | Function Description
(icon / selection box)
(8) Maximum value Field for displaying the maximum value of an analog axis.
Access for editing depends on the state of the associated write protection
9).
¢ "Write protection disabled" state (open padlock icon):
You can edit the value in the corresponding column of the definition
table, or directly in this field. Changes to the cell in the definition table
are transferred to the field of the y axis.
However, changes to the field of the y axis are not transferred to the
corresponding cell in the definition table!
e "Write protection enabled" state (closed padlock icon):
The value cannot be edited in the corresponding column of the definition
table or in the y axis field.
You can restore the configured minimum/maximum with double-click on the
y axis.
9) Lock text box Using this icon, you can enable write protection for the input field next to
the icon (closed padlock icon), or disable it (open padlock icon).
(10) Y axis (here: analog axis) The y axis is labeled with the axis name and the configured physical unit.
In the figure above, axis position "right" was configured for the analog y axis.
1) Minimum value Field for displaying the minimum value of an analog axis.
Access for editing depends on the state of the write protection (9).
¢ "Write protection disabled" state (open padlock icon):
You can edit the value in the corresponding column of the definition
table, or directly in this field. Changes to the cell in the definition table
are transferred to the field of the y axis.
However, changes to the field of the y axis are not transferred to the
corresponding cell in the definition table!
e "Write protection enabled" state (closed padlock icon):
The value cannot be edited in the corresponding column of the definition
table or in the y axis field.
You can restore the configured minimum/maximum with double-click on the
y axis.
(12) Time (right edge of the visualized | The field displays the time for right edge of the x axis.
trend range) Write access depends on:
* The state of the associated write protection (9)
¢ The selected display mode (2)
You can use the selection function to open a calendar and select a different
day.
(13) Time range of the x-axis The time range of the x axis is set in the definition table.
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5.2 Trend display - Functions and operating options

Element | Function Description
(icon / selection box)
(14) Time (left edge of the visualized | The field displays the time for the left edge of the x axis.
trend range) Write access depends on:
* The state of the associated write protection (9)
e The selected display mode (2)
?j(ou can use the selection function to open a calendar and select a different
ay.

(15) Digital trend names The names of the digital trends (25) are displayed outside of the trend chart.
The position depends on the configured position of the digital axis (16).

(16) Y axis (here: digital axis) The y axis is labeled with the axis names.
In the figure above, axis position "left" was configured for the digital y axis.

(20) Legend (analog trends) The legend displays the markers and names of the visualized analog trends.
The corresponding values are displayed to the right of the trend name:
e |If thereis no ruler, the last values added to the trend are displayed.
e If at least one ruler is displayed, the associated values are displayed to

the right of the trend name at the active ruler.

(21) Analog trends Analog trends are visualized in the upper area of the trend window.
The names of the analog trends (F) are displayed in the legend of the trend
chart.
A tooltip is displayed for each visualized trend whenever you position the
mouse pointer on the trend line. The tooltip first displays the trend name;
click this name to display the configured data source.

(22) Markers Markers help you to distinguish between several trends.
You can enable the display of markers in the "View" menu.

(23) Interpolated trend value A value without underscore on the ruler indicates that this is an
interpolated value.
A defined online value is not available for this trend point.

(24) Defined trend value AnI underscored value on the ruler indicates that this is a defined online
value.

(25) Digital trends Digital trends are visualized in the lower area of the trend window.
The names of the digital trends (15) are displayed outside of the trend chart.
The position depends on the configured position of the digital axis (16).
A tooltip is displayed for each visualized trend whenever you position the
mouse pointer on the trend line. The tooltip first displays the trend name;
click this name to display the configured data source.
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5.2 Trend display - Functions and operating options

Element | Function Description
(icon / selection box)

(26) Ruler A ruler displays the value of each trend at the ruler/trend intersections.
Every ruler displays the associated time stamp with data and time.
A trend chart may have several rulers.
The active ruler is indicated by a yellow marker at its top end. The values at
the active rulers are displayed in the legend (A) to the right of the trend
name.
Adding rulers:
e You can drag-and-drop a new ruler from its docking position on the left

edge of the trend chart to a specific position in the trend chart.

Copying rulers:
* Press <CTRL> and click the ruler to paste a copy thereof.
Deleting rulers:
e Drag the ruler to the left edge of the trend chart.
e Press <ALT> and click the ruler to be deleted.

(27) Ratio display / scroll bar (y axis) | This function depends on the selected display mode (2) and only affects
analog trends.
* Scroll bar function + ratio display in "Static" display mode.
e Ratio display in all other display modes.
Ratio display:
The scroll bar displays the approximate ratio between the configured and
currently displayed range of values of the y axis in the trend chart.
Scroll bar:
The scroll bar can be used to shift the visible range of a trend in the trend
chart if the displayed range of the y axis was modified in vertical direction,
for example, by means of the zoom icons (1).

(28) Ratio display/scroll bar (x axis) This function depends on the selected display mode (2) and only affects
analog trends.
e Scroll bar function + ratio display in "Static" display mode.
e Ratio display in all other display modes.
Ratio display:
The scroll bar displays the approximate ratio between the configured and
currently displayed range of values of the y axis in the trend chart.
Scroll bar:
The scroll bar can be used to shift the visible range of a trend in the trend
chart if the displayed time range of the x axis was modified in horizontal
direction, for example, by means of the zoom icons (1).
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User actions for rapid working

5.2 Trend display - Functions and operating options

Various toolbar functions and mouse actions are available to accelerate your work.

Action

Function

Description

Zooming windows with
pressed left mouse button

Zoom function with window

You can define the display range of the trend chart by
dragging the window while pressing the left mouse button.

All axis value ranges for which write protection is not
enabled by means of the lock icon are adapted when you
release the mouse button.

Double-click on the chart
area

Adapting trends

Double-click on the chart area of the trend chart sets the
analog range of values of the y axes for analog trends so
that the trends are completely visible in the current time
range.

<Alt> + double-click on the
chart area

Arranging trends

<Alt> + double-click in the chart area of the trend chart
adapts the range of values of the y axes for analog trends so
that the trends are arranged vertically.

Dragging the scale with
pressed left mouse button

Editing the range of values of
the axes

To change the range of values of an axis, click the axis and
then drag the scale to the new value while keeping the left
mouse button pressed.

* The arrows at the mouse pointer indicate the possible
direction of change.

— If the arrows point in both directions you can edit
both values.

— You can only edit one value if only one arrow is
displayed, for example, in the direction of the
minimum value.

e Only the axis value ranges for which write protection is
not enabled by means of lock icon are adapted.
Example:

If write protection of the minimum and maximum values of
the y axis is not enabled, both values change simultaneously
when you drag the scale while keeping the left mouse
button pressed. The current difference between both
values remains unchanged!

Double-clicking on the axis resets the range of values to the
configured values.

Double-click on the axis

Resetting the range of values

Double-clicking on the axis resets the range of values to the
configured values.

Space bar plus drag-and-
drop of an axis

Moving axes

The position of the y axes is specified in the definition table
of the trend display.

However, you can change the position of the x and y axes in
online mode by pressing the space bar and moving the
selected axis to the new position using drag-and-drop.

This method can be used, for example, to move the x axis
towards the top.

See also

Overview of the trend and dynamic displays (Page 187)
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5.3 Creating a trend display

5.3 Creating a trend display
A trend display allows you to visualize multiple online values in a trend chart.

This section describes how to create and configure a new trend display.

Requirements

¢ The parameters whose online values are to be displayed in the trend display must be
configured.

¢ The CFC charts and blocks must be compiled.

Procedure

1. Double-click the "Add new trend display" entry in the "Charts - Trend/dynamic display & force
table" folder of the project tree.

— A new trend display is added to the folder and opened in the editor.

— In the editor window, the table for the axis definition and the window for the trend
chart are displayed.

Work in the definition table of the trend display to configure parameters whose online
values are to be displayed in the trend chart.

2. To change the name of the trend display, select the "Rename" entry in the shortcut menu in
the project tree.

3. Open a CFCchartin a second editor window.
Navigate to the desired parameter in the CFC chart or in the chart interface.
4. Drag-and-drop the parameter from the chart into the "y axis/trend" column.

Alternatively, use Copy and Paste from the shortcut menu or the <Ctrl+C> and <Ctrl+V>
keyboard shortcuts.

The inserted parameter is displayed in a new row of the table:

— The name of the "y axis/trend" column is set by default and cannot be changed.
— The trend name is displayed in the legend in the trend window.

— Since the trend display is newly created, no axes have been defined yet.

Depending on the data type of the inserted parameter, an analog or digital axis is
automatically inserted in the "y axis/trend" column.

5. Configure the properties for the trend representation in the line of the inserted parameter:
— Trend name
— Trend color
— Emphasis (line thickness)
— Value representation (line or points)
— Sampling time

You can show and hide columns via the shortcut menu in the table header.
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5.3 Creating a trend display

6. Add additional parameters if needed.

A digital or analog axis is inserted automatically if you insert a parameter of a specific data
type for which an axis does not yet exist.

To add a parameter to a specific axis, select the desired axis during insertion. You cannot
move the parameters in the table.

7. Configure the properties of the inserted axes in the table:
— Name of the axis
The axis name is displayed in the trend view as axis label.
— Minimum value
— Maximum value
— Position (left or right)
— Unit of the values
— Axis mode (linear or logarithmic)

The "Unit" and "Axis mode" properties can only be edited for analog axes.

Alternative procedure: Inserting parameters

If the trend display is not open, drag-and-drop a parameter from the chart to the
corresponding trend display in the project tree.

The parameter is automatically assigned to an axis.

If it does not yet exist, the axis is generated automatically.

Result

You successfully created a new trend display and configured the parameters/tags to be
visualized.

See also
Overview of the trend and dynamic displays (Page 187)
Using the trend display (Page 198)
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5.4 Using the trend display

5.4 Using the trend display

Overview

A trend display allows you to visualize multiple online values in a trend chart.

Note
Value display depending on the interconnection

You can only record trends from the values that can also be monitored in online mode.

For this reason, no values of instructions are displayed in the trend chart if the input
parameters are not interconnected.

Additional information
* "Creating a trend display (Page 196)"
* "Trend display - Functions and operating options (Page 190)"

Trend values: Performance data and storage capacity requirement

Trend values per trend

A maximum of 10000 trend values per trend can be stored in the trend display.

Memory requirements
Each trend value occupies 16 bytes of memory.

That is, each trend occupies a maximum of 1.6 MB.

Sampling time and time range

You increase the sampling time to extend the time range of stored trend values.

e 1 ssampling time: A time range of approx. 2.7 hours can be stored.

¢ 10 s sampling time: A time range of approx. 27.7 hours can be saved.

For S7 target systems, you have the following options to specify the sampling time:

* Inthe "Testing" task card in the "Test settings" area you specify the "Sampling time chart"
in milliseconds.

— Minimum value for CFC charts: 500 ms
— Minimum value for parameters: 200 ms

* You change the sampling time for analog values in the "Sampling time" column of the
definition table in the trend display.

This value can only be equal to or greater than the value of the "Sampling time chart".
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Requirements

Procedure

Result

See also

Configuring CFC charts

5.4 Using the trend display

The CFC charts and blocks have been compiled and downloaded to the device.
The trend display is configured.
The online connection to the device has been established once before.

To display value changes, the CPU of the device must be in "RUN" mode.

. Open the trend display by double-clicking its name in the "Charts - Trend/dynamic display &

force table" folder.

The table for the axis definition and the window for the trend chart are displayed in the
editor window.

. Click "Go online" in the toolbar.
3. Click the "Monitoring on/off" toolbar icon in the editor window of the trend display: *%'

. If you hover over the trend line with the mouse, a tooltip with the trend name is displayed

for each displayed digital or analog trend.

When you click on the trend name, the configured data source is displayed.

. In the toolbar, in the "Time span of x axis" drop-down list, select the time range that the

trend chart is to display.

For analog values, you select the time for each analog trend individually in the "Sampling
time" column of the definition table.

This selection also influences the time range that a trend display can save.

. In the toolbar, select the functions for controlling the display in the trend view.

The display of the online values and the trend chart is adjusted.

. Depending on the target system, the "Testing" task card may contain additional settings for

testing and displaying online value.

Additional information on the S7 target system: "Working with CFC charts for S7"

Online values are shown in a trend chart with the trend display.

Overview of the trend and dynamic displays (Page 187)
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5.5 Creating a dynamic display

5.5

Requirements

Procedure

200

Creating a dynamic display
A dynamic display allows you to visualize multiple online values in a table.

This section describes how to create and configure a new dynamic display.

The parameters whose online values are to be displayed in the dynamic display must be
configured.

The CFC charts and blocks must be compiled.

. Double-click the "Add new dynamic display” entry in the "Charts - Trend/dynamic display &

force table" folder of the project tree.
— A new dynamic display is added in the folder.
— The table for the dynamic display is opened in the editor window.

Work in the table of the dynamic display to configure parameters whose online values are
to be displayed in the dynamic display.

. To change the name of the dynamic display, select the "Rename" entry in the shortcut menu

in the project tree.

. Open a CFCchart in a second editor window.

Navigate to the desired parameter in the CFC chart or in the chart interface.

. Drag-and-drop the parameter from the chart into the "Tag name" column.

Alternatively, use Copy and Paste from the shortcut menu or the <Ctrl+C> and <Ctrl+V>
keyboard shortcuts.

The inserted parameter is displayed in a new row of the table.

The "Tag name" column contains the link to this parameter.

. Configure the properties in the row containing the inserted parameter.

You can show and hide columns via the shortcut menu in the table header.

The "Unit" property can only be edited for analog values.

. Add additional parameters if needed.

. You can exclude individual parameters from updating:

In the Inspector window, disable the "For test" option in the "Properties" tab. Online values
are displayed only for the parameters for which the option is enabled.

This function is particularly useful if you have numerous tags/parameters in the dynamic
display and do not need all online values.
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Alternative procedure: Inserting parameters

If the dynamic display is not open, drag-and-drop a parameter from the chart to the
corresponding dynamic display in the project tree.

Result

You have successfully created a new dynamic display and configured the parameters/tags to
be visualized.

See also

Overview of the trend and dynamic displays (Page 187)
Using the dynamic display (Page|202)
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5.6 Using the dynamic display

5.6

Requirements

Procedure

Result

See also

202

Using the dynamic display
A dynamic display allows you to visualize multiple online values in tabular format.

Additional information: "Creating a dynamic display (Page 200)"

The CFC charts and blocks have been compiled and downloaded to the device.
The dynamic display has been configured.
The online connection to the device has been established once before.

To display value changes, the CPU of the device must be in "RUN" mode.

. Open the dynamic display by double-clicking its name in the "Charts - Trend/dynamic display

& force table" folder.

The editor displays a table.

. Click "Go online" in the toolbar.

. Click the "Monitoring on/off" toolbar icon in the editor window of the dynamic display: =

The current online values of the configured tags or parameters are displayed in the table.

. Check the settings in the "For test" column:

— If the option is enabled, the online values of the configured tags or parameters are
displayed.

— If the option is disabled, no online value is displayed for the corresponding parameter.

. You can add additional parameters to the table in online mode.

For example, drag-and-drop a parameter from a CFC chart into the table of the dynamic
display.

. Depending on the target system, the "Testing" task card may contain additional settings for

testing and displaying online value.

Additional information on the S7 target system: "Working with CFC charts for S7"

Online values are displayed in a table with the dynamic display.

Overview of the trend and dynamic displays (Page 187)
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6.1 Data types in the TIA Portal
CFCs support the standard data types of the TIA Portal.

Additional information on syntax and display of the data types, for example, is available in
the TIA Portal information system:

e "Program PLC > Data types"
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6.2 Elementary data types

6.2 Elementary data types
6.2.1 Bit strings
6.2.1.1 BOOL (Boolean)
Keyword
BOOL
Description
Bit value

Value range

Oto1
See also
Data types in the TIA Portal (Page/203)
6.2.1.2 BYTE
Keyword
BYTE
Description

Sequence of 8 bits

Value range
0 to 255

See also
Data types in the TIA Portal (Page/203)
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6.2.1.3 WORD
Keyword

WORD
Description

Sequence of 16 bits

Value range

0 to 65535
See also

Data types in the TIA Portal (Page|/203)
6.2.1.4 DWORD (Double Word)
Keyword

DWORD
Description

Sequence of 32 bits
Value range

0to 4294967295
See also

Data types in the TIA Portal (Page|[203)
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6.2 Elementary data types

6.2.1.5 LWORD (Long Word)
Keyword

LWORD
Description

Sequence of 64 bits

Value range
¢ Signed integers:
-9 223 372 036 _854 775 808 to +9 223 372 036_854 775 807
¢ Unsigned integers:
0to 18_446_744 073_709 551 615
See also

Data types in the TIA Portal (Page/203)
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6.2.2 Integers

6.2.2.1 Signed integers

SINT (Short Integer)

Keyword
SINT

Description

Signed integer

Value range
-128 to +127

See also
Data types in the TIA Portal (Page[203)

INT (Integer)

Keyword
INT

Description

Signed integer

Value range
-32768 to 32767

See also
Data types in the TIA Portal (Page[203)
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6.2 Elementary data types

DINT (Double Integer)

Keyword
DINT

Description

Signed double integer

Value range
From -2 147 483 648 to +2 147 483 647

LINT (Long Integer)

Keyword
LINT

Description

Signed integer

Value range
-9 223 372 036_854 775 808 to +9_223 372 _036_854 775 807

See also
Data types in the TIA Portal (Page/203)
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6.2.2.2 Unsigned integers

USINT (Unsigned Short Integer)

Keyword

USINT
Description

Unsigned integer
Value range

0 to 255
See also

Data types in the TIA Portal (Page|[203)

UINT (Unsigned Integer)

Keyword
UINT
Description
Unsigned double integer
Length 16 bits
Value range
From O to 65_535
See also

Data types in the TIA Portal (Page|[203)
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6.2 Elementary data types

UDINT (Unsigned Double Integer)

Keyword
UDINT

Description

Unsigned integer

Value range
0to 4 294 967 295

See also
Data types in the TIA Portal (Page/203)

ULINT (Unsigned Long Integer)

Keyword
ULINT

Description

Unsigned integer

Value range
0to 18_446_744 073_709 551 615

See also
Data types in the TIA Portal (Page/203)
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6.2 Elementary data types

6.2.3 Floating-point numbers
6.2.3.1 REAL (Real Numbers)
Keyword

REAL
Description

Signed floating-point number

See also
Data types in the TIA Portal (Page[203)
6.2.3.2 LREAL (Long Reals)
Keyword
LREAL
Description
Unsigned floating-point number
See also

Data types in the TIA Portal (Page[203)
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6.2 Elementary data types

6.2.4 Duration (Times)
6.2.4.1 TIME
Keyword

TIME
Description

Duration

Value range
-24d_20h_31m_23s 648ms to 24d_20h_31m_23s_647ms
(In milliseconds: -2147483648 ms to 2147483647 ms)

See also
Data types in the TIA Portal (Page/203)
6.2.4.2 LTIME (Long Time)
Keyword
LTIME
Description
Duration
Days (d), hours (h), minutes (min), seconds (s), milliseconds (ms), microseconds (us) and
nanoseconds (ns).
See also

Data types in the TIA Portal (Page/203)
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6.2.4.3 S5TIME
Keyword

S5TIME
Description

Value range

See also

Configuring CFC charts

Duration in S5 format

From Oh_Om_0s to 2h_46m_30s

From 0 to 9990 ms in steps of 10 ms

From 100 ms to 99900 ms in steps of 100 ms
From 1st0999 sin stepsof 1s

From 10 s t0 9990 s in steps of 10 s

Data types in the TIA Portal (Page|[203)
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6.2 Elementary data types

6.2.5 Point in time (Date and time)
6.2.5.1 DATE (Date)
Keyword
DATE
Description
Point in time

Date (YYYY-MM-DD), e.g. 2020-01-26

See also
Data types in the TIA Portal (Page/203)
6.2.5.2 TOD (Time of Day)
Keyword
TOD or TIME_OF_DAY
Description
Point in time
Time-of-day in hours:minutes:seconds.milliseconds (HH:MM:SS.MS), e.g. 15:21:00.321
See also

Data types in the TIA Portal (Page/203)
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6.2 Elementary data types

6.2.5.3 LTOD (Long Time of Day)

Keyword
LTOD or LTIME_OF_DAY

Description
Point in time
Number of nanoseconds since the start of day (0:00 hrs).
Time-of-day in hours:minutes:seconds.nanoseconds (HH:MM:SS.NS)
See also
Data types in the TIA Portal (Page|/203)
6.2.5.4 DT (Date and Time of Day)
Keyword
DT or DATE_AND_TIME
Description
Point in time
Information on date and time of day in BCD format (YYYY-MM-DD-HH:MM.SS.MS)
Value range
Min.: DT#1990-01-01-00:00:00.000
Max.: DT#2089-12-31-23:59:59.999
See also

Data types in the TIA Portal (Page|[203)
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6.2 Elementary data types

6.2.5.5 LDT (Long Date and Time)

Keyword
LDT or LDATE_AND_TIME

Description
Point in time
Information on date and time in nanoseconds since 01/01/1970 0:0.
DTL and LDT
The data types DTL and DTL provide the same information. The internal data format of these
two data types has been optimized for specific operations.
Adding and subtracting, for example, is very easy with LDT.
DTL is suitable for reading the date.
See also
Data types in the TIA Portal (Page/203)
6.2.5.6 DTL
Keyword
DTL
Description
Point in time
DTL and LDT
The data types DTL and LDT provide the same information. The internal data format of these
two data types has been optimized for specific operations.
Adding and subtracting, for example, is very easy with LDT.
DTL is suitable for reading the date.
See also

Data types in the TIA Portal (Page/203)
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6.2 Elementary data types

6.2.6 Characters
6.2.6.1 CHAR (Single-Byte Character)
Keyword
CHAR
Description

Single character

Value range

Depending on the selected Windows character set either "single byte" or "multibyte".

See also

Data types in the TIA Portal (Page[203)
6.2.6.2 WCHAR (Double-Byte Character)
Keyword

WCHAR
Description

Tag.

Single character.

Sequence of 16 bits.

Value range
$0000 - $D7FF

See also
Data types in the TIA Portal (Page[203)
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6.2 Elementary data types

6.2.7 Parameter types
6.2.7.1 TIMER
Keyword

TIMER
Description

Number of an S7 timer.

Value range

0 to 65535 (number depends on the target system).

Notes on use in the CFC chart

The data type is not supported in the chart interface.

See also
Data types in the TIA Portal (Page/203)
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6.2.7.2 COUNTER
Keyword

COUNTER
Description

Number of an S7 counter

Value range

0 to 65535 (number depends on the target system).

Notes on use in the CFC chart

The data type is not supported in the chart interface.

See also
Data types in the TIA Portal (Page|[203)
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6.3 Compound data types

6.3 Compound data types
6.3.1 STRUCT
Keyword
STRUCT
Description

A structure of data consisting of different elementary and complex data types.

Value range

The value ranges of the used data types apply.

See also
Data types in the TIA Portal (Page/203)
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6.3 Compound data types

6.3.2 STRING
Keyword

STRING
Description

String
Value range

Without additional information, the data type has a dimension of up to 254 characters.

To explicitly define a specific length, use the syntax STRING[N].

STRINGI[N]
Character string with a length of "N" bytes.
Depending on the selected Windows character set "single byte" or "multibyte" (at least N/2
characters).

See also

Data types in the TIA Portal (Page[203)
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6.3 Compound data types

6.3.3 ARRAY
Keyword

ARRAY
Description

Data structure consisting of a fixed number of components of the same data type.

All data types except ARRAY and reference data types are permitted for the components.
Not permitted data types:

* ARRAY

e Pointer: ANY, POINTER, VARIANT

e Parameter types: COUNTER, TIMER

Format

* ARRAY[Low limit..High limit] of <Data type>

Restrictions

Supported functions in CFC:

* Import of blocks containing parameters of the data type "ARRAY" with fixed dimension
limits

e Import of FBs with the element type "Array of FB":
ARRAYs of FB types are only allowed in the "Static" section of the block.

* Interconnections between same-type block interfaces of ARRAY tags

* Interconnections of ARRAY module connections with type-same parameters of global DBs

Unsupported functions in CFC:

* Import of blocks containing parameters of data type "ARRAY" with dynamic dimension
limits

e Import of FBs with element type "Array of FB" in other sections besides the "Static" section
of the block:

* Access to elements within ARRAY tags

* Online display of values in ARRAY tags

» Testing with the "Forcing" function
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Value range

See also

Configuring CFC charts

6.3 Compound data types

The specified value ranges are maximum values. The actual number of ARRAY elements that
can be used depends on the data type and the CPU used.

Blocks with standard access

e [-32768..32 767] of <DataType>

S7-1500 blocks with optimized access *)
e [-2147 483 648..2 147 483 647] of <DataType>
Maximum number of ARRAY elements in total:

- 16777 216 (=22%)

*) The internal storage structure is hidden for S7-1500 blocks with optimized access. The system automatically optimizes and manages the

addresses. More information: "Working with CFC charts for S7 > Blocks in CFC charts for S7"

Data types in the TIA Portal (Page[203)
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6.4 User-defined data types

6.4 User-defined data types

Overview

In addition to the elementary and complex data types, you can also use your own data types,
so-called "user-defined data types", in a TIA project. These data types are also referred to as
"User Defined Datatypes" (UDT).

A user-defined data type is an individually defined version of the STRUCT data type and is
stored with its own name (UDT name) in the project.

CFC interprets tags with a UDT name, such as block interfaces, as if these tags were combined
directly with a data structure of the STRUCT data type.

See also
STRUCT (Page 220)
Data types in the TIA Portal (Page/203)
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6.5 Pointer
6.5.1 VARIANT
Keyword

VARIANT
Description

A block input of the VARIANT data type can be interconnected with a source of any data type.

The block input can also be interconnected with a data block element of an ARRAY type.

Exception

Interconnections with a source of the data type ANY or POINTER are not supported in CFC.

Notes on use in the CFC

Blocks with output parameters of the VARIANT data type cannot be imported into CFC.

See also
Data types in the TIA Portal (Page[203)
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6.5 Pointer
6.5.2 POINTER
Keyword
POINTER
Description
Pointer to a memory area
Value range

Only as interconnection

Notes on use in the CFC

You can interconnect an input or output parameter of the data type POINTER with all data

types except POINTER and ANY.

The destination can also be an external tag.

See also

Data types in the TIA Portal (Page/203)
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6.5 Pointer

6.5.3 ANY
Keyword

ANY
Description

Pointer to a data element

Value range

Only as an interconnection with input or output parameter or external tag.

Notes on use in the CFC

You can interconnect an input or output parameter of the data type ANY with all data types
except POINTER and ANY.

The destination can also be an external tag.

See also
Data types in the TIA Portal (Page|203)
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6.6 System data types

6.6 System data types

System data types are not supported in CFC.

Hardware data types are made available by the CPU. The number of available hardware data

Some hardware data types are versions of elementary or complex data types.

CFC interprets tags with hardware data types, such as block interfaces, as if these tags were

See also

Data types in the TIA Portal (Page/203)
6.7 Hardware data types

Overview

types depends on the CPU.

an elementary or complex data type.
See also

Data types in the TIA Portal (Page/203)
228
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7.1 CFC charts for S7 target systems

This section includes specific descriptions for the S7 target system when working with CFC
charts.

Additional information in the TIA Portal Information System
* Information about supported systems and overview of supported CPUs:
"Readme > STEP 7 > STEP 7 CFC > System requirements for SIMATIC STEP 7 CFC (Page| 13)"
¢ Licensing information:
"Readme > STEP 7 > STEP 7 CFC > Licensing for SIMATIC STEP 7 CFC (Page| 15)"
¢ Generally valid information for configuring CFC charts:

"Configuring technologically > Configuring CFC charts (Page 61)"
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7.2 Blocks in CFC charts for S7

7.2 Blocks in CFC charts for S7

Additional S7 blocks

In addition to the function blocks (FB), functions (FC) and instructions, S7 target systems
contain additional block types, e.g.:

» Organization blocks (OB) for structuring the program execution

OBs are created during compiling for tasks that are assigned to the CFC charts. The
properties of these OBs can be changed to a limited extent.

» Data blocks (DB) for data storage
Global data blocks (DB) are used for storing data that can be used by any block.
¢ Multi-instance blocks

A function block does not store its data in an instance data block of its own, but rather in
the instance of another function block.

When you import or copy a multi-instance block, all blocks called by the multi-instance
block are copied as well.

More information in the information system of TIA Portal under "Programming a PLC >
Programming basics":

"Block calls > Instances > Multi-instances"

"Using and addressing operands > Addressing operands > Addressing variables in data
blocks > Addressing instance data"

S7 blocks in CFC
¢ Data blocks and organization blocks are not inserted or processed in CFC.

* You can interconnect the structure elements of global data blocks with the parameters of
function blocks, functions and CFC charts.

¢ Typed blocks are not supported in CFC.
Typed blocks are block templates from libraries located in the "Types" folder.

To use a typed block, remove the type assignment after inserting it into the project.

Length of block names
The name of instance data blocks may be a maximum of 125 characters in total.

The instance name consists of the name of the CFC chart in which the instance is located, the
name of the type and the instance number:

* <CFC chart>/<Block name_Instance number>

For hierarchical charts, the instance name contains the entire path of the subcharts:
* <Basic chart>/<Subchart 1>/<Subchart 2>/<Block name_Instance number>
Example with 3 hierarchy levels:

e CFC_2/CFC_2 1/CFC_2_ 1 1/MyFB 1

Configuring CFC charts
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7.2 Blocks in CFC charts for S7

Therefore, use short block names.

If necessary, change the block names in STEP 7 before inserting the first instance in an
hierarchical CFC chart.

User-defined attributes

When you select a block parameter, the inspector window shows the properties of the tag in
the "General" and "Attributes” areas.

CFC also uses the following attributes in addition to the standard attributes:

CFC_Configurable Configurable
CFC_EnableTagReadback Tag readback
CFC_EngineeringUnit Assigned engineering unit
CFC_EnumerationTexts No function in CFC

CFC_ForTest Registered for the CFC test mode.
CFC_HighLimit High limit

CFC_Interconnectable Interconnectable

CFC_LowLimit Low limit

CFC Visible Visible

S7-1500 blocks: Access modes

Configuring CFC charts

CFC charts support blocks with optimized access and standard access.
New blocks and functions are created as data blocks with optimized access.

Blocks that you have imported from a different system, such as an S7-400, may have
standard access.

You can change the access mode in the block type properties under "General > Attributes".

A cruton

Changing can result in full download

Changing the block access has effects on the internal memory structure.

In most cases, this means you will have to recompile and load the program after block
access has been changed.

Loading of the entire software with the S7 target system requires a CPU stop.
Effects of the type change

Changing the access type corresponds to a type change. Therefore, you must take into
account the effects on the updated instances.

More information: "Central change of a block type (Page 115)"
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7.2 Blocks in CFC charts for S7

Note
Performance: Avoid mixing the access types

You can combine blocks with optimized access and blocks with standard access in a CFC
chart.

When you interconnect both types in a CFC chart, the necessary conversions will reduce the
performance.

To improve the performance of a CFC chart, interconnect only blocks and parameters with
the same type of access and retentivity setting.

Data blocks with optimized access
¢ The internal storage structure is hidden for data blocks with optimized access.
The variable declaration contains only the symbolic names of the data elements.
¢ The system automatically optimizes and manages the addresses.
Access errors, for example, from SIMATIC HMI, are prevented.
* You can determine the retentivity behavior of individual parameters.
— Retentive
— Non-retentive
— SetinIDB:
The retentivity can be set in the instance data block.

The setting in the instance data block is then valid for all parameters with the setting
"Setin IDB".

This setting affects the performance because a non-optimized storage is used
internally. Interconnections to parameters with the setting "Retentive" or "Non-
retentive" require conversions.

For structured data types, the retentivity setting always applies to the entire structure.

* The optimized access improves the performance of the CPU.

Data blocks with standard access

* The storage structure of the elements in the data block is transparent, for example, offset
and storage length can be displayed.

e The data elements can be addressed via a symbolic name as well as via a fixed address
within the block.

* The retentivity setting is valid for all tags of the data block.
* The data blocks are compatible with S7-300/400 controllers.
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7.2 Blocks in CFC charts for S7

More information
Information system of the TIA Portal:
¢ "Programming a PLC":

"Programming basics > Blocks in the user program > Blocks with optimized access >
Basics of block access"

"Creating and managing blocks > Specifying block properties > Overview of block
properties"

"Declaring the block interface > Rules for declaring the block interface > Setting the
retentivity of local tags"

"Programming data blocks > Properties of the tags in data blocks"

See also
Instructions and blocks (Page|25)

Updating instances of a changed block type (Page 119)
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7.3 Reserved number ranges for user blocks in CFC

7.3 Reserved number ranges for user blocks in CFC

The reserved number ranges for user blocks are set when new project is created. The
reserved number ranges are displayed in the basic settings for CFC charts.

This setting applies to all target systems that are newly added to the project after the
reserved number ranges have been configured.

S$7-1500 number ranges
The number ranges for data blocks and functions are specified automatically.
The following numbers are available for user blocks:
* 0-19999
CFC uses numbers = 20000.

See also

Basic settings for CFC charts (Page 41)
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7.4 "Chart sequence & extras" editor for S7

Target system S7: Tab

The tabs in the "Chart sequence and extras" editor are shown depending on the target
system.

The S7 target system contains the following tabs:
¢ Chart sequence

¢ Task assignment

* Target system settings

* Textual interconnections

¢ Block types

* Block instances

e Statistics

"Chart sequence” tab

In "Chart sequence”, you specify the run sequence of all CFC charts of a target system with
drag-and-drop.

You can change the task assignment of individual instructions/blocks or assign additional
tasks.

In the "Chart sequence" you also select charts for automatic optimization of the run sequence
and set the properties for timing of the charts.

Additional information: "Adapting the run sequence (Page|161)"

"Task assignment" tab

The "Task assignment" tab lists the configured tasks and the instructions/blocks executed in
them.

This view shows the actual sequence for processing of the CFC charts and blocks/instructions
in the device.

The "Task assignment" serves only to provide information.
¢ To change the task assignment of charts, select the "Chart sequence" tab.
Additional information: "Adapting the run sequence (Page 161)"

* To change the task assignment of instructions/blocks, display the CFC chart in the "Control
flow".

Additional information: "Adapting the run sequence within the CFC chart (Page|166)"
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7.4 "Chart sequence & extras" editor for S7

"Textual interconnections" tab
For each CFC chart the "open" textual interconnections are displayed in a table.
You can close or delete the textual interconnections in the table.

Additional information: "Textual interconnections in the "Chart sequence & extras" editor
(Page 159)"

"Target system settings" tab
¢ The tab contains the task assignment for the chart folders of the target system.
New CFC charts are created with this task assignment.
¢ The reserved number ranges for user blocks are displayed.

Additional information on the task assignment: "Runtime model (Page|161)"

"Block types" tab
The tab is only used for comparing and updating blocks.
The blocks in the "Program blocks" folder and the blocks imported in CFC are displayed.
Specific data are shown for each block, e.g. the version.

There is a version comparison for the blocks imported in CFC with the result represented in a
symbol. This shows existing differences and indicates if there is a need for an update.

Additional information for updating an imported block type: "Importing blocks in CFC with S7
target system (Page 237)"

"Block instances" tab
All block types with their associated instances are displayed in a table.
You can open the associated CFC chart via an instance entry.

Additional information: "Searching for and managing block instances in CFC (Page 246)"

"Statistics" tab

In the "Statistics" area, you can see the number of CFC instance DBs used for the respective
PLC.

See also
"Chart sequence & extras" Editor (Page 47)
Basic settings for CFC charts (Page 41)
SIMATIC STEP 7 CFC licensing (Page 15)
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7.5 Importing blocks in CFC with S7 target system

Blocks from the "Program blocks" folder of an S7 target system can be inserted into a CFC
chart and be used several times.

During insertion, this S7 block is imported into CFC and defined as type.
You create an instance of this type by inserting a type into a CFC chart.

If the S7 block used in CFC is changed, the instances of this type can be updated in all CFC
charts of a target system.

Note
Length of block names
Check the block names before importing into CFC.

The name of instance data blocks may be a maximum of 125 characters in total.

¢ The instance name consists of the name of the CFC chart in which the instance is located,
the name of the type and the instance number.

* For hierarchical charts, the instance name contains the entire path of the subcharts.

If necessary, change long block names in STEP 7 before importing into CFC.

Import and revision comparison

"Chart sequence & extras" Editor

The "Block types" tab in the "Chart sequence & extras" Editor displays the versions of the
blocks in the "Program blocks" folder and the blocks imported in CFC.

This shows existing differences and indicates if there is a need for an update. If necessary,
one or more blocks can be updated or imported for the first time.

Additional information: "Comparison and updating of imported blocks in CFC (Page|241)"

"Update blocks" dialog

The blocks to be updated and the existing differences are displayed in the "Update blocks"
dialog.

If differences exist, the dialog box opens automatically:
¢ During the updating of the blocks imported into CFC

¢ During the initial import, for example, when copying a CFC chart from a different S7 target
system

The import process can be continued or cancelled in this dialog box.
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7.5 Importing blocks in CFC with S7 target system

Example: Copying CFC charts and importing blocks

238

The S7 blocks that are to be used in a CFC chart do not have to be configured in the same
target system as the CFC chart.

You can also import S7 blocks from other S7 systems of the project.

The following figure shows an example with the S7 systems "PLC1" and "PLC2" and the
possible copy and import paths for blocks and CFC charts.

CFC100

CFC100 CFC200

FB11

[
[
(? : FB11
[
[

CALL
FC11

E—| 1 osor
(4)— | OBxx

FB11+FC11 I FBxx

In the figure, the following actions are executed with the blocks "FB11" and "FB21":

Action

Note

(1

In "PLC1", the "FB11" block is copied from the "Program blocks" folder to the CFC chart
"CFC100".

"FB11" is thus imported as type in CFC of the "PLC1".

"FB11" contains a call for "FC11". However, the function "FC11" is not imported as
type in CFC.

(2)

CFC chart "CFC100" with the block "FB11" is copied from "PLC1" to "PLC2".
"FB11" is imported as type in CFC of the "PLC2".
Action "4" is automatically executed as well.

3)

Alternatively to action "(1)" and "(2)", it is also possible to import the block "FB11"
from the "Program blocks" folder of "PLC1" to the CFC chart "CFC100" in "PLC2".

"FB11" is imported as type in CFC of the "PLC2".
"FC11"is also copied, because it is called by "FB11".
Action "4" is automatically executed as well.

4)

For action "(2)" or "(3)", "FB11" and "FC11" are copied to the "Program blocks" folder of
"PLC2".

"FB11" contains a call for "FC11". However, the function "FC11" is not imported as
type in CFC of "PLC2".

(5)

From "PLC2", the "FB21" block is copied from the "Program blocks" folder to the CFC
chart "CFC200".

"FB21" is thus imported as type in CFC of the "PLC2".
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Overview

7.5 Importing blocks in CFC with S7 target system

The following table describes possible scenarios that can occur when copying CFC charts or

importing of S7 blocks in CFC.

Scenario

Reaction

Block does not exist in the target
system.

CFC chart is copied.

Blocks, including all called blocks, are transferred from the
source system to the target system.

In the process the blocks are first copied to the "Program
blocks" folder and then imported into CFC.

Block in the target system is completely
identical.

CFC chart is copied.

Blocks in the source system and target
system are different.

CFC chart is not copied if the blocks in the source and target
have differences that require a CPU stop during loading.

A CPU stop is required for structural changes in the block
interface, for example, change of data type or default value,
number of parameters.

Note to the user, indicating what the conflict is.

Block exists in the target system,
different numbers

CFC chart is copied. The copied CFC chart is adapted to the
target system.

Block is not copied. The block number and the block in the
target remain unchanged.

Type update in CFC:

1. Message to the user that only download of the entire
software is possible in CPU STOP.

2. "Update blocks" dialog:
Display of the blocks to be updated and the differences.

User decision on type update.

3. During type update, the existing type receives the new
number.

Block exists in the target system,
different name

CFC chart is not copied.
Type update in CFC:

1. Message to user indicating that names are different
2. "Update blocks" dialog:

Display of the blocks to be updated and the differences.

User decision on type update.
3. During type update, the block type in CFC receives the
new name.

Downloading of the changed software without CPU
STOP is possible if only the name has been changed.

Block in the target system is completely
identical: Block instance has been
deleted.

Change was not correctly transferred
via full download or 2 x downloads of
changes.

CFC chart is copied.
However, downloading results in an error due to a name
conflict.

Ensure that a full download or two downloads of changes
are always performed after deletion of instances.
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Scenario

Reaction

The task of the CFC chart to be copied
does not exist in the target system.

CFC chart is copied.
The assignment of the CFC chart to the task is retained.

A non-existent task is created during the next compilation of
the software, if the target system supports this task.

Task of the copied chart is different in
source and target system.

CFC chart is copied.
The assignment of the CFC chart to the task is retained.

See also

Updating block types imported in CFC (Page 243)

Searching for and managing block instances in CFC (Page|246)

"Chart sequence & extras" editor for S7 (Page 235)

240
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7.6 Comparison and updating of imported blocks in CFC

Chart sequence and extras: "Block types" tab

The blocks in the "Program blocks" folder and the blocks imported into CFC are shown in the
"Block types" tab of the "Chart sequence and extras" editor.

Specific data on each block is displayed.

The blocks imported into CFC are compared; the result of this comparison is represented by a
symbol. This shows existing differences and indicates if there is a need for an update.

The functions in the "Block types" tab are specific to the S7 target system.

More information on updating the block types: "Updating block types imported in CFC
(Page 243)"

Overview: Tables
The name, type and block version, among other things, is displayed for each block.
Additional properties of the selected block are displayed in the Inspector window.
You change the orders of columns in the table by dragging a column header with the mouse.
You change the column width by dragging the mouse or have the shortcut menu optimized
automatically.
"Blocks in the Program blocks folder"

The table contains a list of blocks that you can import into the CFC.

"Block types imported in CFC"
The table contains a list of blocks that were imported as block instances into the CFC.

It also lists blocks whose instances were later deleted in the charts. These unused blocks are
identified with their own status symbol.

The status symbol in the "Difference" column displays the result of the comparison between
the block type in the "Program blocks" folder and the version imported into the CFC.

Information on the comparison status is displayed as a tooltip at the symbol and in the
Inspector window.
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Overview: Buttons

"Importing block(s)"

This button is used to import the blocks selected in the "Blocks in "Program blocks" folder"
table into CFC.

The button is activated if at least one block is selected in the table.

If a conflict occurs during the import, a dialog shows more information on the cause, e.g.
differences between the blocks.

If the operation is canceled, any changes made are discarded.

"Delete unused blocks"
This button deletes blocks that were imported into the CFC but no longer in use.
The button is enabled if the table contains at least one unused block.

Unused blocks can be identified by their status symbol in the "Differences" column.

"Update block(s)"

This button is used to import the blocks selected in the table "Block types imported in CFC"
into the CFC again. The types and their instances are updated when this button is pressed.

The button is activated if at least one block is selected in the table.

After the start of the operation a dialog displays more information about the differences of
the blocks.

If the operation is canceled, any changes made are discarded.

See also
Importing blocks in CFC with S7 target system (Page 237)

Searching for and managing block instances in CFC (Page|246)
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7.7 Updating block types imported in CFC
Blocks added in the CFC represent an instance of a type.

The type exists, for example, in a library or the "Program blocks" folder of the project tree.

"Chart sequence & extras" editor

You can compare and update blocks that were imported from the "Program blocks" folder into
CFCin the "Chart sequence & extras" editor.

The blocks in the "Program blocks" folder and the blocks imported into CFC are displayed in
the "Block types" tab.

The blocks imported into CFC are compared; the result of this comparison is represented by a
symbol. This shows existing differences and indicates if there is a need for an update.

Note

Libraries not included

The comparison and import of blocks is only available for block types that were imported
from the "Program blocks" folder in the project tree.

Abort update

If the update operation is canceled or an error occurs, any changes made are discarded.
Undoing an update

You can use the "Undo" button on the toolbar to undo all changes after a successful update
operation.

User-defined PLC data types (UDT)

When the block instances of PLC data types are updated, the interconnections are
automatically also updated. It is no longer necessary to manually adapt the interconnections
at the instances.

Requirement:
* All changed blocks that are currently interconnected are updated at the same time.

If you update only some of the instances or some of the changed blocks, the
interconnections to the non-updated block instances are lost.

The removed interconnections are listed in the Inspector window "Info" under "General".

Adapt these interconnections afterward.
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Block types imported in CFC

Procedure

244

The "Differences" column displays the status of the block in comparison with the block types.

Icon Meaning

J

There are no differences between the compared blocks.
No action required.

No instances of this imported block are currently used in the CFC.
Existing differences have no effect in the CFC.

o There are differences between the compared blocks.

The differences are displayed in the Inspector window in the "Properties >
Differences" tab.

0 The block type of the imported block was not found in the block folder.
Other status Status information is displayed in the "Properties” tab of the Inspector
Example: =LIII window.

Example: The block is not compiled.

. Double-click on "Chart sequence & extras" in the project tree.

The editor opens.

. Switch to the "Block types" tab.

The following information is displayed in the table:
— Blocks in the "Program blocks" folder
— Blocks imported into CFC

— Status of the comparison

. In the table "Block types imported in CFC" check the status symbols in the column

"Differences".

The symbol indicates whether there are differences between the blocks in the "Program
blocks" folder and the version imported into CFC.

If you point on a status symbol with the mouse, then a tooltip is displayed and provides an
explanation.

. To import one or more blocks again and thus update the type in CFC, select the

corresponding blocks in the table "Block types imported in CFC".

. Click "Update block(s)".

The "Update blocks" dialog opens.

The differences between the versions in the "Program blocks" folder and in CFC are
displayed.

. Click "OK".

The selected blocks are imported into CFC.

The instances are updated.
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Result
The blocks imported in CFC are updated.

The Inspector window contains information on the update where appropriate.

See also
Comparison and updating of imported blocks in CFC (Page|241)
Updating instances of a changed block type (Page/119)
Central change of a block type (Page|115)
Searching for and managing block instances in CFC (Page|246)

Importing blocks in CFC with S7 target system (Page 237)
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7.8

Searching for and managing block instances in CFC

When using types and instances of blocks, it may be necessary to get an overview of all block
types and their instances in the project.

This overview offers the "Block instances" tab in the "Chart sequence & extras" editor.

"Block instances" table

Procedure

246

All block types and instances are displayed in the "Block typelinstance" column.
The instances are displayed as lower-level objects below the associated types.

You can find and replace strings with the "Find and Replace" function.

Toolbar

The toolbar includes symbols for showing/hiding the lower-level elements/instances.
The symbols for jumping to the "Data flow" or "Control flow" are activated for a selected
instance.

Instance path

The "Path to instance” column displays the path to the instance in the "<Chart>\<Instance
name>" format.

Double-click the path to open the associated CFC and select the type instance.

Formatting table

You can turn the sorting of the table on/off or change it by clicking the respective table
column.

Use drag-and-drop to move the selected column header and change the order of the
columns.

1. Double-click on "Chart sequence & extras" in the project tree.
The editor opens.

2. Switch to the "Block instances" tab.

3. Select the "Search and replace" pane in the "Tasks" task card.
— Search: Search for a text in all fields of the table.

If the text searched for can be edited at the location of use, the found text is selected
for editing.

— Replace: You can replace texts in the instance name and comment of the instance.
4. Select a type or an instance in the table.

The corresponding configuration data are displayed in the Inspector window.

— You can change the configuration of an instance.

— Data cannot be edited for a type.

Configuring CFC charts
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Result
All block types and their instances in the project are displayed.
When selecting the table entry of an instance, you can jump to the location of use in the CFC
or even change the configuration data.

See also

Updating block types imported in CFC (Page 243)

Comparison and updating of imported blocks in CFC (Page|241)
Importing blocks in CFC with S7 target system (Page|237)
"Chart sequence & extras" editor for S7 (Page 235)
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7.9 Comparison status of CFC charts

7.9 Comparison status of CFC charts

Online/offline project status

The status of the CFCs in the project and of the downloaded charts in the S7 target device are
compared automatically and displayed in the project tree.

Each CFCin the "Charts" folder is identified with a corresponding status icon.

The status display provides an overview of potential changes in the project and whether it is
necessary to download data to the device.

Icon Meaning

i The CFC exists in the project, but not in the device.

i The basic chart exists in the project, but not in the device.

oy The CFCis identical in the project and in the device.

K The basic chart is identical in the project and in the device.

I The CFC was modified in the project and exists in a different version in the device.
. The basic chart was modified in the project and exists in a different version in the
- device.

= The basic chart is identical in the project and in the device, but a subchart was

e modified.

See also

Overview: Compiling and downloading CFC charts (Page 249)
Hierarchical CFC charts (Page 29)
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7.10 Compiling CFC charts and downloading them for the S7 target system

7.10 Compiling CFC charts and downloading them for the S7 target
system

7.10.1 Overview: Compiling and downloading CFC charts

Overview

Configuring CFC charts

You will have to compile the configured CFC charts for testing or application and download
them to the respective device, such as the CPU of the S7 target system.

You have the following options:

Downloading and testing during operation

Downloading and testing is not critical to safety and may be carried out on the device in the
real system.

This procedure is described below.

Simulation with a test CPU

For security reasons, downloading and testing may not be carried out on a device of the real
system.

In this case, you can run a complete download to a so-called test CPU.

This test CPU may be a different device of the real system, or the "S7-PLCSIM" simulation
software.

Additional information: "Downloading CFC charts to a test CPU (Page|256)"
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7.10 Compiling CFC charts and downloading them for the S7 target system

Basic procedure

The following steps are always performed when you compile and download the CFC charts to
a device:

1. Compiling all charts

This step is necessary if there are no CFC charts in the device or if they have not been
compiled yet.

Additional information: "Compiling CFC charts (Page 251)"
2. Downloading all charts
This step is necessary if there are no CFC charts in the device of the target system.

Additional information: "Downloading all CFC charts (Page 252)"

Further processing of CFC charts

When you change individual CFC charts after these steps, you must execute the following
steps:

1. Compilation of modified charts
Use the compilation of changes to only compile changed CFC charts.
It is necessary that all CFC charts have been compiled once before for this device.
Additional information: "Compiling CFC charts (Page 251)"

2. Downloading modified charts

To download modified CFC charts to the device of the target system, download only the
changes.

It is necessary that all CFC charts have been compiled and downloaded once before for
this device.

Additional information: "Downloading modified CFC charts (Page 254)"
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7.10.2

Requirement

Procedure

Result

See also

Configuring CFC charts

7.10 Compiling CFC charts and downloading them for the S7 target system

Compiling CFC charts

You can decide whether you want to compile all charts or only modified charts.

You must compile all charts if no CFCs have been compiled in the device yet.

A cruton

Interface change can result in full download

After interface changes at the block type and subsequent update of the block type in the
target system, you will often only be able to compile and load the entire software.

An interface change is, for example, the change of a default value.

Loading of the entire software with the S7 target system requires a CPU stop.

* The project tree is open.

¢ The CFCs belong to a specified CPU.

1. Select the "Charts" folder in the project tree.
2. Select the scope of the compilation:

— Select the "Compile > Software (rebuild all blocks)" command in the shortcut menu, if
no CFCs have been compiled before.

— If you want to compile only the changes since the last compilation, select the "Compile
> Software" command in the shortcut menu.

The compilation process starts, and the current status is displayed.

The user program for the target system is created from the CFCs.
The project can be downloaded to the device.

The messages regarding the compilation process are displayed in the Inspector window
under "Info > Compile".

Downloading all CFC charts (Page 252)
Downloading modified CFC charts (Page 254)
Downloading CFC charts to a test CPU (Page|256)
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7.10 Compiling CFC charts and downloading them for the S7 target system

7.10.3

Requirement

Procedure

252

Downloading all CFC charts

You will have to download all CFCs if there have never been any CFCs downloaded to the
device.

A warninG

Execution during plant runtime

Performing the described actions during plant runtime may cause serious injury or material
damage in the event of malfunctions or program errors.

Make sure that no dangerous situations can arise before you start the actions.

* The CFCs of the device have been compiled.

1. Select the folder of the device or the "Charts" folder in the project tree.
2. In the "Online" menu, select the "Download to device" command.

You can also select the "Software (all blocks)" command in the "Download to device" menu
in the shortcut menu of the "Charts" folder.

— If you have not already established an online connection, the "Extended download to
device" dialog opens.

— If you have already specified an online connection, the "Load preview" dialog opens.
Continue then with step 6.

3. Select the type of interface for your programming device/PC from the "PG/PC interface type"
drop-down list in the "Extended download to device" dialog.

4. Select the interface of your programming device/PC from the "PG/PC interface" drop-down
list.

— If available, select a subnet from the "Connection to subnet" drop-down list that you
can use to link the devices to the PG/PC interface.

If the devices are connected directly to the PG/PC interface, select the "Local" setting.

— If the required devices are accessible via a gateway, select the gateway that connects
the two subnets involved in the "1st gateway" drop-down list.

5. Select your device in the "Accessible devices in target subnet” table and confirm your
selection with "Load".

If necessary, the project data is compiled.

The "Load preview" dialog opens. This dialog displays messages and recommends actions
necessary for loading.

Configuring CFC charts
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Result

See also

Configuring CFC charts

7.10 Compiling CFC charts and downloading them for the S7 target system

6. Check the messages in the "Load preview" dialog, and select the actions in the "Action"

column, if necessary.

As soon as downloading becomes possible, the "Load" button is enabled.

AWARNING

Execution during plant runtime

Performing the described actions during plant runtime may cause serious injury or
material damage in the event of malfunctions or program errors.

Make sure that no dangerous situations can arise before you start the actions.

. Click on "Load".

The blocks are downloaded and the "Load results" dialog opens.

This dialog shows you the status and the actions after downloading.

. If you want to start the modules again directly after downloading, select the "Start all" check

box.

. To close the "Load results" dialog box, click "Finish".

The compiled CFCs have been loaded to the device.

The result of the process is displayed in the Inspector window under "Info > General".

If the changes affect additional blocks in the user program, these blocks are compiled and
also loaded to the device.

Blocks that only exist in the device online are deleted.

Inconsistencies between the blocks in the user program are avoided by downloading all
blocks affected and deleting the unnecessary blocks in the device.

Compiling CFC charts (Page 251)
Downloading modified CFC charts (Page 254)
Downloading CFC charts to a test CPU (Page|256)
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7.10 Compiling CFC charts and downloading them for the S7 target system

7.10.4

Requirement

Procedure

254

Downloading modified CFC charts

If you have modified and compiled individual CFC charts after the last download, you will
have to download them to the device.

A warninG

Execution during plant runtime

Performing the described actions during plant runtime may cause serious injury or material
damage in the event of malfunctions or program errors.

Make sure that no dangerous situations can arise before you start the actions.

* The modified CFC charts have been compiled.

* Al CFC charts of this device have been compiled and downloaded before.

1. Select the "Charts" folder in the project tree.

2. Select the "Download to device > Software (changes only)" command from the shortcut
menu.

— If you have not already established an online connection, the "Extended download to
device" dialog opens.

— If you have already specified an online connection, the "Download preview" dialog
opens.

Continue then with step 6.
You can also open the "Extended download to device" dialog via the "Online" menu.

3. Select the type of interface for your programming device/PC from the "PG/PC interface type"
drop-down list in the "Extended download to device" dialog.

4. Select the interface of your programming device/PC from the "PG/PC interface" drop-down
list.

— If available, select a subnet from the "Connection to subnet" drop-down list that you
can use to link the devices to the PG/PC interface.

If the devices are connected directly to the PG/PC interface, select the "Local" setting.

— If the required devices are accessible via a gateway, select the gateway that connects
the two subnets involved in the "1st gateway" drop-down list.

5. Select your device in the "Accessible devices in target subnet” table and confirm your
selection with "Load".

If necessary, the project data is compiled.

The "Load preview" dialog opens. This dialog displays messages and recommends actions
necessary for loading.

Configuring CFC charts
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Result

See also

Configuring CFC charts

7.10 Compiling CFC charts and downloading them for the S7 target system

6. Check the messages and, where necessary, enable the actions in the "Action" column.

As soon as downloading becomes possible, the "Load" button is enabled.

AWARNING

Execution during plant runtime

Performing the described actions during plant runtime may cause serious injury or
material damage in the event of malfunctions or program errors.

Make sure that no dangerous situations can arise before you start the actions.

. Click on "Load".

The blocks are downloaded and the "Load results" dialog opens.

This dialog shows you the status and the actions after downloading.

. You may have to restart the modules after loading.

To do this, select the "Start all" check box.

. To close the "Load results" dialog box, click "Finish".

The modified and compiled CFC charts have been downloaded to the device.

The result of the process is displayed in the Inspector window under "Info > General".

If the changes affect additional blocks in the user program, these blocks are compiled and
also loaded to the device.

Blocks that only exist in the device online are deleted.

Inconsistencies between the blocks in the user program are avoided by downloading all
blocks affected and deleting the unnecessary blocks in the device.

Compiling CFC charts (Page 251)
Downloading all CFC charts (Page 252)
Downloading CFC charts to a test CPU (Page|256)
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7.10 Compiling CFC charts and downloading them for the S7 target system

7.10.5

Overview

256

Downloading CFC charts to a test CPU

If the CFC charts need to be tested but this is not permitted on a real system device for safety
reasons, you can download the data to a so-called test CPU.

This test CPU may be a different device of the real system, or the "S7-PLCSIM Advanced"
simulation software.

Once you performed the test with the "Download to test CPU" function, you only need to
compile and download the delta data to update the program in the device of the real system
because no loadable states are changed during testing on the test CPU.

Note
Adapting the interface after the test

Running this function using the "Download to test CPU" menu command reliably prevents
unintentional download of the software to the device in the real system.

You need to restore the interface to this device in the "Extended download to device" dialog
on completion of the test to enable a reload of the data to the device.

Configuring CFC charts
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7.10 Compiling CFC charts and downloading them for the S7 target system

Procedure
1. Select the device folder in the project tree.
2. Select the "Download to device > Download to test CPU (HW + SW)" command from the
shortcut menu.
The "Extended download to device" dialog opens.
3. Select the type of interface for your programming device/PC from the "PGIPC interface type"
drop-down list in the "Extended download to device" dialog.
4. Select the interface of your programming device/PC from the "PG/PC interface" drop-down
list.
Select "PLCSIM Vx.x", for example, if you want to use "S7-PLCSIM" to simulate the test CPU.
— If available, select a subnet from the "Connection to subnet" drop-down list that you
can use to link the devices to the PG/PC interface.
If the devices are connected directly to the PG/PC interface, select the "Local" setting.
— If the required devices are accessible via a gateway, select the gateway that connects
the two subnets involved in the "1st gateway" drop-down list.
5. Select your test device from the "Accessible devices in target subnet" table.
6. Click the "Load" button.
If necessary, the project data is compiled.
The "Load preview" dialog opens.
This dialog displays messages and recommends actions necessary for loading.
7. Click the "Load" button.
The complete software and hardware configuration are downloaded and the "Load
results” dialog opens.
This dialog shows you the status and the actions after downloading.
8. If you want to start the modules again directly after downloading, select the "Start all" check
box.
9. To close the "Load results" dialog box, click "Finish".
Result
The CFC charts, the complete software, and the hardware configuration have been
downloaded to the test CPU.
You need to restore the interface to this device in the "Extended download to device" dialog
on completion of the test to enable a reload of the data to the device.
See also

Compiling CFC charts (Page 251)
Downloading all CFC charts (Page 252)
Downloading modified CFC charts (Page 254)
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7.11 Testing CFC charts in the S7 system

7.11 Testing CFC charts in the S7 system

After configuration of the instructions and blocks in the CFCs, you can test the function of the
CFCs.

Values from the device are displayed at the input and output parameters for this.

The following section explains the test procedure with an S7 system.

Basic procedure
You always need to perform the following steps to test CFCs:
1. Start by selecting the input and output parameters for the test.

2. Then you start the actual test in which values from the device are displayed at the input and
output parameters.

Note
Conditions

The following conditions apply to the test:

¢ The input and output parameters only receive the latest values for testing at the following
conditions:

— The parameters have been selected for the test.
— The parameters are available in the visible part of the CFC within the work area.

* Input parameters of instructions and, for example, of "FC" functions in S7 can only display
values from the device if they are interconnected.

Although they can be selected in the table of parameters for testing, no values are
displayed for existing online connections.

This does not apply to output parameters, function block parameters, and other blocks
created by users.

STRUCT data type

If you select a parameter of the STRUCT data type for testing, the value of the first structure
element of the configured structure is displayed.

"Testing" task card
In the "Testing" task card, you configure the test settings.

For the S7 target system, you can register/deregister individual input and output parameters
for testing and edit the update times, among other things, in the task card.

The current operating state of the CPU is displayed and can also be controlled in the "CPU
operator panel” tab.

Configuring CFC charts
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Requirement

Procedure

Configuring CFC charts

7.11 Testing CFC charts in the S7 system

The online connection to the device has been established once before.
Rules for the device containing the CFCs to be tested:

— The corresponding software must be compiled and loaded.

— The CPU of this device must be in "RUN" operating mode.

The required CFC is configured and open.

"Data flow" is shown in the work area.

. Click in the CFC, or select an instruction, or a block.

. Click "Go online" in the toolbar.

Once you are online, all input and output parameters selected for testing are provided
with the current values from the device and are highlighted in color.

. Check the CPU operating mode if no online values are displayed.

To do this, switch to the "Testing" task card, "CPU operator panel".
The "RUN" state should be active. If not, change the operating mode to "RUN".

. If necessary, you can register or deregister a selected input or output parameter in the

"Testing" task card for testing.
You do not have to open the Inspector window for this purpose.

You can also select additional parameters for testing at "Parameters" in the Inspector
window, or remove parameters already tested from the test.

Additional information: "Configuring and adapting CFCs > Test CFC > Selecting parameters
for testing (Page|171)"

. If necessary, adapt the settings of the update times in the "Testing" task card:

— For updating the visible area of the CFC in which the values are updated.
— For the selected parameters or the interconnection
— For the dynamic display with the mouse pointer

See additional information below.
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7.11 Testing CFC charts in the S7 system

Alternative procedure

Result

See also

260

You can also use the following options in the "Data flow" online mode to show values from
the device:

Value as tooltip:

If you point to the input or output parameter with the mouse pointer, then the latest
value from the device is shown as tooltip.

Use the shortcut menu command "For test" to display the value.
Value with data type STRUCT:

The structure with all structure elements appears as a tooltip when you move the mouse
pointer over a parameter of STRUCT data type.

Display value permanently:

If you have not selected the input or output parameter for testing, then you can keep the
<Ctrl> key pressed and click on an input or output parameter or an interconnection with
the mouse pointer.

The parameter is permanently selected for the test and the latest value from the device is
displayed.

Repeat this step to revert this function and no longer display the value.

All input and output parameters in the visible work area that have been selected for testing
are supplied with the latest values from the device.

This enables you to test the function of the instructions and blocks.

Downloading CFC charts to a test CPU (Page|256)
Testing a CFC chart (Page 173)

Testing with the "Forcing" function (Page|178)

Overview: Compiling and downloading CFC charts (Page 249)
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7.12 Reading back parameter changes in CFC

During commissioning or when testing a CFC, you can make and test different parameter
changes on the device in online mode.

Once you have successfully tested these changes, you can read back the changed parameters
to the offline program.

Reading back conditions

Reading back is only possible if the offline configuration of the program corresponds to the
status of the online program in the device.

When you change a block type, for example, reading back is no longer possible.

Reading back of parameters is possible to the following extent:

Parameter Reading back

Input parameter ("Input”, "InOut") Yes

Output parameter ("Output”) No

Parameter with the attribute No

“Configurable = FALSE" The parameter must have the BOOL value "TRUE".
Parameters of basic instructions No

Parameters of "FC" blocks No

Chart 1/0s No

Supported data types

The following data types can be read back:

Binary numbers BOOL, BYTE, WORD, DWORD, LWORD
Integers SINT, INT, DINT, LINT, USINT, UDINT, ULINT
Floating-point numbers REAL, LREAL

Times TIME, LTIME, S5TIME

Date and time DATE, TOD, LTOD, DT, LDT, DTL

Strings CHAR, WCHAR, STRING

Parameter types TIMER, COUNTER

Data structures STRUCT
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7.12 Reading back parameter changes in CFC

Control reading back using attributes

Reading back is controlled using attributes at the block type and at the block instance.

Object Properties: Meaning
"General" tab
Block type Block header " | "Attributes > User-defined Enabled:
attributes™: . . . .
* Reading back is enabled when an instance is
* "Enable tag readback" inserted.
Disabled:
e Reading back is disabled when an instance is
inserted.

Parameter
“Input" /
“InOut" 2

"Attributes > User-defined
attributes”:

* "CFC EnableTagReadback"

BOOL parameter = "TRUE":

* The input parameter can be read back.

The runtime behavior depends on the
setting in the block header of the instance.
BOOL parameter = "FALSE"

e Parameter cannot be read back.

Block instance 3

Block header

"S7 specific > Block":
* "Enable tag readback”

The block type setting is applied when an
instance is inserted.

However, you can change the setting for
specific instances.

Enabled:

e Reading back is possible.

The runtime behavior depends on the
"CFC_EnableTagReadback" attribute at the
block type parameter.

Disabled:

e Parameter cannot be read back.
When you enable the "All parameters"”

option in the "Readback" dialog, however,
this setting is ignored.

Parameter

"S7 specific":
* "Enable tag readback"

Indicates whether the parameter can be read
back.

To read back a parameter during runtime, the
following settings must be made:

* Block type > Parameter:

Attribute "CFC_EnableTagReadback" = "TRUE"
¢ Block instance > Block header:

"Enable tag readback" = enabled

You can also enable the "All parameters"
option during readback.

262
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7.12 Reading back parameter changes in CFC

Object

Properties: Meaning

"General" tab

1) To edit the type of a block header, select the "Properties” entry in the shortcut menu of the block in the navigation area.

2) To edit a parameter of a type, open the block and click on the respective parameter. The properties are displayed in the

Inspector window.

3) To edit the block instance, click on the block header or the input parameter in the CFC. The properties are displayed in
the Inspector window.

Requirement

Procedure

Configuring CFC charts

Parameters were changed during runtime.
Readback is enabled:
— Block type: at the parameter

— Block instance: at the block header

. Select the "Charts" folder in the project tree.

. Select the "Readback" command from the shortcut menu.

The "Readback" dialog opens.

. Select an option for reading back:

— "All parameters"
The "Enable tag readback" attribute at the block instance is ignored.

All changed parameters with the attribute "CFC_EnableTagReadback" = "TRUE" are read
back.

— "Only designated param./blocks"

The parameter is read back when reading back is enabled at the block header of the
instance and at the parameter.

. Click "OK".

Readback starts.

. The readback process is logged in the Inspector window in the "Info > General" tab.

All values changed in the offline program during the readback are logged.
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Result
Changes to CPU parameters are read back into the offline program.
"No changes" message
During runtime, changes at the block input in CFC are written directly to the controller.
Readback is not necessary for these changes.
You will receive the message "No changes" in this case.
See also
Overview: Compiling and downloading CFC charts (Page 249)
Configuring CFC charts
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7.13 Inter-project engineering in CFC

7.13 Inter-project engineering in CFC

Overview

The functionality of Inter Project Engineering also referred to as "IPE", is used to exchange the
controller data in a source project between different projects.

You can then transfer this data to other projects and use it there for further configuration.

Use the "Device Proxy Data" object to exchange controller data.

Additional information in the information system of the TIA Portal:

"Using Team Engineering > Exchanging data with Inter Project Engineering (IPE)"

Cross-project data exchange

The following options are available for cross-project data exchange with Inter Project
Engineering:

Basic procedure

IPE file:

The controller data of the controller from the source project is exported to an IPE file.
The IPE file is imported into the target project.

Project file:

The controller data from the source project is transferred to the controller in the target
project via a project file.

An IPE file is used in this process.

Information on the exchange via a project file can be found in the information system of the
TIA Portal.

1.
2.

Compile the project to ensure consistency.

Open a "Device Proxy Data" object in the "Device Proxy Data" folder in the navigation area of
the controller.

. Navigate to the following folder in the "Definition of the content" area:

— "Program blocks > CFC blocks"

Select the CFC blocks you want to exchange.

5. Click "Export Device Proxy Data".

Select the name and the storage path of the IPE file.

Result

The selected controller data has been exported as an IPE file.

To use the data in a different project, import the file into the target project.

Configuring CFC charts
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7.13 Inter-project engineering in CFC

See also

Multiuser Engineering in CFC (Page|267)
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7.14 Multiuser Engineering in CFC

Multiuser Engineering

With Multiuser Engineering you edit server projects together and at the same time in multiple
local sessions.

You edit your projects offline and initially download them to the TIA project server.

The project server supports the convenient synchronization of projects and allows you to
conduct tests locally.

Use Multiuser Commissioning when working with CFCs. The respective Team Engineering
functionalities support you when downloading the project versions to the CPU.
More information
Information system of the TIA Portal:
¢ "Using Team Engineering > Using Multiuser Engineering":
“Introduction to Multiuser Engineering"
"Requirements for working with Multiuser Engineering”
"Operator controls in Multiuser Engineering"
¢ "Using Team Engineering":

"Using Multiuser Commissioning"
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7.14 Multiuser Engineering in CFC

Basic procedure

—_

. Create the controller in the server project.
Update the local session.

Create and edit the CFCs in the local session.

W

Check whether objects that you are referencing in your local session were changed in the
server project.

Objects that do not match the latest version of the server project are labeled as outdated.
If necessary, update the local session, for example, to apply changed block types or tags.

5. Check and mark the changed objects in the local session.

Note
Unmarked objects: Changes are lost

Only the changes of marked objects are checked in.

When objects are not marked or when the marking was removed, the corresponding
changes are not applied during check-in.

6. Check in the marked objects on the project server.

To compile the changes during check-in, enable the "Compile" option in the "Check-in"
dialog.

7. Select synchronous commissioning as commissioning mode:
— Download the data to the controller in the server project.

The local session is automatically updated after the download.

Note
Avoid loss of delta download capability

To ensure online delta download capability, save the server project to the controller after
each download.

If an error occurs in Multiuser Commissioning or when you are working without Multiuser
Commissioning, the server project is not saved automatically.

When changes in the server project are not saved, the online delta download of the
project may no longer be possible.
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CFCs in Multiuser Engineering

Configuring CFC charts

When using Multiuser Engineering, multiple editors are configuring CFCs in local sessions.

The configuration data of the local session is synchronized with the server project on the
project server.

Changed objects are marked with a color flag in the first column in the project tree.

During check-in, the changed data from the local session are transferred to the server project.

Refresh local session

You apply the changes from other editors to your local session during the refresh.

Make sure that you are always using the current block types in the local session.

CFCs are only checked in when the blocks in the local session match the blocks in the server
project.

Multiuser Commissioning

In Multiuser Commissioning the project is synchronized via the server project. The online
project in the CPU and the offline project in the project server are kept consistent.

A download to the controller is not possible in a local multiuser session. You always compile
and download the CFCs in the server project.

You define the settings in the administration tool.
Disable the following option:

¢ "Check for different data before download (recommended)”

Editing in online mode

Before you edit CFCs in online mode, the local session must match the version downloaded to
the PLC.

Parameter changes are written directly to the PLC in online mode.

To apply the changed values to the server project, check in the data of the local session
afterward.
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Supported objects for Multiuser Engineering
The following actions are possible for the supported objects:
¢ Supplement objects
* Edit properties of objects and interconnections

¢ Delete objects

Note
Editing unsupported objects in the local session

Objects that are not supported can be edited in a local session but cannot be marked.
Changes to unsupported objects are not applied to the server project during check-in.

Changes to such objects are lost after check-in and after an update in the local session,
because these objects are once again overwritten with the contents of the server project.

You can, however, edit such objects that are not supported in the usual way in the server
project view.
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Supported objects

Object Check-in into the server project

CFCs and interconnections CFCs are checked in with the block instances and interconnections.
An error message is output in case of naming conflicts.

Hierarchical CFCs Hierarchical CFCs are treated as a single object.

The basic chart and all subcharts are always checked in together.
Interconnections across Interconnections between CFCs are always checked in with the target
charts chart.

If you only check in the CFC chart at which the output is
interconnected, the interconnection is ignored.

When you check in an interconnection without a source, the
interconnection in the server project is removed.

Run sequence CFCs in the server project are placed at the end of the run sequence in
the following cases:

e A new CFC chart is checked in but not the changed run sequence.
e CFCs that are available in the server project are missing in the

checked-in run sequence.

If the run sequence contains CFCs that are not available in the server
project, these items are deleted in the run sequence.

Trend displays and value If a referenced tag in the server project is not available, the associated
displays items are deleted in the displays during check-in.

If an attribute of a trend or value display is changed that is part of a
referenced tag, the higher-level CFC chart is marked as changed.

Instructions and blocks Proceed as described below to avoid conflicts:

1. Check in edited block types.

2. Open the server project.

3. Update the block types in the server project.

4. Update the local session.

5. Use the block types in the CFCs.

You cannot update blocks in CFCs in the local session.

Block instances Check whether all block instances in the server project were updated
before you start working with a CFC chart.

Troubleshooting

When a block type was only changed in the server project, you cannot
check in a CFC chart with the associated block instances.

The corresponding block instances are listed in the Inspector window.

To check in a CFC chart despite block type conflicts, delete the listed
block instances. Correct the checked-in CFC chart in the server project
and update the local session.

See also

Inter-project engineering in CFC (Page|265)
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7.15 Connection to an HMI system

7.15.1 Connection of CFC charts to an HMI system
You can visualize alarms and values of CFC block instances in SIMATIC WinCC.

You can display and use the parameters from the CFC interfaces for operator control and
monitoring in an HMI system.

Requirement for the HMI connection

* The block type is configured for HMI access.

Default setting

When you create a block, the attributes for HMI access are already enabled:
* Accessible from HMI/OPC UA/Web API

* Writable from HMI/OPC UA/Web API

* Visible in HMI engineering

Basic procedure

—_

. Add a function block that is configured for HMI access in the CFC chart.
Configure the interconnections of the block instance.

If required, configure the alarms at the block instance.

> wN

Download the compiled CFC chart to the CPU.
The alarms of the block instance are included in the download.
You can also process alarms from multiuser projects.

5. In WinCC, you have access to the tags and alarms of the CFC instances.

Additional information
e "Tag connection in CFC (Page 273)"
* "Configuring alarms in CFC (Page 275)"
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7.15.2 Tag connection in CFC

To visualize values of CFC block instances in SIMATIC WinCC link the block parameters to the
HMI tags.

The HMI connection must be configured for this.

Additional information: "Connection of CFC charts to an HMI system (Page 272)"

Tag connection
You have the following options to link an HMI tag with a block parameter:
¢ Dynamize an object in the process picture with a block parameter.
The associated HMI tag is created automatically.

¢ C(Create a tag under "HMI tags" and select a block parameter in the "PLC tag" field.

Tag selection
The CFC blocks are located in the navigation area of the tag selection at the following path:
* "Program blocks > CFC blocks"

In the data area, select the block parameter under the block instance.

The block parameter is created as an HMI tag.

Tag names
The tag names are formed from the following elements:
« CFC
¢ Block instance
e Parameters
Editor / Component Display format Example
Tag selection <Chart name>/<Block instance name> Navigation area / data area:
e CFC_2/MyFB 1
Parameters in the data area:
¢ InByte3
Process tag | HMI <Chart name>/<Block instance CFC_2/MyFB_1 InByte3
tag *) name> <Parameter>
PLC tag "<Chart name>/<Block instance "CFC_2/MyFB_1".InByte3
name>".Parameter

*) When you create an HMI tag while configuring a dynamization, this name structure is applied. However, you can also
assign a different name to an HMI tag.
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Changing the name

When you change parts of a name, the name of the PLC ta
The HMI tag retains the original name.

¢ Name change of the block instance or CFC:

g is changed as well.

The link of the HMI tag to the PLC tag is updated automatically.

¢ Name change of the parameter:

You must adapt the link of the HMI tag to the PLC tag in the "HMI tags" table.

Note
Adapting the configuration

Name changes can affect the tag connections.

If necessary, update the tag names in the configuration, for example, during addressing in

scripts.

Example
Block instance PLC tag HMI tag
Chart name: "CFC_2/MyFB 1".InByte3 CFC _2/MyFB 1 InByte3
e CFC 2
Instance name:
e MyFB 1
Parameter name
¢ InByte3
Changed chart name: "CFCNew/MyFB 1".InByte3 CFC_2/MyFB 1 InByte3
e CFCNew The change is applied to the "HMI tags" table.
Changed instance name: "CFCNew/New FB".InByte3 CFC _2/MyFB 1 InByte3
e New FB The change is applied to the "HMI tags" table.
Changed parameter name: "CFCNew/New FB".InByteNew CFC_2/MyFB_1 InByte3
+ InByteNew ggfailw_gt;?gnlannfz.e HMI tags" table retains the original tlhidgc; ;c]:\;ancaogner:ﬁ;;etc'j PLC tagin

The "PLC tag" field is highlighted in red.

See also

274

Configuring alarms in CFC (Page 275)
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7.15.3 Configuring alarms in CFC

Alarm blocks in CFCs

You can configure the S7 message block "Program_Alarm" in an S7 block.

When you use a block with the lower-level alarm block in the CFC, you can edit the alarm
texts directly at the block instance.

Additional information
Information system of the TIA Portal:

e "Program PLC > Configuring alarms"”

Display in the alarm system

The alarms of the blocks are integrated into the program alarms in the "PLC supervisions &
alarms" editor:

¢ Alarm types: Alarms of the block type

¢ Alarm instances: Alarms of the block instances

Whenever you copy a block instance in CFC, copies of the instance alarms are generated
as well.

Display alarms in runtime

To display the alarms, download the modified charts and create an online connection.

In the navigation window, select the menu command "Receive alarms" from the shortcut
menu of the device.

The alarms are displayed in the Inspector window, "Diagnostics" tab, "Alarm display" area.

Select the corresponding target system from the drop-down list.

Requirement

Check the settings of the PLC alarms using the menu command "Options > Settings":

Setting Status
Show lock icons Enabled
Set locks on creation of a new program alarm Disabled

You enable or disable the interlock of individual alarm texts and infotexts in the "PLC
supervisions & alarms" editor in the "Alarms > Program alarms" tab.
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Procedure
1. Inthe CFC, select the block at which you want to configure the alarms.
2. To display the properties of the alarms, click on the block header of the instance.
The "Alarms" tab is displayed with a list of the alarm instances in the Inspector window
under "Properties".
3. In the list, click the instance alarm that you want to configure.
4. You change the texts in the current configuration language in the "Alarm text" and "Infotext"
columns.
The alarm texts and infotexts can only be edited when they are not locked.
Result
The alarms are configured and can be displayed in runtime.
See also

Connection of CFC charts to an HMI system (Page|272)
Tag connection in CFC (Page|273)
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7.16 OPC UA communication in CFC

You can also access the instances of blocks and instructions in CFC charts via OPC UA.

Additional information
Information system of the TIA Portal:

¢ "Editing devices and networks > Configuring devices and networks > Creating
configurations > Configuring automation systems > Using OPC UA communication”

Settings for OPC UA access

See also

Configuring CFC charts

On compilation of a block instance a corresponding programming object is created.
These options are activated as the default setting:
* "Data block accessible via OPC UA"

¢ "Data block accessible via web server"

Note
Do not change options

On every full download of the block instances the default setting is restored again and
changes are overwritten.

Tag connection in CFC (Page|273)
Connection of CFC charts to an HMI system (Page|272)
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7.17 CFC charts: Reference
7.17.1 CFC tasks for S7
Overview

Instructions and blocks are always assigned to one or more tasks of the target system.
The tasks are also referred to as "OB types".

Additional information:

* "Runtime model (Page|161)"

* Information system of the TIA Portal:

"Editing devices and networks > Configuring devices and networks > Creating
configurations > Configuring automation systems > Principle of operation of S7-1500
CPUs > Basics on program execution"
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Supported tasks

When you create tasks, they are only be displayed in English for technical reasons —
irrespective of the set user interface language.

CFC supports the following tasks:

Task Meaning

Program cycle Cycle, task for cyclic program execution
Cyclic interrupt_0 Cyclic interrupt, cycle time: 5000 ms *
Cyclic interrupt_1 Cyclic interrupt, cycle time: 2000 ms *
Cyclic interrupt_2 Cyclic interrupt, cycle time: 1000 ms *
Cyclic interrupt_3 Cyclic interrupt, cycle time: 500 ms *
Cyclicinterrupt_4 Cyclic interrupt, cycle time: 200 ms *
Cyclic interrupt 5 Cyclic interrupt, cycle time: 100 ms *
Cyclic interrupt_6 Cyclic interrupt, cycle time: 50 ms *
Cyclic interrupt_7 Cyclic interrupt, cycle time: 20 ms *
Cyclic interrupt_8 Cyclic interrupt, cycle time: 10 ms *
Synchronous cycle Isochronous mode interrupt

Time error interrupt Time error

Diagnostic error interrupt Diagnostics interrupt

Pull or plug of modules Pull/plug

Rack or station failure Rack failure

Startup Startup

Programming error Programming error

IO access error I/O access error

*) Cyclic time:
To change the cyclic time, select the OB in the project tree under "Program blocks".

Open the block properties via the shortcut menu. You can change the cyclic time and the phase offset
in the "Cyclic interrupt" area
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7.17.2

7.17.2.1

Families of CFC instructions

CFC Instructions for S7

Overview of CFC instructions

The CFCinstructions can be found in the "Instructions” task card in the following panes:

Basic instructions

Family

Folder

Function

TERMINAL (Page 283)

General

TERMINAL instruction for compilation of
interconnections

BIT_LGC (Page|285)

Bit logic operations

Logic instructions of the data type BOOL

FLIPFLOP (Page 285)

Bit logic operations

Flipflop instructions

COMPARE (Page|297)

Comparator operations

Instructions for comparing two input values of the
same type

MATH_FP (Page 301)

Math functions

Arithmetic instructions of the data type REAL

MATH_INT (Page 301)

Math functions

Arithmetic instructions of the data type INT and
DINT

CONVERT (Page 317)

Conversion operations

Instructions for converting data types

WRD_LGC (Page|331)

Word logic operations

Logic instructions of the data type WORD and
DWORD

MULTIPLX (Page/331)

Word logic operations

Multiplex instructions

SHIFT (Page 349)

Shift and rotate

Shift instructions

280
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Instruction group | Folder Function
Date and time-of- | Date and time-of-day Calculations with time formats
day (Page[358) Clock functions Read/change times and time zones
Synchronize slave clocks
Runtime meters
String + Char String + Char Processing character strings
(Page/359)
Process image Process image Updatelsynchronize process images
(Page|/360)
Distributed /0 DP & PROFINET Read / write data records
(Page361) Read/transfer process images
Receive interrupts
Enable/disable DP slaves
Configure 10 system
Others Write data record
Others: iDevice / iSlave Receive/provide data record
Others: PROFIBUS Synchronize DP slaves
Diagnostics Diagnostics Reading out information about the system
(Page/362)
Communication
Instruction group | Folder Function
S7 communication | Others Send/receive data
(Page|/363)
Open user Open user communication Establish connection
communication Send/receive data
(Page|364)

Read/change communication parameters

Others

Establish/terminate communication connection
Send/receive data
Configure interface

See also

"CFC" Editor (Page 43)
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7.17.2.2

Introduction

EN

ENO

282

EN and ENO parameters

Since the function of the following parameters is always the same, this description applies to
all instructions that use these parameters.

EN (enable): Enable input parameter

Note

The input parameter exists only in the graphical interface of CFC, however it is switched to
hidden.

The EN parameter can be used to switch the instruction on or off. It ensures that the
instruction is only called in the task code at PLC level if it has been enabled via EN = 1.

ENO (enable out): Enable output parameter

Note

The output parameter exists only in the graphical interface of CFC, however it is switched to
hidden.

ENO = 1 shows a valid result as appropriate to the function. When the operating system
and/or the troubleshooting routine detects an error in the instruction, ENO will be set to O to
indicate an invalid result. You can use this information in order to switch to other values
(e.g., safety values) and to output messages to the OS as required.

If EN = FALSE, then ENO = FALSE.

Configuring CFC charts
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7.17.2.3 CFC instructions: Basic instructions

General

TERMINAL: Summary of interconnections

Description
The "TERMINAL" instruction supports you in organizing interconnections in the CFC view.
The "TERMINAL" element does not process values and only summarizes the interconnections
of a chart.
Principle
TERMINAL is a passive structuring element without access to CPU resources or its own code.
Each input parameter IN corresponds to exactly one output parameter OUT.

These parameters are connected internally with the "TERMINAL" element. The behavior
corresponds to that of a terminal strip that connects through electrical interconnections.

Because TERMINAL does not process any values, it also does not affect system performance.

Interconnections
You can change the number of input parameters or output parameters.

Corresponding input and output parameters are collectively called "Signal". You change this
name in the properties of the block instance in the "Comment" column of the "Interfaces"
table.

When you create an interconnection, the input parameter and the associated output
parameter take on the data type of the interconnected parameter. When you change the
interconnection, the data type of the new interconnection is applied automatically.

Possible interconnections are, for example:

¢ Block parameters

* Parameters of chart interfaces

¢ Other "TERMINAL" elements

¢ Input parameter: External tag

The TERMINAL parameters cannot be set or read directly.

Interconnected structures cannot be expanded.
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Parameters
Parameters Declaration Data type Description Default
IN1 Input ANY Input value 1 0
IN... Input ANY Input value... 0
INn Input ANY Input value "n" 0
OuUT1 Output ANY Output value 1 0
OUT... Output ANY Output value... 0
OoUTn Output ANY Output value "n" 0

Application example
You interconnect several blocks of the chart "CFC_1" to blocks of a different CFC, e.g. "CFC_2".

The interconnected blocks are distributed widely in the chart "CFC_1". The interconnections
across charts in the sheet bar are not displayed together on one monitor.

You want to display the interconnections of the blocks "bl1" and "bl2" to the blocks of the
chart "CFC_2" bundled in the sheet bar.

To do so, you summarize the interconnections in a "TERMINAL" element:
1. Interconnect the TERMINAL input parameters with the blocks "bl1" and "bl2".

2. You interconnect the corresponding TERMINAL output parameters with the blocks of the
chart "CFC_2".

You can only create interconnections to parameters whose data type corresponds to the
input parameter interconnections that have already been created.

TERMINAL
——bl1_out3Ch
bl2_USInt
bl2_out6S!
bl2_cutdlUDI
——bl1_out7DW

—Signal

14 ICFC_Ziterminal_1.IN1
14 ICFC_2fterminal_1.IN2
14 JICFC_2imyfb_inc_1.ind UDI

See also
Representation and properties of interconnections (Page|126)

Overview of CFC instructions (Page 280)
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Logic instructions (bit logic)
Overview of the instruction families "BIT_LGC" and "FLIPFLOP"
Overview of the instruction family "BIT_LGC"

In this family, logic instructions are combined with the data type BOOL.

With these instructions you implement logical operations.

AND (Page|287)

AND logic operation

F_TRIG (Page 296)

Detect negative signal edge

NAND (Page|288)

NAND logic operation

NOR (Page|289) NOR logic operation

NOT (Page 290) NOT logic operation

OR (Page 291) OR logic operation

R_TRIG (Page 286) Detect positive signal edge

XOR (Page 292) Bit by bit antivalence logic operation

Overview of "FLIPFLOP" instruction family

This family contains flipflop instructions.

JK_FF (Page|293)

JK Flipflop

RS_FF (Page|294)

RS Flipflop, reset dominant

SR_FF (Page | 295)

SR Flipflop, set dominant

See also

Overview of CFC instructions (Page 280)
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R_TRIG: Detect positive signal edge

Function

See also

286

With the "Detect positive signal edge" instruction, you can detect a state change from "0" to
"1" at the CLK input.

The instruction compares the current value at the CLK input with the state of the previous
query (edge memory bit) that is saved in the specified instance.

If the instruction detects a state change at the CLK input from "0" to "1", a positive signal edge
is generated at the Q output, that is, the output has the value TRUE or "1" for exactly one
cycle.

In all other cases, the signal state at the output of the instruction is "0".

TIA Portal Information System
Additional information in the information system of the TIA Portal:

¢ "PLC programming > Instructions > Basic instructions > FBD > Bit logic operations >
R_TRIG: Detect positive signal edge"

Overview of the instruction families "BIT_LGC" and "FLIPFLOP" (Page 285)
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AND: AND logic operation

Description

7.17 CFC charts: Reference

This instruction generates logic AND operations at the input values. The output value is 1 if all

input values are 1. Otherwise, the output value is O.

The number of IN input parameters can be modified.

Truth table (example of n = 2)

IN1 IN2 ouT

0 0 0

0 1 0

1 0 0

1 1 1
Parameters

Parameters Declaration Data type Description Default

IN1 Input BOOL Input value 1 1

INn Input BOOL Input value "n" 1

ouT Output BOOL Output value 1
See also

Overview of the instruction families "BIT_LGC" and "FLIPFLOP" (Page 285)
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NAND: NAND logic operation

Description

This instruction generates and inverts logic AND operations at the input values. The output

value is 0 only if all input values are 1.

The number of IN input parameters can be modified.

Truth table (example of n = 2)

IN1 IN2 ouT

0 0 1

0 1 1

1 0 1

1 1 0
Parameters

Parameters Declaration Data type Description Default

IN1 Input BOOL Input value 1 1

INn Input BOOL Input value "n" 1

ouTt Output BOOL Output value 0
See also

Overview of the instruction families "BIT_LGC" and "FLIPFLOP" (Page 285)
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NOR: NOR logic operation

Description

This instruction generates and inverts logic OR operations at the input values. The output
value is 1 only if all input values are 0.

The number of IN input parameters can be modified.

Truth table (example of n = 2)

IN1 IN2 ouT

0 0 1

0 1 0

1 0 0

1 1 0
Parameters

Parameters Declaration Data type Description Default

IN1 Input BOOL Input value 1 0

INn Input BOOL Input value "n" 0

ouT Output BOOL Output value 1
See also

Overview of the instruction families "BIT_LGC" and "FLIPFLOP" (Page 285)

Configuring CFC charts
System Manual, 11/2022, A5E52420813-AA 289



Working with CFC charts for S7

7.17 CFC charts: Reference

NOT: NOT logic operation

Description
This instruction inverts the input value.
Truth table
IN ouT
0 1
1 0
Parameters
Parameters Declaration Data type Description Default
IN Input BOOL Input value 0
ouT Output BOOL Output value 1
See also
Overview of the instruction families "BIT_LGC" and "FLIPFLOP" (Page 285)
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OR: OR logic operation

Description

This instruction generates logic OR operations at the input values. The output value is 1 if at
least one input value is 1. The output value is O if all input values are O.

The number of IN input parameters can be modified.

Truth table (example of n = 2)

IN1 IN2 ouT

0 0 0

0 1 1

1 0 1

1 1 1
Parameters

Parameters Declaration Data type Description Default

IN1 Input BOOL Input value 1 0

INn Input BOOL Input value "n" 0

ouT Output BOOL Output value 0
See also
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XOR: Bit by bit antivalence logic operation

Description

This instruction generates exclusive OR operations at the input values. The output value is O if
all input values have the same value. Otherwise, the output value is 1.

The number of IN input parameters can be modified.

Truth table (example of n = 2)

IN1 IN2 ouT

0 0 0

0 1 1

1 0 1

1 1 0
Parameters

Parameters Declaration Data type Description Default

IN1 Input BOOL Input value 1 0

INn Input BOOL Input value "n" 0

ouTt Output BOOL Output value 0
See also

Overview of the instruction families "BIT_LGC" and "FLIPFLOP" (Page 285)
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JK_FF: JK Flipflop

Description
Input parameters Input parameters Output parameters Output parameters
J K =
Qn Qn
0 0 =
Qn-1 Qn-1
0 1 0 1
1 0 1 0
1 1 =
Qn-1 Qn-1
*1)
*1) The pulse signal of the implemented tasks toggles the output parameters.
Parameters
Parameters Declaration Data type Description Default
J Input BOOL Set 0
K Input BOOL Reset 0
Q Output BOOL Output value 0
— Output BOOL negated output value 1
L
See also
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RS_FF: RS Flipflop, reset dominant

Description

Parameters

See also

294

Input parameters Input parameters Output parameters Output parameters
R S =
Qr. Qn
0 0 =
Qn-1 Qn-1
0 1 1 0
1 0 0 1
1 1 0 1
Parameters Declaration Data type Description Default
R Input BOOL Reset 0
S Input BOOL Set 0
Q Output BOOL Output value 0
g Output BOOL negated output value 1

Overview of the instruction families "BIT_LGC" and "FLIPFLOP" (Page 285)

Configuring CFC charts

System Manual, 11/2022, A5E52420813-AA




Working with CFC charts for S7

SR_FF: SR Flipflop, set dominant

Description

Parameters

See also

Configuring CFC charts

7.17 CFC charts: Reference

Input parameters Input parameters Output parameters Output parameters
R S =
Qn Qn
0 0 =
Qn-1 Qn-1
0 1 1 0
1 0 0 1
1 1 1 0
Parameters Declaration Data type Description Default
R Input BOOL Reset 0
S Input BOOL Set 0
Q Output BOOL Output value 0
g Output BOOL negated output value |1

System Manual, 11/2022, A5E52420813-AA
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F_TRIG: Detect negative signal edge

Function

See also

296

With the "Detect negative signal edge" instruction, you can detect a state change from "1" to
"0" at the CLK input.

The instruction compares the current value at the CLK input with the state of the previous
query (edge memory bit) that is saved in the specified instance.

If the instruction detects a state change at the CLK input from "1" to "0", a negative signal
edge is generated at the Q output, that is, the output has the value TRUE or "1" for exactly
one cycle.

In all other cases, the signal state at the output of the instruction is "0".

TIA Portal Information System
Additional information in the information system of the TIA Portal:

¢ "PLC programming > Instructions > Basic instructions > FBD > Bit logic operations >
F_TRIG: Detect negative signal edge"

Overview of the instruction families "BIT_LGC" and "FLIPFLOP" (Page 285)

Configuring CFC charts
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Instructions for comparing two input values (comparator)

Overview of "COMPARE" instruction family

Overview

This family contains instructions for comparing two input variables of the same type:

CMP_DI (Page 299) Comparison of DINT values
CMP_I (Page[298) Comparison of INT values
CMP_T (Page 300) Comparison of TIME values

Comparator in CFC and FBD
* You can use the FBD comparator independent of the data types.
The CFC comparators, however, are data type specific.

¢ Each of the CFC instructions "CMP_DI", "CMP_I" and "CMP_T" covers the functions of
multiple FBD instructions.

The corresponding comparison values are output via the parameters of the "CMP_..."

instruction.

FBD: Instruction CFC: Parameter
CMP == EQ, value=0
CMP <> EQ, value=1
CMP >= GE

CMP <= LE

CMP > GT

CMP < LT

See also

Overview of CFC instructions (Page 280)

Configuring CFC charts
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CMP_I: Comparison of INT values

Description

Parameters

See also

298

This instruction compares two input values and sets the output values as follows:

GT=1ifINT>IN2
GE=1IifIN1T=IN2
EQ=1ifINT=IN2
LE=1,ifINT<IN2
LT=1if INT <IN2

Parameters Declaration Data type Description Default
IN1 Input INT Input value 1 0
IN2 Input INT Input value 2 0
GT Output BOOL GT=1:INT>IN2 0
GE Output BOOL GE=1:INT=IN2 0
EQ Output BOOL EQ=1:INT=IN2 0
LE Output BOOL LE=1:IN1=<IN2 0
LT Output BOOL LT=1:IN1<IN2 0

Overview of "COMPARE" instruction family (Page|297)

Configuring CFC charts
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CMP_DI: Comparison of DINT values

Description
This instruction compares two input values and sets the output values as follows:
e GT=TifIN1T>IN2
e GE=1ifIN1=IN2
e EQ=1ifINT=IN2
e LE=1,ifINT=<IN2
e LT=1ifINT<IN2
Parameters
Parameters Declaration Data type Description Default
IN1 Input DINT Input value 1 0
IN2 Input DINT Input value 2 0
GT Output BOOL GT=1:INT>IN2 0
GE Output BOOL GE=1:INT=IN2 0
EQ Output BOOL EQ=1:INT=IN2 0
LE Output BOOL LE=1:IN1=<IN2 0
LT Output BOOL LT=1:IN1<IN2 0
See also

Overview of "COMPARE" instruction family (Page|297)

Configuring CFC charts
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CMP_T: Comparison of TIME values

Description

Parameters

See also

300

This instruction compares two input values and sets the output values as follows:

GT=1ifINT>IN2
GE=1IifIN1T=IN2
EQ=1ifINT=IN2
LE=1,ifINT<IN2
LT=1if INT <IN2

Parameters Declaration Data type Description Default
IN1 Input TIME Input value 1 0
IN2 Input TIME Input value 2 0
GT Output BOOL GT=1:INT>IN2 0
GE Output BOOL GE=1:INT=IN2 0
EQ Output BOOL EQ=1:INT=IN2 0
LE Output BOOL LE=1:IN1=<IN2 0
LT Output BOOL LT=1:IN1T<IN2 0

Overview of "COMPARE" instruction family (Page|297)

Configuring CFC charts
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Arithmetic instructions (Math functions)
Overview of the instruction families "MATH_FP" and "MATH_INT"
Overview of "MATH_FP" instruction family

This family contains arithmetic instructions for the data type REAL.

With these instructions you implement arithmetic operations with data of the type REAL.

Note
Value range

The value range of real numbers:
e -3,40282eM+38...-1,755e7-38 ... 0 ... 1,755e7-38 ... 3,40282e/+38

ABS_R (Page 304) Absolute value of REAL values
NEG_R (Page|305) Inverter for REAL values

Configuring CFC charts
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Overview of "MATH_INT" instruction family

See also

302

This family contains arithmetic instructions for the data types INT and DINT.

With these instructions you implement arithmetic operations with data of the type INT and

DINT.

Note
Value range

The value range of data types INT and DINT:
e INT:-32768...32767
* DINT:-2 147 483 648 ... 2 147 483 647

ABS_DI (Page 305)

Absolute value of DINT values

ABS_| (Page/306)

Absolute value of INT values

DIV_DI (Page|/306)

Division of DINT values

DIV_I (Page 307)

Division of INT values

EPS DI (Page 308)

Accuracy approximation of DINT values

EPS_| (Page/309)

Accuracy approximation of INT values

LIM_DI (Page 310}

Limiter for DINT values

LIM_I (Page/311)

Limiter for INT values

LIMIT (Page|304)

Set limit value

MAX (Page 303)

Get maximum

MAX_DI (Page 312}

Maximum of DINT values

MAX | (Page 312)

Maximum of INT values

MIN (Page 303)

Get minimum

MIN_DI (Page|313)

Minimum of DINT values

MIN_| (Page|313)

Minimum of INT values

MOD_DI (Page 314)

Modulo function of DINT values

MOD_| (Page 315)

Modulo function of INT values

NEG_DI (Page/315)

Inverter for DINT values

NEG_| (Page 316)

Inverter for INT values

Overview of CFC instructions (Page 280)

Configuring CFC charts
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MIN: Get minimum

Description

The "Get minimum" instruction compares the values of the available inputs and writes the
lowest value to the OUT output.

The number of inputs can be expanded at the instruction box by additional inputs. The inputs
are numbered in ascending order in the box.

TIA Portal Information System
Additional information in the information system of the TIA Portal:

¢ "PLC programming > Instructions > Basic instructions > FBD > Math functions > MIN: Get
minimum"

See also

Overview of the instruction families "MATH_FP" and "MATH_INT" (Page|301)

MAX: Get maximum

Description

The "Get maximum" instruction compares the values of the available inputs and writes the
highest value to the OUT output.

The number of inputs can be expanded at the instruction box by additional inputs. The inputs
are numbered in ascending order in the box.

TIA Portal Information System
Additional information in the information system of the TIA Portal:

e "PLC programming > Instructions > Basic instructions > FBD > Math functions > MAX: Get
maximum"

See also

Overview of the instruction families "MATH_FP" and "MATH_INT" (Page|301)

Configuring CFC charts
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LIMIT: Set limit value

Description

See also

The "Set limit value" instruction limits the value at the IN input to the values at the MN and
MX inputs.

¢ When the value at input IN satisfies the condition MN <= IN <= MX, it is copied to output
OUT.

¢ When the condition is not fulfilled and the input value IN is below the low limit MN,
output OUT is set to the value of the input MN.

¢ When the high limit MX is exceeded, output OUT is set to the value of the MX input.
When the value at the MN input is greater than at the MX input, the result is the value
specified at the IN parameter and the enable output ENO is "0".

TIA Portal Information System

Additional information in the information system of the TIA Portal:

e "PLC programming > Instructions > Basic instructions > FBD > Math functions > LIMIT: Set
limit value"

Overview of the instruction families "MATH_FP" and "MATH_INT" (Page 301)

ABS_R: Absolute value of REAL values

Description

Parameters

See also

304

This instruction outputs the absolute value of the input value at the output parameter OUT.
OUT=]IN|

Parameters Declaration Data type Description Default
IN Input REAL Input value 0.0
ouT Output REAL Absolute value 0.0

Overview of the instruction families "MATH_FP" and "MATH_INT" (Page 301)

Configuring CFC charts
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NEG_R: Inverter for REAL values

Description
This instruction outputs the input value with changed sign at the output parameter OUT.
Parameters
Parameters Declaration Data type Description Default
IN Input REAL Input value 0.0
out Output REAL Output value 0.0
See also

Overview of the instruction families "MATH_FP" and "MATH_INT" (Page|301)
ABS_DI: Absolute value of DINT values
Description
This instruction outputs the absolute value of the input value at the output parameter OUT.

OUT=]IN |

Error handling
ENO =0if IN=-2 147 483 648 (smallest negative number)

Parameters
Parameters Declaration Data type Description Default
IN Input DINT Input value 0
ouTt Output DINT Absolute value 0

See also

Configuring CFC charts
System Manual, 11/2022, A5E52420813-AA
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ABS_I Absolute value of INT values

Description

Troubleshooting

OUT =] IN |

ENO=0ifIN=-32,768

This instruction outputs the absolute value of the input value at the output parameter OUT.

Parameters
Parameters Declaration Data type Description Default
IN Input INT Input value 0
ouT Output INT Absolute value 0

See also

Overview of the instruction families "MATH_FP" and "MATH_INT" (Page 301)

DIV_DI: Division of DINT values

Description

This instruction divides the IN1 input value by the IN2 input value and outputs the quotient at
the output parameter OUT.

OUT =IN1/IN2

Error handling
ENO = 0 at division by 0 or division of —2147483648 by —1.

Parameters
Parameters Declaration Data type Description Default
IN1 Input DINT Dividend 0
IN2 Input DINT Divisor 1
out Output DINT Quotient 0
See also
Overview of the instruction families "MATH_FP" and "MATH_INT" (Page 301)
Configuring CFC charts
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DIV_I: Division of INT values

Description

This instruction divides the IN1 input value by the IN2 input value and outputs the quotient at
the output parameter OUT.

OUT =IN1/IN2

Error handling
ENO = 0 at division by 0 or division of —=32768 by —1.

Parameters
Parameters Declaration Data type Description Default
IN1 Input INT Dividend 0
IN2 Input INT Divisor 1
ouT Output INT Quotient 0
See also

Overview of the instruction families "MATH_FP" and "MATH_INT" (Page|301)

Configuring CFC charts
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EPS_DI: Accuracy approximation of DINT values

Description

Troubleshooting

Parameters

See also

308

This instruction compares the absolute value of IN with the input value INTERVAL. If the
absolute value of IN < than the INTERVAL limit, QA output parameter will be set to 1 and QN
to 0. In this case the IN input value is contained in the interval. Otherwise, the QA output
parameter is set to 0 and QN to 1. The IN input value is then outside the interval.

INTERVAL must have a positive value.
If INTERVALis <0, then QA =0.

ENO=0ifIN=-2,147,483,648

Parameters Declaration Data type Description Default

IN Input DINT Input value 0

INTERVAL Input DINT Interval limit 0

QA Output BOOL Validation bit memory |0

QN Output BOOL Inverted validation bit 0
memory

Overview of the instruction families "MATH_FP" and "MATH_INT" (Page 301)

Configuring CFC charts
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EPS_I: Accuracy approximation of INT values

Description
This instruction compares the absolute value of IN with the input value INTERVAL.

If the absolute value of IN < than the INTERVAL limit, QA output parameter will be set to 1
and QN to 0. In this case, the IN input value is contained in the interval.

Otherwise, the QA output parameteris set to 0 and QN to 1. The IN input value is then
outside the interval.

INTERVAL must have a positive value.
If INTERVAL < 0, then QA =0.

Troubleshooting
ENO=0if IN=-32,768

Parameters
Parameters Declaration Data type Description Default
IN Input INT Input value 0
INTERVAL Input INT Interval limit 0
QA Output BOOL Validation bit memory |0
QN Output BOOL Inverted validation bit 0

memory
See also

Overview of the instruction families "MATH_FP" and "MATH_INT" (Page|301)

Configuring CFC charts
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LIM_DI: Limiter for DINT values

Description

Troubleshooting

Parameters

See also

310

This instruction compares the input values IN, MAX and MIN. It checks whether IN is within or
outside the interval limited by MIN and MAX.

If the low limit MIN of the interval is greater than the high limit MAX, the output value OUT =
MAX and the output parameters OUTU and OUTL are setto 1.

IN = MAX represents a violation of the high limit, OUT = MAX, OUTU = 1 and OUTL = 0.
IN = MIN represents a violation of the low limit, OUT = MIN, OUTU =0, OUTL=1. If IN is
between MIN and MAX, OUT =IN, OUTU = 0, OUTL = 0 are set.

ENO = 0 with MIN > MAX --> OUT = MAX; OUTU = OUTL =1

Parameters Declaration Data type | Description Default
MAX Input DINT High limit 0
IN Input DINT Input value 0
MIN Input DINT Low limit 0
OouTU Output BOOL High limit violated 0
OuUTL Output BOOL Low limit violated 0
out Output DINT Output value 0

Overview of the instruction families "MATH_FP" and "MATH_INT" (Page 301)

Configuring CFC charts
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LIM_I: Limiter for INT values

Description

This instruction compares the input values IN, MAX and MIN. It checks whether IN is within or
outside the interval limited by MIN and MAX.

If the low limit MIN of the interval is greater than the high limit MAX, the output value OUT =
MAX and the output parameters OUTU and OUTL are setto 1.

IN = MAX represents a violation of the high limit, OUT = MAX, OUTU =1 and OUTL=0. IN =
MIN represents a violation of the low limit, OUT = MIN, OUTU = 0, OUTL = 1. If IN is between
MIN and MAX, OUT = IN, OUTU =0, OUTL = 0 are set.

Troubleshooting
ENO = 0 with MIN > MAX --> OUT = MAX; OUTU = OUTL =1

Parameters
Parameters Declaration Data type | Description Default
MAX Input INT High limit 0
IN Input INT Input value 0
MIN Input INT Low limit 0
OouTU Output BOOL High limit violated 0
ouTL Output BOOL Low limit violated 0
out Output INT Output value 0
See also

Overview of the instruction families "MATH_FP" and "MATH_INT" (Page|301)

Configuring CFC charts
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MAX_DI: Maximum of DINT values

Description

Parameters

See also

MAX_l: Maximum of INT values

Description

Parameters

See also

312

This instruction compares the input values and outputs their maximum value at output

parameter OUT.

OUT = MAX {IN1, ..., INn}

The number of IN input parameters can be modified.

Parameters Declaration Data type Description Default
IN1 Input DINT Input value 1 0
INn Input DINT Input value "n" 0
ouTt Output DINT Maximum value 0

Overview of the instruction families "MATH_FP" and "MATH_INT" (Page 301)

This instruction compares the input values and outputs their maximum value at output

parameter OUT.

OUT = MAX {IN1, ..., INn}

The number of IN input parameters can be modified.

Parameters Declaration Data type Description Default
IN1 Input INT Input value 1 0
INn Input INT Input value "n" 0
ouT Output INT Maximum value 0

Overview of the instruction families "MATH_FP" and "MATH_INT" (Page 301)

Configuring CFC charts
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MIN_DI: Minimum of DINT values

Description

Parameters

See also

This instruction compares the input values and outputs their minimum value at output
parameter OUT.

OUT = MIN {INT1, ..., INn}

The number of IN input parameters can be modified.

Parameters Declaration Data type Description Default
IN1 Input DINT Input value 1 0
INn Input DINT Input value "n" 0
ouT Output DINT Minimum value 0

Overview of the instruction families "MATH_FP" and "MATH_INT" (Page|301)

MIN_I: Minimum of INT values

Description

Parameters

See also

Configuring CFC charts
System Manual, 11/2022, A5E52420813-AA

This instruction compares the input values and outputs their minimum value at output
parameter OUT.

OUT = MIN {IN1, ..., INn}

The number of IN input parameters can be modified.

Parameters Declaration Data type Description Default
IN1 Input INT Input value 1 0
INn Input INT Input value "n" 0
out Output INT Minimum value 0

Overview of the instruction families "MATH_FP" and "MATH_INT" (Page|301)
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MOD_DI: Modulo function of DINT values

Description

This instruction outputs the remainder of the division of the input value IN1 by the input
value IN2 at the output parameter OUT.

The instruction DIV_DI (Page 306) is used for the integer division of the data type DINT.

Troubleshooting

ENO = 0 in the case of division by 0.

Parameters

Parameters Declaration Data type Description Default

IN1 Input DINT Dividend 0

IN2 Input DINT Divisor 1

ouTt Output DINT Remainder 0
See also

Overview of the instruction families "MATH_FP" and "MATH_INT" (Page 301)

Configuring CFC charts
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MOD_I: Modulo function of INT values

Description

This instruction outputs the remainder of the division of the input value IN1 by the input
value IN2 at the output parameter OUT.

The instruction DIV_| (Page|307) is used for the integer division of the data type INT.

Troubleshooting
ENO = 0 in the case of division by 0.

Parameters
Parameters Declaration Data type Description Default
IN1 Input INT Dividend 0
IN2 Input INT Divisor 1
ouT Output INT Remainder 0
See also

Overview of the instruction families "MATH_FP" and "MATH_INT" (Page|301)

NEG_DI: Inverter for DINT values

Description

This instruction outputs the input value with changed sign at the output parameter OUT.

Troubleshooting
ENO=0if IN=-2,147,483,648

Parameters
Parameters Declaration Data type Description Default
IN Input DINT Input value 0
ouT Output DINT Output value 0

See also

Configuring CFC charts
System Manual, 11/2022, A5E52420813-AA
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NEG_I: Inverter for INT values

Description

This instruction outputs the input value with changed sign at the output parameter OUT.

Troubleshooting

ENO=0ifIN=-32,768

Parameters

Parameters Declaration Data type Description Default

IN Input INT Input value 0

ouT Output INT Output value 0
See also

Overview of the instruction families "MATH_FP" and "MATH_INT" (Page 301)
Configuring CFC charts
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Instructions for converting data types (conversion operations)

Overview of "CONVERT" instruction family

Conversion operations

The CONVERT instruction family contains instructions that convert "n" values of a data type
into "m" values of another data type.

"m"and "n" may also have the same value.

Principle: Data conversion

In the CFC chart you can only interconnect outputs (source type) to inputs (target type) when
both data types are identical, for example, REAL output value with REAL input value.

You must use conversion instructions to interconnect different data types.

These instructions have input and output parameters of a different type, and therefore
convert the input data type according to the data type set at the output parameter.

Conversion rules

Configuring CFC charts

The abbreviated name of the source and target data type, connected by means of an
underscore " ", form the type name of the conversion instruction.

The conversion rules for specific instructions are briefly described.

If the IN input value is not within the allowed range, the OUT output value becomes invalid
and the test output parameter ENO = O is displayed.

You can evaluate ENO, for example, to provide a substitute/safety value for further
processing.
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Convert data type value into another data type

The following instructions convert one value of a data type into one value of another data

type:
Instruction Conversion
BY DW (Page 322) BYTE to DWORD
BY W (Page/323) BYTE to WORD
DI_DW (Page|323) DINT to DWORD
DI_I (Page 324) DINT to INT
DI_R (Page|/324) DINT to REAL
DW_DI (Page|325) DWORD to DINT
DW_R (Page 326) DWORD to REAL
DW_W (Page 326) DWORD to WORD
I_DI (Page 327) INT to DINT
|_DW (Page 327) INT to DWORD
|_R (Page 328) INT to REAL
|_W (Page 328) INT to WORD
W_BY (Page 329) WORD to BYTE
W_DW (Page/330) WORD to DWORD
W_I (Page 330) WORD to INT

Converting several BOOL values

The following instructions convert several BOOL type values into one BYTE, WORD or DWORD

type value:
Instruction Conversion
BO_BY (Page 319) BOOL to BYTE, 8 inputs
BO_DW (Page 320) BOOL to DWORD, 32 inputs
BO_W (Page 321) BOOL to WORD, 16 inputs

Conversion into several BOOL values

The following instructions convert one BYTE, WORD or DWORD type value into several BOOL

type values:
Instruction Conversion
BY_BO (Page 322) BYTE to BOOL, 8 outputs
DW_BO (Page 325) DWORD to BOOL, 32 outputs
W_BO (Page 329) WORD to BOOL, 16 outputs

See also

Overview of CFC instructions (Page 280)

318
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BO_BY: BOOL to BYTE conversion

Description

This instruction converts the eight BOOL type input values to a BYTE type value and applies it
to the output value.

The conversion is performed as follows:

The "n" output value bit is set to 0 or 1 if the corresponding input value "INn" has the value 0
or1.

Troubleshooting

N/A

Parameters
Parameters Declaration Data type Description Default
INn Input BOOL Input value "n" 0
Osn<s7
ouT Output BYTE Output value 0

See also

Overview of "CONVERT" instruction family (Page[317)

Configuring CFC charts
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BO_DW: BOOL to DWORD conversion

Description

Troubleshooting

Parameters

See also

320

This instruction converts the 32 BOOL type input values to a DWORD type value and applies it
to the output value.

The conversion is performed as follows:

The "n" output value bit is set to 0 or 1 if the corresponding input value "INn" has the value O

or1.

N/A

Parameters Declaration Data type Description Default
INn Input BOOL Input value "n" 0
O=n=<31

ouTt Output DWORD Output value 0

Overview of "CONVERT" instruction family (Page|317)

Configuring CFC charts
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BO_W: BOOL to WORD conversion

Description

This instruction converts the 16 BOOL type input values to a WORD type value and applies it
to the output value.

The conversion is performed as follows:

The "n" output value bit is set to 0 or 1 if the corresponding input value "INn" has the value 0
or1.

Troubleshooting

N/A

Parameters
Parameters Declaration Data type Description Default
INn Input BOOL Input value "n" 0
O=sn=<15
ouT Output WORD Output value 0

See also

Overview of "CONVERT" instruction family (Page[317)

Configuring CFC charts
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BY_BO: BYTE to BOOL conversion

Description

This instruction converts the input value of data type BYTE to 8 values of data type BOOL and
applies them to the 8 output values. The "n" bit in the input value is converted to the output
value OUTn.

Troubleshooting

N/A

Parameters
Parameters Declaration Data type Description Default
IN Input BYTE Input value 0
OUTn Output BOOL "n" output value 0
O<sn=<7

See also

Overview of "CONVERT" instruction family (Page(317)

BY_DW: BYTE to DWORD conversion

Description
Copies the byte of IN to the low-byte of OUT and sets the high-bytes to 0.

Troubleshooting

N/A
Parameters
Parameters Declaration Data type Description Default
IN Input BYTE Input value 0
ouTt Output DWORD Output value 0
See also

Overview of "CONVERT" instruction family (Page|317)

Configuring CFC charts
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BY_W: BYTE to WORD conversion

Description
Copies the byte of IN to the low-byte of OUT and sets the high-byte to 0.

Troubleshooting

N/A
Parameters
Parameters Declaration Data type Description Default
IN Input BYTE Input value 0
out Output WORD Output value 0
See also
Overview of "CONVERT" instruction family (Page|317)
DI_DW: DINT to DWORD conversion
Description
Copies the bit string of IN to OUT.
Troubleshooting
N/A
Parameters
Parameters Declaration Data type Description Default
IN Input DINT Input value 0
ouTt Output DWORD Output value 0
See also

Overview of "CONVERT" instruction family (Page|317)

Configuring CFC charts
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7.17 CFC charts: Reference

DI_I: DINT to INT conversion

Description

Converts the IN bit string to INT and copies the result to OUT.

Troubleshooting
If the values of IN lie outside the value range of -32 768 to 32 767, ENO = 0 and OUT is an

invalid value.
Parameters
Parameters Declaration Data type Description Default
IN Input DINT Input value 0
ouT Output INT Output value 0
See also
Overview of "CONVERT" instruction family (Page|317)
DI_R: DINT to REAL conversion
Description
Converts the value of IN to a REAL number and copies the result to OUT.
Troubleshooting
N/A
Parameters
Parameters Declaration Data type Description Default
IN Input DINT Input value 0
ouT Output REAL Output value 0
See also
Overview of "CONVERT" instruction family (Page|317)
Configuring CFC charts
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7.17 CFC charts: Reference

DW_BO: DWORD to BOOL conversion

Description

This instruction converts the input value of the DWORD data type to 32 values of the BOOL
data type, which are applied at the 32 output values. The "n" bit in the input value is

converted to the output value OUTn.

Troubleshooting

N/A
Parameters
Parameters Declaration Data type Description Default setting
IN Input DWORD Input value 0
OoUTn Output BOOL "n" output value 0
O0=<n=<31
See also
Overview of "CONVERT" instruction family (Page[317)
DW_DI: DWORD to DINT conversion
Description
Copies the bit string of IN to OUT.
Troubleshooting
N/A
Parameters
Parameters Declaration Data type Description Default
IN Input DWORD Input value 0
ouT Output DINT Output value 0
See also

Overview of "CONVERT" instruction family (Page|317)

Configuring CFC charts
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7.17 CFC charts: Reference

DW_R: DWORD to REAL conversion

Description

Troubleshooting

Parameters

See also

This instruction copies the bit string from IN to OUT. The instruction does not perform a value

change.

To achieve a value change to REAL, the combination of DW_Dl instruction and subsequent
DI_R instruction must be used.

DW_W: DWORD to WORD conversion

Description

Troubleshooting

Parameters

See also

326

N/A

Parameters Declaration Data type Description Default
IN Input DWORD Input value 0

ouT Output REAL Output value 0
Overview of "CONVERT" instruction family (Page|317)

Copies the low-word of IN to the word of OUT.

ENO = 0 if the IN high-word > 0

Parameters Declaration Data type Description Default
IN Input DWORD Input value 0

ouT Output WORD Output value 0

Overview of "CONVERT" instruction family (Page|317)

Configuring CFC charts
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I_DI: INT to DINT conversion

Description

Troubleshooting

Parameters

See also

I_DW: INT to DWORD conversion

Description

Troubleshooting

Parameters

See also

Configuring CFC charts
System Manual, 11/2022, A5E52420813-AA

Copies the value of IN to OUT.

7.17 CFC charts: Reference

N/A

Parameters Declaration Data type Description Default setting
IN Input INT Input value 0

out Output DINT Output value 0

Overview of "CONVERT" instruction family (Page|317)

Copies the bit string of IN to the low-word of OUT and sets the high-word to O.

N/A
Parameters Declaration Data type Description Default
IN Input INT Input value 0
ouTt Output DWORD Output value 0

Overview of "CONVERT" instruction family (Page|317)
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7.17 CFC charts: Reference

I_R: INT to REAL conversion

Description

Converts the integer value of IN to OUT.

Troubleshooting

N/A
Parameters
Parameters Declaration Data type Description Default
IN Input INT Input value 0
ouT Output REAL Output value 0
See also
Overview of "CONVERT" instruction family (Page|317)
I_W: INT to WORD conversion
Description
Copies the bit string of IN to OUT.
Troubleshooting
N/A
Parameters
Parameters Declaration Data type Description Default
IN Input INT Input value 0
ouT Output WORD Output value 0
See also
Overview of "CONVERT" instruction family (Page|317)
Configuring CFC charts
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7.17 CFC charts: Reference

W_BO: WORD to BOOL conversion

Description

This instruction converts the input value of the WORD data type to 16 values of the BOOL
data type, which are applied at the 16 output values. The "n" bit in the input value is
converted to the output value OUTn.

Troubleshooting

N/A
Parameters
Parameters Declaration Data type Description Default
IN Input WORD Input value 0
OoUTn Output BOOL “n" output value 0
O0=sn<15
See also
Overview of "CONVERT" instruction family (Page[317)
W_BY: WORD to BYTE conversion
Description
Copies the low-byte of IN to OUT.
Troubleshooting
If the high-byte > 0, then ENO = 0.
Parameters
Parameters Declaration Data type Description Default
IN Input WORD Input value 0
ouT Output BYTE Output value 0
See also

Overview of "CONVERT" instruction family (Page|317)

Configuring CFC charts
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7.17 CFC charts: Reference

W_DW: WORD to DWORD conversion

Description

Copies the word of IN to the low-word of OUT.

Error handling

N/A
Parameters
Parameters Declaration Data type Description Default
IN Input WORD Input value 0
ouT Output DWORD Output value 0
See also
Overview of "CONVERT" instruction family (Page|317)
W_I: WORD to INT conversion
Description
Copies the bit string of IN to OUT.
Troubleshooting
N/A
Parameters
Parameters Declaration Data type Description Default
IN Input WORD Input value 0
ouT Output INT Output value 0
See also
Overview of "CONVERT" instruction family (Page|317)
Configuring CFC charts
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7.17 CFC charts: Reference

Logic instructions (word logic operations)

Overview of the instruction families "WRD_LGC" and "MULTIPLX"

Overview of "MULTIPLX" instruction family
This family contains Multiplex instructions.

Depending on the input value K, one of the other input values IN is output at the output
value OUT.

MUX_BO (Page 334)

Multiplexer 1 of n for BOOL values

MUX_DI (Page|335)

Multiplexer 1 of n for DINT values

MUX_I (Page 336)

Multiplexer 1 of n for INT values

SEL_BO (Page 337)

Multiplexer 1 of 2 for BOOL values
Is replaced by SEL.

SEL_R (Page 337)

Multiplexer 1 of 2 for REAL values
Is replaced by SEL.

Overview of "WRD_LGC" instruction family

See also

Configuring CFC charts

This family contains logic instructions of the data type WORD and DWORD.

With these instructions you implement logical operations of the data types WORD and

DWORD.

DECO (Page 332) Decode
ENCO (Page/332) Encode
SEL (Page|333) Select

WAND_DW (Page 338)

Double word AND operation

WAND_W (Page/339)

Word AND operation

WNAND_DW (Page 340)

Double word NAND operation

WNAND_W (Page|341)

Word NAND operation

WNOR_DW (Page|342)

Double word NOR operation

WNOR_W (Page|343)

Word NOR operation

WNOT DW (Page|344)

Double word NOT operation

WNOT_W (Page 344

Word NOT operation

WOR_DW (Page|345)

Double word OR operation

WOR_W (Page 346)

Word OR operation

WXOR_DW (Page 347)

Double word exclusive-OR operation

WXOR_W (Page 348)

Word exclusive-OR operation

Overview of CFC instructions (Page 280)

System Manual, 11/2022, A5E52420813-AA
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7.17 CFC charts: Reference

DECO: Decode

Description

See also

ENCO: Encode

Description

See also

332

You can use the "Decode" instruction to set a bit in the output value specified by the input
value.

The "Decode" instruction reads the value at the IN input and sets the bit in the output value
whose bit position corresponds to the read value. The other bits in the output value are filled
with zeroes.

When the value at input IN is greater than 31, a modulo 32 instruction is executed.

TIA Portal Information System
Additional information in the information system of the TIA Portal:

¢ "PLC programming > Instructions > Basic instructions > FBD > Word logic operations >
DECO: Decode"

Overview of the instruction families "WRD_LGC" and "MULTIPLX" (Page|331)

The instruction "Encode" is used to read the bit number of the least significant bit in the input
value and output it to the output OUT.

The instruction "Encode" selects the least significant bit of the value at the IN input and writes
its bit number to the tag in the output OUT.

TIA Portal Information System

Additional information in the information system of the TIA Portal:

¢ "PLC programming > Instructions > Basic instructions > FBD > Word logic operations >
ENCO: Encode"

Overview of the instruction families "WRD_LGC" and "MULTIPLX" (Page|331)

Configuring CFC charts
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SEL: Select

Description

See also

Configuring CFC charts

7.17 CFC charts: Reference

Depending on the signal state at switch (input G), the "Select” instruction selects one of the
inputs INO or IN1 and moves its content to the output OUT.

¢ If the input G has signal state "0", the value at the INO input is moved.
¢ If the input G has signal state "1", the value at the IN1 input is moved to the output OUT.

The instruction can only be executed if the enable input EN has the signal state "1" and the
tags of all parameters are of the same data type.

Note
"SEL": Replaces "SEL_BO", "SEL_R"

The instruction "SEL" replaces the CFC instructions "SEL_BO" and "SEL_R".

These data type specific instructions are only available for reasons of compatibility in CFC.

TIA Portal Information System
Additional information in the information system of the TIA Portal:

¢ "PLC programming > Instructions > Basic instructions > FBD > Word logic operations > SEL:
Select”

Overview of the instruction families "WRD_LGC" and "MULTIPLX" (Page[331)
SEL_BO: Multiplexer 1 of 2 for BOOL values (Page|337)
SEL_R: Multiplexer 1 of 2 for REAL values (Page|337)
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7.17 CFC charts: Reference

MUX_BO: Multiplexer 1 of n for BOOL values

Description

Troubleshooting

Parameters

See also

334

This instruction is a multiplexer with the function "1 of n" for input values of data type BOOL.

The number of IN input parameters can be modified.

Depending on the input value K, one of the input parameters INO to INp is output at the
output parameter OUT.

Example:

With K =2, the input value IN2 is output at the output parameter OUT.

ENO=0andOUT=0,ifK>(n-1)orK<0.

Parameters Declaration Data type Description Default
K Input INT Selection value 0

INp Input BOOL Input value "p" 0
O<p=<(n-1)

ouT Output BOOL Output value 0

Overview of the instruction families "WRD_LGC" and "MULTIPLX" (Page|331)

Configuring CFC charts
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MUX_DI: Multiplexer 1 of n for DINT values

Description

Troubleshooting

Parameters

See also

Configuring CFC charts

System Manual, 11/2022, A5E52420813-AA

7.17 CFC charts: Reference

This instruction is a multiplexer with the function "1 of n" for input values of the DINT data

type.

The number of IN input parameters can be modified.

Depending on the input value K, one of the input parameters INO to INp is output at the
output parameter OUT.

Example:

With K = 2, the input value IN2 is output at the output parameter OUT.

ENO=0andOUT=0,ifK>(n-1)orK<D0.

Parameters Declaration Data type Description Default
K Input INT Selection value 0

INp Input DINT Input value "p" 0
O<p=s(n-1)

out Output DINT Output value 0

Overview of the instruction families "WRD_LGC" and "MULTIPLX" (Page|331)
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7.17 CFC charts: Reference

MUX_I: Multiplexer 1 of n for INT values

Description

Troubleshooting

Parameters

See also

336

This instruction is a multiplexer with the function "1 of n" for input values of data type INT.

The number of IN input parameters can be modified.

Depending on the input value K, one of the input parameters INO to INp is output at the
output parameter OUT.

Example:

With K = 2, the input value IN2 is output at the output parameter OUT.

ENO=0andOUT=0,ifK>(n-1)orK<0.

Parameters Declaration Data type Description Default
K Input INT Selection value 0

INp Input INT Input value "p" 0
O<p=<(n-1)

ouT Output INT Output value 0

Overview of the instruction families "WRD_LGC" and "MULTIPLX" (Page|331)

Configuring CFC charts
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SEL_BO: Multiplexer 1 of 2 for BOOL values

Description

Parameters

See also

Use the instruction "SEL (Page|333)".

The instruction "SEL_BO" is only available for reasons of compatibility in CFC. You can only
use the instruction for "BOOL" data types.

7.17 CFC charts: Reference

Depending on the input value K, this instruction switches the value of the input parameter
INO (K=0) orIN1 (K= 1) to the output parameter OUT.

Parameters Declaration Data type Description Default setting
K Input BOOL Selection input 0
INO Input BOOL Input value 1 0
IN1 Input BOOL Input value 2 0
out Output BOOL Output value 0

Overview of the instruction families "WRD_LGC" and "MULTIPLX" (Page|331)

SEL_R: Multiplexer 1 of 2 for REAL values

Description

Parameters

See also

Configuring CFC charts
System Manual, 11/2022, A5E52420813-AA

Use the instruction "SEL (Page|[333)".

The instruction "SEL_R" is only available for reasons of compatibility in CFC. You can only use

the instruction for "REAL" data types.

Depending on the input value K, this instruction switches the value of the input parameter
INO (K=0) orIN1 (K= 1) to the output parameter OUT.

Parameters Declaration Data type Description Default
K Input BOOL Selection input 0

INO Input REAL Input value 1 0.0

IN1 Input REAL Input value 2 0.0
out Output REAL Output value 0.0

Overview of the instruction families "WRD_LGC" and "MULTIPLX" (Page|331)
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7.17 CFC charts: Reference

WAND_DW: Double word AND operation

Description

This instruction generates double word logic AND operations at the input values. All input
value bits of the same significance are logically linked by AND; the result is written to the
corresponding output value bit.

The number of IN input parameters can be modified.

Example (two inputs)

IN1 2411110000 11110000 110100000000 0000

IN2 2#1111.0000 00110000 0011.000000000000

ouT 2#1111.0000 00110000 0001.000000000000
Parameters

Parameters Declaration Data type Description Default

IN1 Input DWORD Input value 1 16#FFFFFFFF

INn Input DWORD Input value "n" 16#FFFFFFFF

ouTt Output DWORD Output value 16#FFFFFFFF
See also

Overview of the instruction families "WRD_LGC" and "MULTIPLX" (Page|331)

Configuring CFC charts
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WAND_W: Word AND operation

Description

7.17 CFC charts: Reference

This instruction generates word logic AND operations at the input values. All input value bits
of the same significance are logically linked by AND; the result is written to the corresponding
output value bit.

The number of IN input parameters can be modified.

Example (two inputs)

IN1 2#1111.00001111.1101
IN2 241111.000000110011
ouT 241111.00000011.0001
Parameters
Parameters Declaration Data type Description Default
IN1 Input WORD Input value 1 16#FFFF
INn Input WORD Input value "n" 16#FFFF
out Output WORD Output value 16#FFFF
See also

Overview of the instruction families "WRD_LGC" and "MULTIPLX" (Page|331)

Configuring CFC charts
System Manual, 11/2022, A5E52420813-AA

339



Working with CFC charts for S7

7.17 CFC charts: Reference

WNAND_DW: Double word NAND operation

Description

This instruction generates double word logic NOT AND operations at the input values. All
input value bits of the same significance are logically linked by AND, then inverted and
written to the corresponding output value bit.

The number of IN input parameters can be modified.

Example (two inputs)

IN1 2411110000 11110000 110100000000 0000

IN2 2#1111.00000011.00000011.000000000000

ouT 2#0000.1111.1100.1111.1110. 111111111111
Parameters

Parameters Declaration Data type Description Default

IN1 Input DWORD Input value 1 16#FFFFFFFF

INn Input DWORD Input value "n" 16#FFFFFFFF

ouTt Output DWORD Output value 16#00000000
See also

Overview of the instruction families "WRD_LGC" and "MULTIPLX" (Page|331)

Configuring CFC charts
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7.17 CFC charts: Reference

WNAND_W: Word NAND operation

Description

This instruction generates word logic NOT AND operations at the input values. All input value
bits of the same significance are logically linked by AND, then inverted and written to the
corresponding output value bit.

The number of IN input parameters can be modified.

Example (two inputs)

IN1 2#1111.00001111.1101
IN2 241111.000000110011
ouT 2#0000.1111.1100.1110
Parameters
Parameters Declaration Data type Description Default
IN1 Input WORD Input value 1 16#FFFF
INn Input WORD Input value "n" 16#FFFF
out Output WORD Output value 16#0000
See also

Overview of the instruction families "WRD_LGC" and "MULTIPLX" (Page|331)
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7.17 CFC charts: Reference

WNOR_DW: Double word NOR operation

Description

This instruction generates double word logic NOT OR operations at the input values. All input
value bits of the same significance are logically linked by OR. The result is then inverted and
written to the corresponding output value bit.

The number of IN input parameters can be modified.

Example (two inputs)

IN1 2411110000 11110000 110100000000 0000

IN2 2#1111.0000 00110000 0011.000000000000

ouT 2#0000.1111.0000.1111.0000. 111111111111
Parameters

Parameters Declaration Data type Description Default

IN1 Input DWORD Input value 1 0

INn Input DWORD Input value "n" 0

out Output DWORD Output value 0
See also

Overview of the instruction families "WRD_LGC" and "MULTIPLX" (Page|331)

Configuring CFC charts
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7.17 CFC charts: Reference

WNOR_W: Word NOR operation

Description

This instruction generates word logic NOT OR operations at the input values. All input value
bits of the same significance are logically linked by OR. The result is then inverted and written
to the corresponding output value bit.

The number of IN input parameters can be modified.

Example (two inputs)

IN1 2#1111.00001111.1101
IN2 241111.000000110011
ouT 2#0000.1111.0000 0000
Parameters
Parameters Declaration Data type Description Default
IN1 Input WORD Input value 1 0
INn Input WORD Input value "n" 0
out Output WORD Output value 0
See also

Overview of the instruction families "WRD_LGC" and "MULTIPLX" (Page|331)

Configuring CFC charts
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7.17 CFC charts: Reference

WNOT_DW: Double word NOT operation

Description
This instruction inverts the input value word. Each bit of the input value is inverted and
written to the output value bit of the corresponding significance.
Example
IN 2411110000 111100001101.000000000000
ouT 2#0000.11110000111100101111.1111.1111
Parameters
Parameters Declaration Data type Description Default
IN Input DWORD Input value 0
out Output DWORD Output value 1
See also

Overview of the instruction families "WRD_LGC" and "MULTIPLX" (Page|331)

WNOT_W: Word NOT operation

Description
This instruction inverts the input word. Each bit of the input value is inverted and written to
the output value bit of the corresponding significance.
Example
IN 2#1111.0000.1111.1101
ouT 2#0000.1111.0000 0010
Parameters
Parameters Declaration Data type Description Default
IN Input WORD Input value 0
ouTt Output WORD Output value 1
See also

Overview of the instruction families "WRD_LGC" and "MULTIPLX" (Page|331)

Configuring CFC charts
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WOR_DW: Double word OR operation

Description

7.17 CFC charts: Reference

This instruction generates double word logic OR operations at the input values. All input
value bits of the same significance are logically linked by OR; the result is written to the

corresponding output value bit.

The number of IN input parameters can be modified.

Example (two inputs)

IN1T 2411110000 11110000 1101.000000000000

IN2 2#1111.0000 00110000 0011.000000000000

ouT 2#1111.0000.17111.0000.1111.000000000000
Parameters

Parameters Declaration Data type Description Default

IN1 Input DWORD Input value 1 0

INn Input DWORD Input value "n" 0

out Output DWORD Output value 0
See also

Overview of the instruction families "WRD_LGC" and "MULTIPLX" (Page|331)

Configuring CFC charts
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7.17 CFC charts: Reference

WOR_W: Word OR operation

Description

This instruction generates word logic OR operations at the input values. All input value bits of
the same significance are logically linked by OR; the result is written to the corresponding
output value bit.

The number of IN input parameters can be modified.

Example (two inputs)

IN1 2#1111.00001111.1101

IN2 241111.000000110011

ouT 2#1111.0000.1111.1111
Parameters

Parameters Declaration Data type Description Default

IN1 Input WORD Input value 1 0

INn Input WORD Input value "n" 0

out Output WORD Output value 0
See also

Overview of the instruction families "WRD_LGC" and "MULTIPLX" (Page|331)

Configuring CFC charts
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7.17 CFC charts: Reference

WXOR_DW: Double word exclusive-OR operation

Description

This instruction generates double word logic exclusive-OR operations at the input values. All
input value bits of the same significance are logically linked by exclusive-OR; the result is
written to the corresponding output value bit. The bitis O if all input bits of the same
significance have the same value. Otherwise, the bitis 1.

The number of IN input parameters can be modified.

Example (two inputs)

IN1T 2411110000 111111010000 000000000000

IN2 24#1111.00000011.0011.0000000000000000

ouT 240000.0000.1100.1110 0000 000000000000
Parameters

Parameters Declaration Data type Description Default

IN1 Input DWORD Input value 1 16#0

INn Input DWORD Input value "n" 16#0

ouT Output DWORD Output value 16#00000000
See also

Overview of the instruction families "WRD_LGC" and "MULTIPLX" (Page|331)
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7.17 CFC charts: Reference

WXOR_W: Word exclusive-OR operation

Description

This instruction generates word logic exclusive-OR operations at the input values. All input

value bits of the same significance are logically linked by exclusive-OR; the result is written to
the corresponding output value bit. The bit is O if all input value bits of the same significance
have the same value. Otherwise, the bitis 1.

The number of IN input parameters can be modified.

Example (two inputs)

Parameters

See also

348

IN1 2#1111.00001111.1101

IN2 241111.00000011.0011

out 240000 0000 11001110

Parameters Declaration Data type Description Default
IN1 Input WORD Input value 1 0

INn Input WORD Input value "n" 0

out Output WORD Output value 0

Overview of the instruction families "WRD_LGC" and "MULTIPLX" (Page|331)
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7.17 CFC charts: Reference

Instructions for shifting and rotating

Overview of "SHIFT" instruction family

Overview
In this family, instructions for shifting and rotating are grouped together.
You use the instructions to shift or rotate input-value bits and have the result output at the
output value.
ROL_DW (Page|350) DWORD rotate left
ROL_W (Page 351) WORD rotate left
ROR_DW (Page 352) | DWORD rotate right
ROR_W (Page 353) WORD rotate right
SHL_DW (Page 354) DWORD shift left
SHL W (Page 355) WORD shift left
SHR_DW (Page|356) DWORD shift right
SHR_W (Page 357) WORD shift right
See also

Overview of CFC instructions (Page 280)

Configuring CFC charts
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7.17 CFC charts: Reference

ROL_DW: Rotate DWORD to left

Description
The bits of input value IN are rotated left by the number of steps specified in input value N.
The bit positions freed by rotating are filled with the bit positions that are pushed out. The
status of the bits remains intact.
The result is stored at output parameter OUT.
Example of N = 3 and the DWORD data type:
Bit Bit
31 0
IN |1010|1111|0000|11001010111100001100
\ v J
N ‘_, N=3 J—‘
4 A Y
our| [011 1[1000[]0110[0o101[0o111]1000[0110[]0101
\_Y_J'
A
Parameters
Parameters Declaration Data type Description Default
IN Input DWORD Input value 0
N Input WORD Number of bit positions by 0
which the value IN is rotated.
ouT Output DWORD Output value 0
See also
Overview of "SHIFT" instruction family (Page|349)
Configuring CFC charts
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7.17 CFC charts: Reference

ROL_W: Rotate WORD to left

Description

The bits of input value IN are rotated left by the number of steps specified in input value N.
The bit positions freed by rotating are filled with the bit positions that are pushed out. The
status of the bits remains intact.
The result is stored at output parameter OUT.
Example of N = 3:

Bit Bit

15 0
IN 101 0111 1|{000 01100

L_W_’ L J
N R [ —

A

I 1

ouT 0111100 0[0110|010 1
[——
4
Parameters
Parameters Declaration Data type Description Default
IN Input WORD Input value 0
N Input WORD Number of bit positions |0
by which the value IN is
rotated.
ouT Output WORD Output value 0
See also

Configuring CFC charts
System Manual, 11/2022, A5E52420813-AA
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7.17 CFC charts: Reference

ROR_DW: Rotate DWORD to right

Description
The bits of input value IN are rotated right by the number of steps specified in input value N.
The bit positions freed by rotating are filled with the bit positions that are pushed out. The
status of the bits remains intact.
The result is stored at output parameter OUT.
Example of N = 3 and the DWORD data type:
Bit Bit
31 0
IN 1010[111 1[{0000f1100[1010[1111]0000][110 0]
¥ Y N
N |—‘ N=3 |—>

oOUT |100{1|0101 1110|000 1 1001|o101|1110|0001|

A

Parameters

See also

352

Parameters Declaration Data type Description Default

IN Input DWORD Input value 0

N Input WORD Number of bit positions by 0
which the value IN is rotated.

ouTt Output DWORD Output value 0

Overview of "SHIFT" instruction family (Page|349)

Configuring CFC charts
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7.17 CFC charts: Reference

ROR_W: Rotate WORD to right

Description
The bits of input value IN are rotated right by the number of steps specified in input value N.
The bit positions freed by rotating are filled with the bit positions that are pushed out. The
status of the bits remains intact.
The result is stored at output parameter OUT.
Example of N = 3:
Parameters
Parameters Declaration Data type Description Default
IN Input WORD Input value 0
N Input WORD Number of bit 0
positions by which the
value IN is rotated.
ouT Output WORD Output value 0
See also

Overview of "SHIFT" instruction family (Page 349)
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7.17 CFC cha

SHL_DW: M

Description

rts: Reference

ove DWORD to left

The bits of input value IN are shifted left by the number of steps specified in input value N.

The low-order bit positions freed by rotating are assigned the value "0". The high-order bit
positions that are pushed out are lost.

The result is stored at output parameter OUT.
Example of N = 3 and the DWORD data type:
Bit Bit
31 0
[1o1o0[1111]oo00o0f[1100[1010[1111]0000[1100
\ J

Y

N=3

)
[ ] "o"

ouT

Parameters

See also

354

A

|{0111|1000|0110|0000 011 1|1000[011 0 0\000

Parameters Declaration Data type Description Default

IN Input DWORD Input value 0

N Input WORD Number of bit positions by 0
which the value IN is shifted.

out Output DWORD Output value 0

Overview of "SHIFT" instruction family (Page|349)
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7.17 CFC charts: Reference

SHL_W: Move WORD to left

Description

Parameters

See also

Configuring CFC charts

System Manual, 11/2022, A5E52420813-AA

The bits of input value IN are shifted left by the number of steps specified in input value N.

The low-order bit positions freed by rotating are assigned the value "0". The high-order bit
positions that are pushed out are lost.

The result is stored at output parameter OUT.

Example of N = 3:

Bit Bit
15 0
IN 101 0 1 % g = 000 O 110 0
[ ]
N T N=3
i_x_l { 0
i A 1
ouT |o111|1000|0110|0000
Parameters Declaration Data type Description Default
IN Input WORD Input value 0
N Input WORD Number of bit 0
positions by which the
value IN is shifted.
ouT Output WORD Output value 0

Overview of "SHIFT" instruction family (Page 349)
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7.17 CFC charts: Reference

SHR_DW: Move DWORD to right

Description
The bits of input value IN are shifted right by the number of steps specified in input value N.
The high-order bit positions freed by shifting are assigned the value "0". The low-order bit
positions that are pushed out are lost.
The result is stored at output parameter OUT.
Example of N = 3 and the DWORD data type:
Bit Bit
3 0
IN 1010|1111|0000|11oo101011110000|1100|
. ~ J H_}
N N=3 |_.r1><‘ 0]
“O“ [ —_— ]
A
i A}
OUT 0001|0101|1110|0001000101011110|0001|
Parameters
Parameters Declaration Data type Description Default
IN Input DWORD Input value 0
N Input WORD Number of bit positions by 0
which the value IN is shifted.
out Output DWORD Output value 0
See also
Overview of "SHIFT" instruction family (Page|349)
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7.17 CFC charts: Reference

SHR_W: Move WORD to right

Description
The bits of input value IN are shifted right by the number of steps specified in input value N.
The high-order bit positions freed by shifting are assigned the value "0". The low-order bit
positions that are pushed out are lost.
The result is stored at output parameter OUT.
Example of N = 3:
Bit Bit
15 0
IN 101 0[1111[0000[1100]
\ T ———
N N=3 | reNg -1
I 1 0|
" 1 I— N
A
i 1
ouT looo 1{o101[111 0000 1]
Parameters
Parameters Declaration Data type Description Default
IN Input WORD Input value 0
N Input WORD Number of bit 0
positions by which the
value IN is shifted.
out Output WORD Output value 0
See also

Overview of "SHIFT" instruction family (Page 349)
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7.17 CFC charts: Reference

7.17.2.4

CFCinstructions: Extended instructions

CFC instructions - Extended instructions: Date and time-of-day

CFCinstructions: Date and time-of-day

See also

358

The CFC instructions can be found in the "Instructions” task card in the "Extended

instructions" pane.

You can find descriptions of the individu

al instructions in the TIA Portal Information System:

e "PLC programming > Instructions > Extended instructions > Date and time-of-day"

Instruction Folder Function

T_ADD Date and time-of-day Add times

T_COMBINE Date and time-of-day Combine times

T_COMP Date and time-of-day Compare time tags
T_CONV Date and time-of-day Convert times and extract
T_DIFF Date and time-of-day Time difference

T SUB Date and time-of-day Subtract times

RD LOC T Clock functions Read local time

RD SYS T Clock functions Read time-of-day

RTM Clock functions

Runtime meters

SET_TIMEZONE | Clock functions

Set time zone

SNC_RTCB Clock functions Synchronize slave clocks
TIME_TCK Clock functions Read system time
WR_LOC T Clock functions Write local time

WR SYS T Clock functions Set time-of-day

Overview of CFC instructions (Page 280)
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7.17 CFC charts: Reference

CFCinstructions - Extended instructions: String + Char

CFCinstructions: String + Char

See also

Configuring CFC charts

System Manual, 11/2022, A5E52420813-AA

The CFC instructions can be found in the "Instructions” task card in the "Extended
instructions" pane.

You can find descriptions of the individual instructions in the TIA Portal Information System:

¢ "PLC programming > Instructions > Extended instructions > String + Char"

Instruction Folder Function

CONCAT String + Char Combine character strings

DELETE String + Char Delete characters in a character string

FIND String + Char Find characters in a character string

INSERT String + Char Insert characters in a character string

LEFT String + Char Read the left characters of a character string
LEN String + Char Determine the length of a character string
MID String + Char Read the middle characters of a character string
REPLACE String + Char Replace characters in a character string
RIGHT String + Char Read the right characters of a character string
S_COMP String + Char Compare character strings

S_MOVE String + Char Move character string

STRG_VAL String + Char Convert character string to numerical value
VAL_STRG String + Char Convert numerical value to character string

Overview of CFC instructions (Page 280)
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7.17 CFC charts: Reference

CFCinstructions - Extended instructions: Process image

CFCinstructions: Process image

See also

360

The CFC instructions can be found in the "Instructions"” task card in the "Extended
instructions" pane.

You can find descriptions of the individual instructions in the TIA Portal Information System:

¢ "PLC programming > Instructions > Extended instructions > Process image"

Instruction Folder Function

SYNC_PI Process image Synchronize the process image inputs
SYNC_PO Process image Synchronize the process image outputs
UPDAT PI Process image Update the process image inputs
UPDAT_PO Process image Update the process image outputs

Overview of CFC instructions (Page 280)
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7.17 CFC charts: Reference

CFC instructions - Extended instructions: Distributed 1/0

CFC instructions: Distributed 1/0

The CFC instructions can be found in the "Instructions” task card in the "Extended

instructions" pane.

You can find descriptions of the individual instructions in the TIA Portal Information System:

e "PLC programming > Instructions > Extended instructions > Distributed /0"

Instruction Folder Function

Distributed 1/0
D_ACT_DP DP & PROFINET Enable/disable DP slaves
GETIO DP & PROFINET Read process image
GETIO_PART DP & PROFINET Read process image area
RALRM DP & PROFINET Receive interrupt
RDREC DP & PROFINET Read data record
ReconfiglOSystem | DP & PROFINET Reconfigure 10 system
SETIO DP & PROFINET Transfer process image
SETIO_PART DP & PROFINET Transfer process image area
WRREC DP & PROFINET Write data record

Others
WR_REC Others Write data record to 1/O
PRVREC iDevice | iSlave Make data record available
RCVREC iDevice | iSlave Receive data record
DPSYC_FR PROFIBUS Synchronize DP slaves/Freeze inputs

See also

Overview of CFC instructions (Page 280)
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7.17 CFC charts: Reference

CFCinstructions - Extended instructions: Diagnostics

CFCinstructions: Diagnostics

See also

362

The CFC instructions can be found in the "Instructions"” task card in the "Extended
instructions" pane.

You can find descriptions of the individual instructions in the TIA Portal Information System:

¢ "PLC programming > Instructions > Extended instructions > Diagnostics"

Instruction Folder Function

RT_INFO Diagnostics Read runtime statistics

Get_IM_Data Diagnostics Reading identification and maintenance data
Get_Name Diagnostics Reading the name of a module
GetStationInfo | Diagnostics Read information of an 10 device

Overview of CFC instructions (Page 280)
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7.17.2.5 CFC instructions: Communication

CFC instructions - Communication: S7 communication

CFC instructions: S7 communication

The CFC instructions can be found in the "Instructions” task card in the "Communication”

pane.

7.17 CFC charts: Reference

You can find descriptions of the individual instructions in the TIA Portal Information System:

¢ "PLC programming > Instructions > Communication > S7 communication"

Instruction Folder Function

BRCV Others Receive data in segments
BSEND Others Send data in segments
URCV Others Receive data uncoordinated
USEND Others Send data uncoordinated

See also

CFCinstructions - Communication: Open User Communication (Page 364)

Overview of CFC instructions (Page 280)
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7.17 CFC charts: Reference

CFC instructions - Communication: Open User Communication

CFC instructions: Open User Communication

See also

364

The CFC instructions can be found in the "Instructions” task card in the "Communication”
pane.

You can find descriptions of the individual instructions in the TIA Portal Information System:

¢ "PLC programming > Instructions > Communication > Open User Communication"

Instruction Folder Function

TRCV_C Open User Communication *) Establishing a connection and receiving data
TSEND _C Open User Communication *) Establishing a connection and sending data
T_CONFIG Others Configure interface

T_DIAG Others Checking the connection

T _RESET Others Resetting the connection

TCON Others Establish communication connection
TDISCON Others Terminate communication connection

TRCV Others Receive data via communication connection
TSEND Others Send data via communication connection

*) Version selection
You can select different versions of the "Open User Communication" group.

After the first import of the instructions into a CFC chart you can no longer change the
version.

The same version is always used for each future import.

CFCinstructions - Communication: S7 communication (Page|363)

Overview of CFC instructions (Page 280)
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8.1 Export/Import of CFC charts

The TIA Portal Openness API supports the export and import of charts that are created with
STEP 7 CFC ("Continuous Function Chart").

You can export and import all charts as XML files, or export only selected charts.

8

You call these functions for defined tasks outside the TIA Portal by means of the Public API.

Note

Recommended PC hardware

If you are working with large projects, check that the computer meets the TIA Portal
hardware requirements:

RAM:
32 GB for large projects

Functions

The following functions are available for CFC charts:

Exporting CFC charts (Page 367)

Exporting only selected CFC charts (Page|369)

Importing CFC charts (Page|371)

Configuring chart passwords:

Setting a password for CFC charts (Page 373)
Reading the password from CFC charts (Page 375)
Changing a password for CFC charts (Page 377)

Removing a password from CFC charts (Page 379)

The function descriptions contain code samples that you can adapt to your openness
program.

Configuring CFC charts
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8.1 Export/import of CFC charts

Security measures for TIA Portal Openness applications
It is recommended
¢ toinstall a TIA Portal Openness application with admin rights to the programs folder.

¢ to avoid the dynamical loading of program parts like assemblies or dlls from the users
area.

¢ torun the TIA Portal Openness application with user rights.

Note

Siemens is not liable for and does not guarantee the compatibility of the data and
information transported via these interfaces with third-party software.

We expressly point out that improper use of the interfaces can result in data loss or
production downtimes.

Note

There are no obligations or guarantees of any kind associated with using this description to
manually modify and evaluate the source file.

Siemens therefore accepts no liability arising from the use of all or part of this description.

If you import externally created configuration data that contains code errors, a wrong
structure or unwanted manipulations, this can cause unexpected errors and security risks.

AWARNING

The APl user is responsible for ensuring the security measures of handling passwords
through code.

More information in the TIA Portal Openness documentation:

¢ "Readme TIA Portal Openness"

¢ "Basics > Openness tasks > Introduction”

¢ "TIA Portal Openness APl > General functions > TIA Portal Openness firewall"

¢ "TIA Portal Openness APl > Functions for accessing the data of a PLC device > Functions for
downloading data to PLC device > Downloading to PLC devices"

* "Export/import > Overview > Basic principles of importing/exporting"

Configuring CFC charts
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8.2

Requirements

Application

8.2 Exporting CFC charts

Exporting CFC charts

¢ The TIA Portal Openness application is connected to the TIA Portal.
See "Connecting to the TIA Portal"

e A project is open.
See "Opening a project"

e PLCis not online.

¢ The CFC charts to be exported are not password-protected.

CFC charts with a configured password are ignored during export.

The TIA Portal Openness APl supports the export of CFC charts to an XML file with the
function "CompleteExport".

The function writes the CFC project data from the chart folder into an XML file:
e All CFC charts created under the selected PLC

¢ Block types used in the exported charts

e Task assignment for the exported charts

¢ Run sequence of each exported chart

You find more information on the supported objects in the CFC documentation: "Instructions
and blocks (Page 25)".

If you want to start a selective XML export of CFC charts, use the function "SelectiveExport
(Page 369)".

Parameters

Parameter Data type Description

xmlFilePath String Folder path and name of the import file
modelVersion String S7TIA exchange model version to be used
filter Int64 Filter options for the automation interface
unattended Boolean Toggle for silent mode

Configuring CFC charts
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8.2 Exporting CFC charts

Program code

Modify the following program code to export all CFC charts from a PLC with their objects to

an XML file.
plcSoftware = (PlcSoftware) swContainer.Software;
chartProvider = plcSoftware.GetService<ChartProviderS7>();
if (chartProvider == null) // in case that CFC is not installed
return;

// Export CFC charts:
// XML file information for export

chartProvider.CompleteExport (@"D:\Users\usernamel\Documents\Automation\OpennessExample
.xml", "Vv1.0", 0, true);

More information in the TIA Portal Openness documentation:

"Export/import > Overview > Exporting configuration data"

See also

Export/Import of CFC charts (Page|365)

Configuring CFC charts
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8.3

Requirements

Application

8.3 Exporting only selected CFC charts

Exporting only selected CFC charts

The TIA Portal Openness application is connected to the TIA Portal.
See "Connecting to the TIA Portal"

A project is open.

See "Opening a project"

PLC is not online.

The CFC charts to be exported are not password-protected.

CFC charts with a configured password are ignored during export.

The TIA Portal Openness APl supports the export of specific CFC charts to an XML file with the
function "SelectiveExport".

The function writes the project data for only the selected charts into an XML file:

Specific CFC charts from the selected PLC
Block types used in the exported charts
Task assignment for the exported charts

Run sequence of each exported chart

You find more information on the supported objects in the CFC documentation: "Instructions
and blocks (Page 25)".

If you want to start a complete XML export of all CFC charts, use the function
"CompleteExport (Page|367)".

Parameters

Parameter Data type Description

xmlFilePath String Folder path and name of the import file
selectedObjects String(] Names of the charts that you want to export
modelVersion String S7TIA exchange model version to be used
filter Int64 Filter options for the automation interface
unattended Boolean Toggle for silent mode

Configuring CFC charts
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8.3 Exporting only selected CFC charts

Program code

Modify the following program code to export only selected CFC charts with their objects to an

XML file.
plcSoftware = (PlcSoftware) swContainer.Software;
chartProvider = plcSoftware.GetService<ChartProviderS7>();
if (chartProvider == null) // in case that CFC is not installed
return;

// Export selected CFC charts
// XML file information for export of CFC charts "CFC 1" and "CFC_3"
chartProvider.SelectiveExport (@"D:\Users\usernamel\Documents\Automation\OpennessExampl

e.xml", new string[] { "CrC_1", "CFC 3" }, "V1.0", O, true);

More information in the TIA Portal Openness documentation:

"Export/import > Overview > Exporting configuration data"

See also

Export/Import of CFC charts (Page|365)

Configuring CFC charts
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8.4 Importing CFC charts

8.4 Importing CFC charts

Requirements

¢ The TIA Portal Openness application is connected to the TIA Portal.
See "Connecting to the TIA Portal"

e A project is open.
See "Opening a project"

e PLCis not online.

Application

The TIA Portal Openness APl supports the import of CFC charts from an XML file with the
function "Import".

The XML file is created by a complete XML export or by a selective XML export of specific CFC

charts.

Parameters

Parameter Data type Description

xmlFilePath String Folder path and name of the import file

modelVersion String S7TIA exchange model version to be used

filter Int64 Filter options for the automation interface

unattended Boolean Toggle for silent mode

deleteAtTarget Boolean Toggle for deleting objects in the TIA project that were not

included in the original export file

Program code
Modify the following program code to import CFC charts from an XML file.

plcSoftware = (PlcSoftware) swContainer.Software;

chartProvider = plcSoftware.GetService<ChartProviderS7>();
if (chartProvider == null) // in case that CFC is not installed

return;

// Import CFC charts
// XML file information for import

chartProvider.Import (@"D:\Users\usernamel\Documents\Automation\OpennessExample.xml",
"v1.0", 0, true, false);

More information in the TIA Portal Openness documentation:

¢ "Export/import > Overview > Importing configuration data"

Configuring CFC charts
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8.4 Importing CFC charts

See also
Export/Import of CFC charts (Page|365)

Configuring CFC charts
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8.5 Setting a password for CFC charts

8.5 Setting a password for CFC charts
Requirements

¢ The TIA Portal Openness application is connected to the TIA Portal.
See "Connecting to the TIA Portal"

e A project is open.
See "Opening a project"

e PLCis not online.

Application

To protect a CFC chart or hierarchical CFC chart from unintentional editing, you can protect
the chart with a password.

¢ To configure a password, use the function "AddChartProtection".
¢ To change an existing password, use the function "ChangeChartProtection (Page|377)".

e To read the password from a chart as a hash value, use the function "GetChartProtection
(Page 375)".

¢ To delete the configured password, use the function "RemoveChartProtection (Page|379)".

NOTICE

Password: No authorization, no know-how protection of the charts
The password merely protects the CFC chart from unintentional editing.
This type of access protection is not intended to increase the access security.

The password does not offer:
e Protection against unauthorized access to know-how in CFC charts
» Security-relevant authorization for access to CFC charts

Parameters
Parameter Data type Description
chartName System.String | Name of the chart which is protected with a password.

newHashedPassword System.String | Password

The password is displayed as a hash value.

Return value

The function "AddChartProtection” returns a System.Boolean:

TRUE The password was set successfully.
FALSE The password could not be set.

Configuring CFC charts
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8.5 Setting a password for CFC charts

Program code

Modify the following program code to set a password for a CFC chart.

In this example, the hash value of the new password is included as an abbreviated example
value.

plcSoftware = (PlcSoftware) swContainer.Software;

chartProvider = plcSoftware.GetService<ChartProviderS7>();

if (chartProvider == null) // in case that CFC is not installed
return;

// Configure CFC chart password
bool added = chartProvider.AddChartProtection("CFC 1", "AgGUWg...92M=");

See also

Export/Import of CFC charts (Page 365)

Configuring CFC charts
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8.6 Reading the password from CFC charts

8.6 Reading the password from CFC charts
Requirements

¢ The TIA Portal Openness application is connected to the TIA Portal.
See "Connecting to the TIA Portal"

e A project is open.
See "Opening a project"

e PLCis not online.

Application
To read the password from a CFC chart, use the function "GetChartProtection".

You can change or delete that password with the functions "ChangeChartProtection
(Page 377)" and "RemoveChartProtection (Page|379)".

NOTICE

Password: No authorization, no know-how protection of the charts

The password merely protects the CFC chart from unintentional editing.
This type of access protection is not intended to increase the access security.

The password does not offer:
e Protection against unauthorized access to know-how in CFC charts
* Security-relevant authorization for access to CFC charts

Parameters
Parameter Data type Description
chartName System.String | Name of the chart which is protected with a password.

Return value

The function "GetChartProtection" returns a System.Boolean:

TRUE The password was read successfully.
FALSE The password could not be read.

Configuring CFC charts
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8.6 Reading the password from CFC charts

Program code

Modify the following program code to read a password from a CFC chart.

plcSoftware = (PlcSoftware) swContainer.Software;

chartProvider = plcSoftware.GetService<ChartProviderS7>();

if (chartProvider == null) // in case that CFC is not installed
return;

// Read CFC chart password

string passwordHash = chartProvider.GetChartProtection ("CFC 1");

See also

Setting a password for CFC charts (Page|373)
Export/Import of CFC charts (Page 365)

Configuring CFC charts
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8.7

Requirements

Application

Configuring CFC charts

8.7 Changing a password for CFC charts

Changing a password for CFC charts

¢ The TIA Portal Openness application is connected to the TIA Portal.
See "Connecting to the TIA Portal"

e A project is open.
See "Opening a project"

e PLCis not online.

To change the password that is used to protect a CFC chart or hierarchical CFC chart from
unintentional editing, use the function "ChangeChartProtection”.

You can read or delete a password with the functions "GetChartProtection (Page 375)" and
"RemoveChartProtection (Page 379)".

NOTICE
Password: No authorization, no know-how protection of the charts

The password merely protects the CFC chart from unintentional editing.
This type of access protection is not intended to increase the access security.

The password does not offer:
e Protection against unauthorized access to know-how in CFC charts
* Security-relevant authorization for access to CFC charts

Parameters
Parameter Data type Description
chartName System.String Name of the chart which is protected with a
password.
currentPassword System.Security.Secure | Currently used password for the CFC chart.
String
newHashedPassword System.String New Password
The password is displayed as a hash value.

Return value

The function "ChangeChartProtection” returns a System.Boolean:

TRUE The password was changed successfully.
FALSE The password could not be changed.
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8.7 Changing a password for CFC charts

Program code
Modify the following program code to change a password for a CFC chart.

In this example, the password "test" is changed to a new password. The hash value of the
new password is included as an abbreviated example value.

plcSoftware = (PlcSoftware) swContainer.Software;

chartProvider = plcSoftware.GetService<ChartProviderS7>();
if (chartProvider == null) // in case that CFC is not installed
return;

// Change CFC chart password
char[] passwordl = new char[] {'t', 'e', 's', 't'};

SecureString securePasswordl = new SecureString();
foreach (char ch in passwordl)
securePasswordl.AppendChar (ch) ;

bool changed = chartProvider.ChangeChartProtection("CFC 1", securePasswordl,
"AgGUWqg. ..92M=") ;

See also
Setting a password for CFC charts (Page|373)
Export/Import of CFC charts (Page|365)
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8.8

Requirements

Application

Configuring CFC charts

8.8 Removing a password from CFC charts

Removing a password from CFC charts

¢ The TIA Portal Openness application is connected to the TIA Portal.
See "Connecting to the TIA Portal"

e A project is open.
See "Opening a project"

e PLCis not online.

To delete a configured password for a CFC chart, use the function "RemoveChartProtection".
The CFC chart can then be opened and edited again without entering a password.

To set the password again, use the function "AddChartProtection (Page|[373)".

NOTICE
Password: No authorization, no know-how protection of the charts

The password merely protects the CFC chart from unintentional editing.
This type of access protection is not intended to increase the access security.

The password does not offer:
e Protection against unauthorized access to know-how in CFC charts
» Security-relevant authorization for access to CFC charts

Parameters
Parameter Data type Description
chartName System.String Name of the chart which is protected with a
password.
currentPassword System.Security.Secure | Currently used password for the CFC chart.
String

Return value

The function "RemoveChartProtection” returns a System.Boolean:

TRUE The password was deleted successfully.
FALSE The password could not be deleted.
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8.8 Removing a password from CFC charts

Program code
Modify the following program code to remove a password for a CFC chart.
In this example, the password "test" was configured for the chart "CFC_1".

plcSoftware = (PlcSoftware) swContainer.Software;

chartProvider = plcSoftware.GetService<ChartProviderS7>();
if (chartProvider == null) // in case that CFC is not installed
return;

// Remove CFC chart password
char[] passwordl = new char[] {'t', 'e', 's', 't'};

SecureString securePasswordl = new SecureString();
foreach (char ch in passwordl)
securePasswordl.AppendChar (ch) ;

bool removed = chartProvider.RemoveChartProtection ("CFC 1", securePasswordl);

See also
Changing a password for CFC charts (Page 377)
Reading the password from CFC charts (Page 375)
Export/Import of CFC charts (Page|365)
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A

ABS DI, 305
ABS 1,306
ABS_R, 304
Absolute value
DINT, 305
INT,|306
REAL, 304
Access protection
CFC chart, 35/81//82/ 84
Alarm
CFC, 275
AND,|287
AND operation, 287
generic, DWORD,|338
WORD, 339
Arithmetic instructions,|302
Attribute, (see: Parameters)

B

Basic chart, (see: CFC chart)
BIT logic instructions,| 285
BIT_LGC,/285
Block
CFC chart, 27,94
Importing in the CFC,|243
BO_DW,[320
BO_W, 321
BY BO,|322
BY DW, 322
BY_W,/323

C

CFC, (see: CFC chart), 76,107
Textual interconnection, 156, 159
CFC
Attributes, 124
Block, 106
Block instance, 111//246
Block type, 121
Data flow, 112
Hierarchy, 87,89,91
Interconnection, 132//134, 143, 150//151, 152
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Parameter, 122, 132/134,/143
Text field, 110
CFC
Textual interconnection
CFC
Testing, 171//176, 182|184, 258
CFC
Testing
CFC
Testing
CFC
Testing
CFC
Data types, (see: CFC data type)
CFC
Chart sequence & extras,|235
CFC
Block instance
CFC
Icons, 248
CFC
Online/Offline, 248
CFC
Compiling, 251
CFC
Download,| 252
CFC
Testing
CFC
IPE Inter-Project Engineering, 265
CFC
Alarm,|275

CFCchart,[13) 23] 24//36)/39, 41, 61//64) 69, 71,7386

Access protection,[35, 81, 82//84
Alarm, 272

Block, 25, 94//104, 108, 113,/230, 237
Block icon,/ 101

Block instance,/ 27,101,115, 119
Block type,|27,115

Chart sequence and extras, 47/ 241
Compiling, 249

Control flow, 24

Data flow, 24

Download, 254

Downloading, 249

Dynamic display,| 187200, 202
Editor, 41//43)/47/ 63

Hierarchy, 29
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HMI connection,|272
Importing block, 243
Instruction,|25, (see also:
Block),[ 108,280, 358//359, 360, 361//362, 363, 364
Interconnection,|126, 135, 139//141, 153
Interconnection
Interface,|92
Multiuser Engineering, 267
OB type, 278
Objects,|38
Parameter, 141/ 145//147, 148
Password, 35//81
Printing,| 78
Reading back,|261
Run sequence,[161
S7 target system,/ 13,230
Sheet bar, 64
Signal tracing,[32, 100,129
Supported systems, 13
Target system S7,[13)/230
Task,[162/[278
Testing, 173/|178//257
Textual interconnection, 153
Trend display, 187,196, 198
WinCC connection, 272

CFC charts
Exporting, 367,369, 373,375, 377//379
Importing, 371

CFC data type,[203
ANY,|227
ARRAY, 222
BOOL, 204
BYTE,[204
CHAR,[217
COUNTER, 219
DATE,[214
DATE_AND_TIME,[215
DINT, 208
DT,/215
DTL,[216
DWORD, 205
Hardware data types, 228
INT,[ 207
LDATE_AND_TIME,|216
LDT,[216
LINT,[208
LREAL,[211
LTIME, 212
LTIME_OF_DAY, 215
LTOD, 215
LWORD,| 206
POINTER, 226
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REAL,[211
S5TIME, 213
SINT, 207
STRING,| 221
STRUCT, 220
System data, 228
TIME, 212
TIME_OF_DAY, 214
TIMER,[218
TOD,[214
UDINT, 210
UDT, 224
UINT, 209
ULINT, 210
User-defined data types, 224, 224
USINT,[209
VARIANT, 225
WCHAR,|217
WORD, 205
CFC Instruction
BIT_LGC family, 285
COMPARE family, 297
CONVERT family, 317
FLIPFLOP family,| 285
MATH_FP family, 301
MATH_INT family, 302
MULTIPLX family,[331
SHIFT family, 349
WRD_LGC family, 331
Chart in chart, (see: CFC chart)
Chart sequence & extras, 235//241
Chart sequence and extras",|243
CMP_DI,|299
CMP_1,298
CMP_T, 300
Comparator operations
DINT,[299
INT, 298
TIME, 300
COMPARE,|297
Compile
CFC, 251
Conversion
BOOL -> BYTE, 319
BOOL -> DWORD, 320
BOOL -> WORD, 321
BYTE -> BOOL, 322
BYTE -> DWORD, 322
BYTE -> WORD, 323
DINT -> DWORD,|323
DINT -> INT,|324
DINT -> REAL,|324
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DWORD -> DINT, 325
DWORD -> REAL, 326
DWORD -> WORD, 326
INT -> DINT, 327

INT -> DWORD, 327

INT -> REAL, 328

INT -> WORD, 328
Overview of instructions, 317
WORD -> 16 BOOL, 329
WORD -> BYTE, 329
WORD -> DWORD, 330
WORD -> INT, 330

D

Data type
CFC, (see: CFC data type)
DECO, 332
DI_DW, 323
DI_I, 324
DI_R, 324
DIV_DlI, 306
DIV_l, 307
Divider
DINT, 306
INT, 307
Double word logic, 331
Downloading
CFC, 252
Downloading changes
CFC chart, 254
DW_BO, 325
DW_DlI, 325
DW_R, 326
DW_W, 326
Dynamic display
CFCchart, 187

E

Editor
CFC chart, 43
Task card, 45

EN, 282

ENCO, 332

ENO, 282

EPS_DI, 308

EPS_1, 309

Exclusive-OR operation, 292
generic, DWORD, 347
WORD, 348
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Exporting
CFC charts, 367, 369, 373, 375, 377, 379

F

F_TRIG, 296
Falling edge, 296
Flipflop, 285
Flip-flop

JK, 293
Flip-flop

reset dominant, 294
Flip-flop

set dominant, 295
Forcing

Testing the CFC, 178, 182, 184

H
Hardware data types (CFC), 228

|_DlI, 327
|_DW, 327
| R, 328
| W, 328
Import/Export

CFC charts, 367, 369, 371, 373, 375, 377, 379
Importing

CFC charts, 371
Instruction

CFC chart, 280, 358, 359, 360, 361, 362, 363, 364

Terminal, 283
Interconnection

CFC, 132

CFC chart, 126, 141
Interface

CFC chart, 92
Inter-Project Engineering

CFC, 265
Interval

INT, 309

symmetrical, DINT, 308
Inverter

BOOL, 290

DINT, 315

DWORD, 344

INT, 316

REAL, 305

WORD, 344
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J

JK flip-flop, 293
JK_FF, 293

L

LIM_DI, 310
LIM_I, 304, 311
Limit

asymmetrical, DINT, 310
asymmetrical, INT, 304, 311

M

MATH_FP, 301
MATH_INT, 302
MAX_DI, 312
MAX_l, 303, 312
Maximum

DINT, 312

INT, 303, 312
MIN_DI, 313
MIN_I, 303, 313
Minimum

DINT, 313

INT, 303, 313
MOD_DI, 314
MOD_|, 315
Modulo

DINT, 314

INT, 315
Multiplexer

10f2

BOOL, 334

DINT, 335

INT, 336

10f2
MULTIPLX, 331
Multiuser Engineering

CFC chart, 267
MUX_I, 336
MUXn_BO, 334

N

NAND, 288
NAND operation, 288

generic, DWORD, 340

WORD, 341
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Navigation area
CFCs, 248

NEG_DI, 315

NEG_I, 316

NEG_R, 305

NOR, 289

NOR operation, 289
generic, DWORD, 342
WORD, 343

NOT, 290

0]

OB type
CFC chart, 278
OPC UA
CFC block instance, 277
OR, 291
OR operation, 291
generic, DWORD, 345
WORD, 346

P

Parameter

CFC, 122

CFC chart, 126
Parameters

CFC, 124,132

EN, 282

ENO, 282
Password

CFC chart, 35

R

R_TRIG, 286

Reading back
CFCchart, 261

Rising edge, 286

ROL_DW, 350

ROL_W, 351

ROR_DW, 352

ROR_W, 353

Rotate, 349
left, DOWORD, 350
left, WORD, 351
right, DWORD, 352
right, WORD, 353

RS_FF, 294

Run sequence, 161, 163, 166, 168, 169
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Runtime model, (see: Run sequence)

S

SEL, 333
SEL BO, 337
SEL_R, 337
Shift, 349
left, DIVORD, 354
left, WORD, 355
right, DIWORD, 356
right, WORD, 357
SHIFT, 349
SHL DW, 354
SHL W, 355
SHR_DW, 356
SHR_W, 357
SR_FF, 295
Subchart, (see: CFC chart)
System data types (CFC), 228

T

Task

CFC chart, 278
Team Engineering

CFC, 265

CFC chart, 267
Terminal, 283
Test mode

CFC, 176
Text field

CFC, 110

Textual interconnection, 153, 156, 159

Textual interconnection
Textual interconnection
Trend display
CFC chart, 187
Mouse actions, 195
Toolbar, 191
Trend view, 190

Trend window operating options, 192

Trend view, (see: Trend display)

U

User-defined data types, 224
User-defined data types (CFC), 224
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w
W_BO, 329
W_BY, 329
W_DW, 330
W_I, 330
WAND_DW, 338
WAND_W, 339
WNAND_DW, 340
WNAND_W, 341
WNOR_DW, 342
WNOR_W, 343
WNOT_DW, 344
WNOT_W, 344
WOR_DW, 345
WOR_W, 346
Word logic, 331
Word logic operation
DECO, 332
ENCO, 332
SEL, 333
WRD_LGC, 331
WXOR_DW, 347
WXOR_W, 348

X
XOR, 292
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